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MSDSpro ™ SOFTWARE LICENSE AGREEMENT AND DISCLAIMER

PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THE SOFTWARE OR DATA CONTAINED ON THE CD AND/OR
DISK. BY USING THE SOFTWARE OR DATA, YOU AGREE TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT, WHICH
INCLUDES THE SOFTWARE LICENSE AND WARRANTY DISCLAIMER (collectively referred to herein as the
“Agreement”).

THIS AGREEMENT CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU AND MSDSPRO, LLC. IF YOU DO NOT AGREE
TO THE TERMS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE AND PROMPTLY RETURN THE PACKAGE FOR A FULL
REFUND.

1. Ownership of Software and Data. The enclosed manual and computer programs (“Software”) were
developed and are copyrighted by MSDSpro, LLC. (“MSDSPRO”) and are licensed, not sold, to you by
MSDSPRO for use under the following terms, and MSDSPRO reserves any rights not expressly granted to
you. You own the disk(s) and CD(s) on which any software is recorded, but MSDSPRO retains ownership
of all copies of the Software itself. Neither the manual nor the Software may be copied in whole or
in part except as explicitly stated below.

2. License. MSDSPRO, as Licensor, grants to you, the LICENSEE, a non-exclusive, non-transferable
right to use this Software and Data subject to the terms of the license as follows: a. You may make
backup copies of the Software for your use provided they bear the MSDSPRO copyright notice. b. You
may only use the demo version for a period of 60 days from the date of installation.

3. Restrictions. You may not use more than one copy of the Software or Data at a time.  You may not
distribute copies of the Software to others or electronically transfer the Software from one
computer to another over a network. You may not distribute copies of the Software or Data as part
of a commercial data base. The Software contains trade secrets and to protect them you may not
decompile, reverse engineer, disassemble, or otherwise reduce the Software or Data to a human
perceivable form. YOU MAY NOT MODIFY, ADAPT, TRANSLATE, RENT, LEASE, LOAN OR RESELL THE SOFTWARE,
DATA, OR ANY PART THEREOF.

4. Termination. This license is effective until terminated. This license will terminate immediately
without notice from MSDSPRO if you fail to comply with any of its provisions. Upon termination you
must destroy the Software and Data and all copies thereof, and you may terminate this license at any
time by doing so.

5. Update Policy. MSDSPRO may create, from time to time, updated versions of the Software or Data.
At its option, MSDSPRO will make such updates available to the Licensee.

6. Warranty Disclaimer. THE SOFTWARE AND DATA IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESS OR IMPLIED , INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. MSDSPRO DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS
REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE SOFTWARE, DATA, OR WRITTEN MATERIALS IN THE
TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS OR OTHERWISE. THE SOFTWARE OR DATA IS NOT
INTENDED FOR USE IN ANY CASE WHERE THE FAILURE OR INACCURACY OF SOFTWARE OR DATA COULD LEAD TO DEATH,
PERSONAL INJURY, OR SEVERE PHYSICAL, EMOTIONAL OR ENVIRONMENTAL DAMAGE.  THE ENTIRE RISK AS TO THE
RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE, DATA, OR WRITTEN
MATERIALS ARE DEFECTIVE YOU, AND NOT MSDSPRO OR ITÕS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES,
ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. However, MSDSPRO warrants
to the original Licensee that the disk(s) or CD(s) on which the Software and Data is recorded is free
from defects in materials and workmanship under normal use and service for a period of thirty (30)
days from the date of delivery as evidenced by a copy of the receipt. THIS IS THE ONLY WARRANT OF
ANY KIND, EITHER EXPRESS OR IMPLIED, THAT IS MADE BY MSDSPRO ON THIS SOFTWARE PRODUCT. NO ORAL OR
WRITTEN INFORMATION OR ADVICE GIVEN BY MSDSPRO, ITÕS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES
SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON
SUCH INFORMATION OR ADVICE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER
RIGHTS, WHICH VARY FROM STATE TO STATE.

7. Governing Law. This agreement shall be governed by the laws of the State of Alaska.

MSDSpro is a trademark of MSDSpro, LLC. Apple is a registered trademark of Apple Computer, Inc.
Macintosh is a registered trademark of Apple Computer, Inc. 4th Dimension and 4D are trademarks of
ACI SA and ACI US, Inc.  Windows 98, 2000, XP, and NT 4.0 are trademarks of Microsoft.
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Installation and Configuration

System Requirements

MSDSpro is designed to function properly on many different computer hardware and operating system
configurations.  Here are the minimum requirements:

MSDSpro CD Viewer, Web CD, Classic or Plusweb:

Windows 98/Windows NT 4.0/Windows 2000/Windows XP
Pentium 233 mHz
48MB RAM
Hard Drive with 100MB free (+Datafile size)
CD ROM

Windows MSDSpro Enterprise Client:

Windows 98/Windows NT 4.0/Windows 2000/Windows XP
Pentium 233 MHz
48MB RAM
Hard Drive with 10MB free

MSDSpro Enterprise Server:

Windows NT 4.0/Windows 2000/Windows XP Professional
Pentium 400 mHz
128MB RAM
Hard Drive with 100MB free (+Datafile size)
CD ROM
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Installation of MSDSpro 4D Server

In an MSDSpro Enterprise installation, MSDSpro 4D Server must be installed before MSDSpro Client
workstations will be able to access the MSDSpro Enterprise system. After installing MSDSpro 4D
Server, MSDSpro 4D Clients should be installed on workstations that will need to access the MSDSpro
Enterprise system.

Be sure that you have at least the minimum amount of required hard drive space to install MSDSpro
(see System Requirements.)

To install MSDSpro 4D Server, follow these steps:

1. Insert the MSDSpro Installer CD into your CD-ROM drive.

2. Open the Install/Enterprise Server folder on the CD, as shown below in Explorer.

3. Double-click Setup.exe to begin the installation of MSDSpro 4D Server.

The default installation location is C:\Program Files\MSDSpro Server.

4. Complete the installation.

5. Launch MSDSpro 4D Server.

See Launching MSDSpro 4D Server in this section.
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Installation of MSDSpro 4D Client

In an MSDSpro Enterprise installation, MSDSpro 4D Clients must be installed on computer worksta-
tions that need access to MSDSpro Enterprise after installing the MSDSpro 4D Server.

Be sure that you have at least the minimum amount of required hard drive space to install MSDSpro
(see System Requirements.)

3. Double-click Setup.exe to begin the installation of MSDSpro 4D Client.

The default installation location is C:\Program Files\MSDSpro Client.

4. Complete the installation.

5. Launch MSDSpro 4D Client.

See Launching MSDSpro Client in this section.

NOTE: MSDSpro 4D Client should not normally be installed on the same computer that runs the MSDSpro
Server application.  Please contact MSDSpro Technical Support if this is required.

To install MSDSpro 4D Client, follow these steps:

1. Insert the MSDSpro Installer CD into your CD-ROM drive.

2. Open the Install/Enterprise Client folder on the CD, as shown below in Explorer.
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Installation of MSDSpro Standalone Applications

MSDSpro standalone applications consist of MSDSpro PlusWeb, MSDSpro Classic, MSDSpro CD
Viewer, and MSDSpro WebCD.

Be sure that you have at least the minimum amount of required hard drive space to install MSDSpro
(see System Requirements.)

To install MSDSpro standalone applications, follow these steps:

1. Insert the MSDSpro Installer CD into your CD-ROM drive as shown below in Explorer.

2. Locate the \Install\PlusWeb.Clasic.WebCD.CDViewer folder.

3. Double-click Setup.exe to begin the installation of MSDSpro.

The default installation location is C:\Program Files\MSDSpro.

4. Complete the installation.

5. Launch MSDSpro.

See Launching MSDSpro in this section.
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Launching MSDSpro 4D Server

The MSDSpro 4D Server must be launched first, which will then allow Web users and MSDSpro 4D
Clients to connect and use the system.

MSDSpro 4D Server must be installed on the server computer.  The application can be launched by
selecting MSDSpro Server / 4D_SERV from the Start Menu, or by choosing the default installation
location of C:\Program Files\MSDSpro Server\4D_Serv.exe as shown below in Explorer:

MSDSpro Enterprise is version of MSDSpro designed for administration over a computer network.
MSDSpro Enterprise is a Client/Server relational database system (RDBMS), and consists of two
applications which work together:

n MSDSpro 4D Server

n MSDSpro 4D Client

MSDSpro 4D Server contains the MSDSpro database and Web Server, and allows users to access the
MSDSpro database.  The server should always be available for use.

The client workstations contain the MSDSpro 4D Client application, which connect to the MSDSpro
4D Server to use the system.

Launching MSDSpro Enterprise

WARNING: Windows® NT must be configured for optimal performance before launching MSDSpro 4D
Server for the first time.  See Configuring Windows® NT for MSDSpro 4D Server later in this
section for more information.
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To launch MSDSpro 4D Server:

1. Select MSDSpro Server / 4D_Serv from the Start menu.

After successfully launching MSDSpro 4D Server, the screen below is shown.  No modifications to the
settings are required for standard operation of the MSDSpro Enterprise system. For optimization, see
Configuring Database Cache Memory Settings later in this section.

Launching MSDSpro 4D Server (Cont’d)

WARNING: One (1) Windows® NT Server setting must be modified to function properly with MSDSpro 4D
Server before launching the application.  See Windows® NT: Configuration for Network
Applications later in this section.
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Configuring MSDSpro 4D Server

Configuring Database Cache Memory Settings

MSDSpro maintains an internal Database Cache Memory, independent of any Operating System
cache.  It can be modified to improve performance.

To modify the size of the Database Cache Memory:

1. Launch 4D Server as shown in this section.

2. Choose Database Properties... from the File menu.

Choose the 5th tab (“Tune Up”) from the Database Properties window.  The Maximum Cache
setting is shown with 20 MB (20480 KB) of RAM dedicated to the database cache.  As a
general rule, adding more memory to this setting will increase performance as long as the
server computer has enough physical memory to support the specified setting. The Database
Cache Memory is in addition to the Application Main Memory, which is set at 14 MB (2
blocks of 7168 KB each).  Therefore, the settings shown require at least 34MB of physical
memory dedicated to the server operation.
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3. Click OK to accept the changes, or CANCEL to leave the settings unchanged.

4. Quit and re-launch the MSDSpro 4D Server application for changes to take effect.

Configuring Database Cache Memory Settings (Cont’d)

MSDSpro 4D Server can be registered as a Windows® NT Service.  When a MSDSpro 4D Server
database is registered as a service, it can be launched automatically at system startup and is not shut
down when the user terminates the current Windows® Log session.

No more than one instance of a service can be running at a time.

The Windows® NT Services Control Panel will display an entry for 4D Server:MSDSpro

NOTE: Registering MSDSpro 4D Server as a service is only available on Windows® NT 3.x, 4.x, 2000 and XP.
The three menu items are disabled on other versions of Windows®.

To register MSDSpro 4D Server as a Windows® NT Service:

1. Select Register as Service from the 4D Server File menu.

Windows® NT: Registering as a Service
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3. Click OK to accept the changes, or CANCEL to leave the Service Properties unchanged.

4. Click the CLOSE button to close the Windows® NT Services Control Panel.

To unregister the database as a service, select Unregister Current Database from the MSDSpro
4D Server File menu.

The service registration status of MSDSpro 4D Server cannot be changed from within 4D Server, if the
application has been launched as a service when Windows® NT was started. In this case, the three
menu items are disabled. To stop the service, use the Windows® NT Services Control Panel.

Windows® NT: Registering as a Service (Cont’d)

2. Double-click the entry to display the 4D Server:MSDSpro Service Properties window,
or click the STARTUP button.

Within the Service Properties window, you can specify the MSDSpro 4D Server service to
automatically start at system startup and provide login information. You can also specify the
service to be hidden (so it doesn’t interact with the Desktop).  We recommend allowing the
service to interact with the desktop for ease of server administration.

WARNING: The full pathname for your database structure file cannot exceed 250 characters.



Section 1:  Installation and Configuration

1 - 10 Administrator Guide

Windows® NT: Configuration for Network Applications

By default, Windows® NT will attempt to provide maximum performance for File Sharing.  This means
that Windows® NT will attempt to store large amounts of hard disk information in RAM, which is much
faster to access than the hard disk.  This default setting can dramatically increase the amount of
physical memory occupied by the Windows® NT Operating System itself.

However, MSDSpro 4D Server has an internal disk cache mechanism which optimizes queries and
sorts which have been performed by the database.  This requires that Windows® NT must not cache
the same disk activity (as this will eventually cause degraded performance and can lead to the system
becoming unresponsive until the server machine is restarted.)

To configure Windows® NT memory for Network Applications:

1. Open the Windows® NT Control Panel.

2. Select the Network Control Panel.

6. Click the OK button to save changes and restart the server machine if required.

3. Select the Services tab.

4. Select the Server service.

5. Select MAXIMIZE THROUGHPUT FOR NETWORK APPLICATIONS.

WARNING: When MSDSpro 4D Server is installed on Windows® NT, the configuration of a specific Operating
System setting is required before launching the application.
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Launching MSDSpro 4D Client

The MSDSpro 4D Server must be launched first, which enables MSDSpro 4D Clients to connect and
use the system.

The first time an MSDSpro 4D Client is connected to MSDSpro 4D Server, it must be registered. Enter
product registration information (as supplied on the Registration Card which was included in the initial
shipment.)  You must enter the information exactly as shown on your Registration Card (using capital
letters and zero’s):

1. Enter the Name exactly as shown on your Registration Card.

2. Enter the Organization exactly as shown on your Registration Card.

3. Enter the ID exactly as shown on your Registration Card.

4. Store the Registration Card in a safe place for future reference.
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To launch MSDSpro 4D Client:

1. Select MSDSpro Client from the Start menu, or double-click MSDSproClient.exe in
the MSDSpro Client\Program folder as shown above in Explorer.

2. From the 4D Network Component/Connect to 4D Server window, select “MSDSpro.4DC”.

MSDSpro 4D Client application should be installed on workstations.  The default installation location is
C:\Program Files\MSDSpro Client, as shown below in Explorer.

Launching MSDSpro 4D Client (Cont’d)

3. Click the OK button to connect to the MSDSpro 4D Server.
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If you don’t see a listing showing Msdspro.4dc, one or
more of the following factors may be contributing to the
problem:

n The Network may not be functioning.

n The MSDSpro 4D Client application may
not be configured properly to communicate
on the network.

n The MSDSpro 4D Server may not be
started.

n The MSDSpro 4D Server may not be
configured properly to communicate on
the network.

See the next topic for information on how to select a
network component and configure the network settings.

Launching MSDSpro 4D Client (Cont’d)

To select an alternate Network Component to communicate over the computer network:

1. Click OTHER from the Connect to 4D Server window.

Selecting MSDSpro 4D Client Network Components

Select Network Component
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To Configure MSDSpro 4D Client Network Settings:

1. Click MORE CHOICES from the Connect to 4D Server window.

Configuring MSDSpro 4D Client Network Settings

The Select Network Component window will appear and a list of available Network Compo-
nents will be shown.

2. Select the correct module (either TCP/IP or IPX/SPX).

Selecting MSDSpro 4D Client Network Components (Cont’d)

Configure Network Settings

3. Click the OK button.
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Configuring MSDSpro 4D Client Network Settings (Cont’d)

2. Name should be Msdspro.4dc@machinename.

This information should be supplied by your network administrator.

3. Address should be the MSDSpro Server network address.

This information should be supplied by your network administrator.

4. Click the NEW button to add it to the list at the top right.

5. Click OK to connect to MSDSpro Server.
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Launching MSDSpro Standalone Applications

To launch MSDSpro PlusWeb or MSDSpro Classic, select it from within Start menu / Programs or
double-click MSDSpro.exe.

Registration

The first time you use MSDSpro, you will be required to enter product registration information (as
supplied on the Registration Card which was included in the initial shipment):

1. Enter the Name exactly as shown on your Registration Card.

2. Enter the Organization exactly as shown on your Registration Card.

3. Enter the ID exactly as shown on your Registration Card.

Demo Mode

MSDSpro will function in Demo mode without a Registration ID for a period of 60 days from activation.
Each time you access MSDSpro, it will present the registration screen.

While in Demo mode, the printing and save/export functions are disabled, and web served documents
are limited in how much of the document is shown to the web browser.

After a period of 60 days, MSDSpro will no longer function in Demo mode.  You must purchase a
license to continue using the system.

4. Store the Registration Card in a safe place for future reference.
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Choosing your database

When launched MSDSpro will automatically load the most recently used database. If more than one
database exists the user can load the database of their choosing using the following steps.

1. Launch either MSDSpro Server or MSDSpro.

From the Start menu select either MSDSpro Server/ 4D_Serv or MSDSpro/ MSDSpro.

2. Hold down the ALT key immediately after launching MSDSpro. An Open window will
appear.

d 3. Select the database to be accessed by MSDSpro.

4. Click the OPEN button.
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User Name and Password

After successfully launching MSDSpro, the appropriate password must be entered to use the User
Names shown.

n DBA, EHS, Supervisor and DBO User Names require passwords.

The DBA password is “dba”.
The EHS password is “ehs”.
The Supervisor password is “supervisor”.
The DBO password is “dbo” (DBO is an optional User Name that may be created.)

n Viewer/User does not require a password.

NOTE: Passwords can be modified by the DBA, or the optional DBO.  See the Special Functions section.

To enter a User Name and Password:

1. Select the appropriate User Name

2. Enter the Password

3. Click the OK button

Clicking the QUIT button will close the application.
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Accepting the License and Disclaimer

The first time you use MSDSpro, MSDSpro PlusWeb, or MSDSpro Enterprise, you must agree to the
terms and conditions contained within the License Agreement and Disclaimer.  If you do not agree to
the terms and conditions set forth within the License Agreement and Disclaimer, you may click the
QUIT button to quit the application.

Contacting MSDSpro

e-mail support@MSDSpro.com

Website www.MSDSpro.com

NOTE: Be sure to visit the MSDSpro Software Development website at
www.MSDSpro.com to review our Online Knowledge Base (OKB) within
our Support area for the latest information about MSDSpro and related
technologies.

Technical Support (907) 334-4271

Fax (907) 274-6635

Contacting by Mail MSDSpro
4720 Business Park Blvd, Suite G-42
Anchorage, AK  99503
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User Roles

Multiple User Roles are available, allowing different workgroups to access the system with different
privileges.

The ability to add, modify, and delete data depends on the authorization granted to the User Role:

User Role Access Group Privilege

Database Database Owner Password Editor Only (DBO is optional)
Owner (DBO)

Database DB Admin View Records
Administrator (DBA) Add Records

Edit Records
Delete Records
Import/Export from all tables
Archives
Password Editor (If DBO not engaged)
System Preferences
All Update Options
Reports

EHS Edit View Records
Add Records
Edit Records
Delete Records
Import/Export from all tables
Archives
All Update Options
Reports

Supervisor Browse View Records
Basic Reports & Labels

Viewer/User & - Read-only MSDS viewing interface
Web User

Admin User Access
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Floating Toolbar

The Floating Toolbar floats above other open windows, and is positioned in the top-left corner of the
screen.  Clicking Find, Admin, or Reports will bring up the associated windows.  Clicking Quit will
exit the application.

You can select from a list of open windows by clicking the Windows pull-down menu, as shown.

If the Floating Toolbar interferes with an active window, simply double-click the small left arrow.  The
Floating Toolbar will be minimized and become a small right arrow.  Double-click the right arrow to
show the Floating Toolbar bar once again.

Admin Control Panel

The Admin Control Panel allows Admin users to access specific Data Access screens, Special
Functions and Updates to the data within MSDSpro.

n Data Access tab: These areas use conventions to consistently present data in a
standardized, understandable format (see Database Conventions).

HINT: Drag the Floating Toolbar to any location onscreen by clicking on the arrow and dragging.

Double-click the left arrow
to minimize the Floating
Toolbar, or drag it to any
location onscreen

Double-click the right arrow to
expand the Floating Toolbar

List of open Windows
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n Special Functions tab: Import/Export and Archives follow the same database
conventions as Data Access areas.  Password Editor and Preferences are special areas
that control how MSDSpro functions and can only be accessed by users with
administrator access.

Admin Control Panel (Cont’d)

n Human Resources tab:  These areas allow the update of information relating to an
organization’s Departments, Employees and Groups.
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n Product and Inventory tab:  Reports that Admin Users may regularly access.  See
Section 7: Reports for more information on each report.

Reports Control Panel

The Reports Control Panel allows users to create various comprehensive reports with the data stored
within MSDSpro.  The Reports Control Panel is divided into four areas:

n Updates tab:  These areas allow the update of specific database information from
different sources.

Admin Control Panel (Cont’d)
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n Chemical tab: Reports detailing information about specific chemicals as they are
used within Products at specific Locations.

n Regulatory tab: Reports for Regulatory Agencies, such as SARA reports for the local
and state emergency planning authorities.  See Section 7: Reports for more information
on each report.

n Ad Hoc tab: Access to produce reports and container labeling for custom needs.  See
Section 7: Reports for more information on each report.

Reports Control Panel (Cont’d)
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Database Conventions and Operations

The design of screens, the placement and names of buttons, and the available menus conform to
specific database conventions that were designed into MSDSpro.  All forms that allow MSDSpro
administrator access to the database tables for data entry and browsing use the same conventions as
shown.

Output Forms

Output forms list records, showing only a small summary of the data contained within the records.
The title at the top of the window displays the name of the table currently being accessed, the number
of records in the current selection, and the total number of records within the table. The current
selection refers to the currently selected records in the Output form, in a sorted order. Most Output
forms allow for seven actions.

Table Name: Current Selection of Records of Total Number of Records in Table

n Click on the NEW button to create a new record.

n Click on the DELETE button to remove the highlighted record.

n Click on the EDIT button to modify the information relating to the highlighted record.

n Click on the ALL button to view the entire list of records.

n Click on the SEARCH button to search for records matching a specific criteria.

n Click on the SORT button to sort the records.

n Click on the CLOSE button to close the Output form.
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Data Entry Forms

Data Entry forms allow you to modify or browse the entire record in detail.  Double-clicking a record
from the Output form will present the record in the Data Entry form.  If the current user’s User Role
allows modification, the record will be editable.

The record navigation buttons allow movement between records, and will save any modifications to the
record before displaying the next record.  The buttons (left to right) are FIRST record, PREVIOUS
record, NEXT record, and LAST record.

The record modification buttons are DELETE, CANCEL, and SAVE.  DELETE will delete the current
record shown and return to the Output form.  CANCEL will cancel any changes to this record and
return to the Output form.  SAVE will save changes to the record and return to the Output form.

EDIT LOG  will display a list of modifications made to the record, listed by date, time, and username.
If the EDIT LOG button is not visible, this preference has been turned off by the DBA.

The title at the top of the window shows the name of the table, and the currently selected record out of
the total number of records.

Record navigation buttons Record modification buttons

Edit Log to display listing of modifications to this record

Table Name: Current Record Number of Total Number of Records in Table

Window Resize Thumb
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Menus

n Preferences allows workstation-specific settings to be modified.

n Import... presents the Import editor for the current table.
n Export... presents the Export editor for the current table.

n Page Setup allows changes to the default printer setup.
n Print... presents the Print Choices window.

n Report Editor... presents the Report editor for the current table.

n Quit exits the application.

n Cut, Copy, Paste, Clear perform clipboard operations.
n Select All from an Output form will highlight all records shown.

n Show Clipboard displays the contents of the Clipboard.

n Show All displays all records in the current table.
n Show Subset selects only the highlighted records for the current

selection.
n Omit Subset removes the highlighted records from the current

selection.

n Add Records allows a new record to be added within the current
table.

File Menu

Edit Menu

Selection Menu



3 - 4 Administrator Guide

Section 3:  Database Conventions and Operations

Selection Menu (Cont’d)

n Delete Record deletes the highlighted records in the current
open window.

n Copy Records

n Search Editor... presents the Query editor to search for records.
n Sort Editor... presents the Order By editor to sort the current

selection.

n Apply Formula presents the Formula editor to apply a formula.

n Archive Selected Products only functions within the Product
table.

n Close closes the current open window.
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Searching is one of the most common database operations. A search is often the most convenient
way to select the records with which you want to work.

The term searching refers to finding a group of records in the database based on the contents of one or
more fields. You perform a search by specifying a search condition. A query is a set of instructions that
tells MSDSpro which records to include in the current selection.

A query always has three elements: field name, comparison operator, and value. The field name is
from the current table or a related table. The comparison operator tells MSDSpro how to compare the
contents of the field to the value you specify (equal to, greater than, less than.) The value specifies the
number, string, or other value to which each record is compared.

Suppose you want to see all the records for products with revision dates before 1/1/95. The search
condition you would use is “Revision_Date is less than 1/1/95.” “Revision_Date” is the field, “is less
than” is the comparison operator, and “1/1/95” is the value.

When you search a database, MSDSpro compares the contents of the field in the search condition to
the value you specify. The new current selection is made up of records that satisfy the rules stated in
the query. The new current selection can be no records, one record, a group of records, or all the
records in the table.

You can search on fields from other tables, provided that a relationship exists between the tables.

When you do the search, the new current selection is displayed in the Output form. You can reset the
current selection to all the records in the current table by choosing Show All from the Selection menu,
or clicking the ALL button at the bottom of the Output form.

Searching

MSDSpro can carry out queries very quickly if it has an ordered list of records to work from. An ordered
list is called an Index.  An index is associated with a particular field and is stored on disk as part of the
data file.

A query that is performed without an index is slower than an indexed query because the MSDSpro
must start at the beginning of the table and examine each record until it finds the records that meet the
criteria you have set. To be sure that it has found all the records you are looking for, it must examine
every record in the table sequentially. This process is called a sequential search.

If an index is available, the program “knows” where the target records are located. If you are searching
for all products with a product name of Lead, the program will know where in the file the Lead records
are located. Thus, it doesn’t need to examine every record in the file, and is very efficient.  This process
is called an indexed search.

Indexed and Sequential Searches
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When you write a query, you tell MSDSpro how to compare the value you specify to the contents of the
database. For example, the query, “Name is equal to ‘Lead’” uses the “is equal to” comparison opera-
tor. It tells MSDSpro to compare the values in the product name field to the string “Lead.”

Comparisons involving alphanumeric values are not case sensitive. A search on the product name
“Lead” will find records containing “lead,” “LEAD,” “LEad,” and so on.

The following comparison operators are available:

n Is equal to
n Is not equal to
n Is greater than
n Is greater than or equal to
n Is less than
n Is less than or equal to
n Contains
n Does not contain

A good analogy for an index is a card catalog in a library. The card catalog is an alphabetized list of all
the books in the library. Each record in the catalog contains information about where the book is
physically located. If you are looking for a particular book, it would be very inefficient to conduct a
sequential search of the library’s entire holdings. It is much faster to consult the card catalog, obtain
the location of the book, and then search the particular shelf on which the book is stored.

As you enter or import records, MSDSpro automatically updates all indexes. When you do searches,
MSDSpro automatically uses indexes if they are available.

Indexed and Sequential Searches (cont’d)

Comparison Operators

MSDSpro also has a wildcard character (@) that substitutes for one or more characters in the value
being searched for. You use the wildcard character to do a “begins with” search. For example, to find
products whose product name begins with “L,” you would use the search condition, “Name is equal to
L@.” That is, you use “L@” as the value to be searched for. Using the wildcard character with the “is
equal to” comparison operator is equivalent to a “begins with” comparison.

The @ symbol is used throughout MSDSpro as the wildcard character and is not limited to search
conditions.

The wildcard character can be used only with Alpha or Text fields; it cannot be used in a Numeric or
Date search.

NOTE: Queries using the Contains and Does not contain operators are always sequential queries.
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You can search on one or more fields. A query on one field is called a simple query. For example, the
search “Name is equal to ‘Lead’ ” is a simple query. When you do a simple query, MSDSpro examines
the contents of one field when searching the database.

A query on two or more fields is called a compound query. When you do a compound query, you
combine separate queries using a conjunction operator. The conjunction operator tells MSDSpro how
to combine the results of the individual queries. There are three conjunction operators:

n And: This operator finds all the records that meet two conditions simultaneously. For
example, the query “Find all the products that have a hazard rating of 2 and that are
older than 1/1/95” will find the records of only those products that have a hazard
rating of 2 and that have revision dates older than 1/1/95.

n Or: This operator finds all the records that meet either of two conditions. For example,
the query “Find all the products that have a hazard rating of 2 or that are older than
1/1/95” will find the records of all the products with a hazard rating of 2, as well as all
the products that are older than 1/1/95, regardless of their hazard rating.

n Except: This operator is the equivalent of “not.” The query “Find all the products that
have a hazard rating of 2 except those which are older than 1/1/95” will exclude the
all of the products that are older than the date 1/1/95.

The conjunction operators let you create compound queries such as “Find the manufacturers named
MSDSpro who don’t have an area code of 99501 but whose phone number contains the digits 907”.

The figure below shows this query being specified in the Query editor:

Simple and Compound Searches
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The Query editor is accessed from the Selection menu, or by clicking the SEARCH button in the
Output form. The one exception to this is when a user clicks the SEARCH button on the Product
Output form. Clicking on the SEARCH button on the Product Output form loads the Advanced Search
editor.

The Query editor is a general-purpose editor that can be used to create simple or compound queries.
The Query editor lets you create compound queries linked with the And, Or, or Except conjunctions.
For example, you can use the Query editor to perform a query for all products which have a hazard
rating of 2 or are newer than 1/1/97.

n The Query editor gives you the choice of searching through the current selection of
records or all the records in the table.

n The Query editor lets you save queries to disk and open them when you want to
repeat the query.

n The Query editor allows you to search on any field in the current table and any fields
in related tables.  Related tables are other tables within the database that have a
Many to One relationship to the current table. An example of this is the relationship
that exists between the product table and the manufacturer table. One manufacturer
can make many products. Likewise, many products (and many product records) can
be associated with one manufacturer. Since this many to one relationship exists
between the product table and the manufacturer table then information in the
manufacturer table can be searched from the product table.

 Searches on related tables are always sequential, even if the field being searched on is indexed,
which is slower than a search only within the same table.

The Query Editor

Criteria area

Fields list

Value area

Conjunction buttons

Comparison
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The Query editor contains the following areas:

n Criteria area: This area displays your query as you create it or after you load it from
a disk file.

n Fields list: This area displays a hierarchical list of the fields in the current table.
Indexed fields are shown in boldface.  If there are related tables, the foreign key
fields in the current table can be expanded to display the fields in the related tables.

n Comparison Operator area: This area displays a list of comparison operators.
n Conjunction buttons: This area contains three buttons that correspond to conjunction

operators you can use to join current simple query to the previous simple query.
n Value area: You enter values for which you want to search in this area.
n Query in selection button: This button performs the query only on the records in the

current selection.
n Query editor buttons: You use this area to save your queries, load other queries from

disk, cancel the query, or execute the query.

To create a query:

1. Select Search from the Select menu, or click the SEARCH button from an Output form
other than the Product Output form.

MSDSpro displays the Query editor, highlighting the first row of the Criteria area.

2. Click a field name to use in the query.  If you don’t want to use the “is equal to”
operator, click the desired comparison operator.

The Query Editor (Cont’d)
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Comparison operator choices:

n Is equal to
n Is not equal to
n Is greater than
n Is greater than or equal to
n Is less than
n Is less than or equal to
n Contains (Alpha and Text fields only)
n Does not contain (Alpha and Text fields only)

3. Type the value for which you want to search for in the Value area.

The Query Editor (Cont’d)

In a Text or Alpha field you can use the wildcard character (@) at the end of the value to request a
“Begins with” search.

If the field you selected is a Boolean field, MSDSpro displays a pair of radio buttons.

4. To add another simple query, click ADD LINE.

MSDSpro adds a new line using the “And” conjunction operator.

5.  To use the “Or” or “Except” operator, click the desired conjunction operator button.

Repeat steps 2 and 3 to build the second simple query.

Value
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When you build a compound search condition, MSDSpro evaluates the conditions in the order in
which they appear in the Criteria area (i.e. from top to bottom).

There is no precedence among the conjunctions. Thus, if you have used more than two simple
queries in building the compound query, the order in which you enter the simple queries can affect
the results of the query.

As you build a compound query, you can modify existing parts of the query by clicking the line you
want to change and clicking a new field or operator or typing a new value.

You can remove a simple query by selecting the line and clicking DEL LINE.  In a compound
query, you can remove one line of the query by clicking the DEL LINE button.

6. To save the query to disk file, click SAVE and enter a filename in the Create File window.

You do not need to save your query to perform the search.

7. Click QUERY to search the entire table, or Query in Selection to restrict the query to the
current selection.

Or, click CANCEL to close the Query editor.

The Query Editor (Cont’d)
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You can use the Query editor to search on related tables. If the field you want to search on is in a
related table, click on the plus sign to the left of the appropriate field name to display all the fields
available from the related table. The following illustration shows available fields from the related table,
Manufacturer.

To select a field from another table:

1. Expand the related table fields by clicking the plus sign.

The fields belonging to the related table appear in the hierarchical list.

The Query Editor (Cont’d)

2. Click to the desired field in the related table.

3. Follow the steps 3 through 7 for directions on creating the rest of the query.

To save a query to disk:

1. Click the SAVE button.

2. Click OK.

The query is saved to disk. Simply load it next time to use the same query again.

To load a saved query from disk:

1. Click LOAD and select the desired file.
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Advanced Search

Clicking on the SEARCH button along the bottom of the Product Output form loads the Advanced
Search Editor. The Advanced Search Editor is similar to The Query Editor. However, while The Query
Editor only has the ability to search tables linked directly to the table from which the search is being
conducted, the Advanced Search Editor has the ability to search fields in tables with only an indirect
association to the Product table.

To query using the Advanced Search Editor:

1. Click on the SEARCH button along the bottom of the Product Output form OR choose
Search for Records after selecting Products from the Admin Control Panel.

2. Select Master Table from the Available Fields pull-down menu if the information to
be searched for is located in the product table, otherwise select Other Tables.

3. Highlight the field name that contains the information to be searched for, clicking on
the plus or minus signs to show and hide fields as necessary.

4. Select the appropriate comparison operator to determine how the information to be
searched for should compare to the data in the value field.

5. Enter into the value field the data to be compared to the information contained in the
highlighted field.

6. Click on the AND, OR, or EXCEPT button(s) to combine the search on the current field
with a search on another field or fields.

Click on the (+) sign to
reveal fields contained
in this table.

Highlight the field
containing the data
to be searched.

Enter here the
information to be
compared to the data
in the highlighted field.
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Advanced Search (cont’d)

n ADD, OR, EXCEPT add additional Lines for searches with multiple criteria.

n Click on the CANCEL button to cancel the query.

n Click on the CLEAR ALL button to remove all information from the Search Criteria
area.

n Click on the DELETE LINE button to remove the highlighted line from the Search
Criteria area.

n Click on the QUERY button to execute the query.

n SAVE Allows you to save Search criteria to a file.

n The LOAD button allows you to load a previously saved search.

Click on the (+) sign to
reveal fields contained
in this table

Highlight the field
containing the data
to be searched for

Enter here the
information to be
compared to the data
in the highlighted field
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n Build your query using steps listed on 3-13.

n Click on the Click the SAVE button.

n Select the path and file name.

n Press SAVE.

Click on the (+) sign to
reveal fields contained
in this table

Highlight the field
containing the data
to be searched for

Enter here the
information to be
compared to the data
in the highlighted field

Advanced Search (cont’d)
Save and Load Searches  :  SAVING YOUR ADVANCED SEARCH
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Advanced Search (cont’d):
Save and Load Searches:  LOADING YOUR ADVANCED SEARCH

n Click on the LOAD button.

n Select The Query that you want to run.

n Press OPEN.
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Sorting Records

A sort reorders records according to the values in the table.  It is common to sort records to view
records on screen in a particular order, or before printing a report or exporting data.

As you enter data into the database, MSDSpro stores the records in the order in which they are
entered or imported.  When you list records in an output form or print records, they appear in this order.
Often, you want to view records in another order.  For example, you might want to alphabetize a list of
Product Names in a report - a sort on the Product Name field reorders the records alphabetically by
Product Name.

MSDSpro conducts indexed sorts very quickly.  If you are sorting on only one field and that field is
indexed, MSDSpro uses the index.

You can sort records on up to 30 different fields or formulas.  Each field or formula you sort on is
referred to as a sort level.  For example, the results of a two-level ascending sort on the Product
Revision Date and Name would product a list such as this:

04/22/91, Acetone
04/22/91, Crude Oil
.
.
09/25/98, Acetylene
09/25/98, Green Stuff Absorbent

When sorting the contents of fields, MSDSpro is not case sensitive.

You can specify either an ascending or descending order for each field or formula that you are sorting
on.  Sorting from A to Z or smallest to largest is known as an ascending sort.  Sorting in the reverse
order is called a descending sort - largest to smallest, latest to earliest, and Z to A.

If you are sorting on more than one level, you can freely mix ascending and descending sort orders.  A
multiple-level sort can mix fields and formulas and ascending and descending sort orders.
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The Order By Editor

You use the Sort Editor item in the Selection menu to sort the records in the current selection.  Sorting
the current selection changes the order in which records are displayed or printed.  This is a temporary
sort; it does not affect the order in which the records are stored on disk.

When you choose Sort Editor, the Order By editor enables you to specify the sort you want to perform.

n Fields list:  This area displays a list of fields in the current table.  Indexed fields are
shown in boldface.  You can sort on fields from related tables.  To use a field from a
related table, click on the plus sign to display the fields from the related table.

n Sort area:  The Sort area displays the sort fields or sort formulas and the direction of
each sort.  The arrows on the right of this area are used to specify an ascending or
descending sort.

n ADD FORMULA button:  The ADD FORMULA button to write a formula as one of the
sort criteria.

n Button panel:  The Button Panel has buttons for adding or removing fields from the
sort list.

n MODIFY button:  The MODIFY button displays the selected sort criterion in the Formula
editor.  If the selected criterion is a formula, the formula is presented for editing.  If
the criterion is a field, the field name appears in the editing window of the Formula
editor.

Indexed fields
Shown in Bold

Foreign Key Feild

Field List

Sort area
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You select Sort Editor from the Selection menu, or click SORT in any Output form to sort the records
in the current selection. Sorting the current selection changes the order in which records are displayed
or printed. This is a temporary sort; it does not affect the order in which the records are stored on disk.

When you select Sort Editor, the Order By editor appears, allowing you to specify the sort to perform.

Sorting a Selection

Use the Sort Editor menu item to sort the current selection of records.  This sort is temporary and
applies only to the current selection; it does not affect the order in which records are stored in the
database.  Sorting is commonly used immediately after a query and before printing a report.

To sort the current selection:

1. Choose Sort Editor from the Selection menu.

2. Double-click the name of a field on which you want to sort, or drag the field name
from the Fields list to the Sort area, or to sort on a formula, click the ADD FORMULA
button.

When you open the Order By editor, the Fields list displays the fields from the master table.
You can choose fields from related tables by expanding a foreign key field.

If you clicked the ADD FORMULA button, MSDSpro displays the Formula editor.  For information
on writing a formula, see The Formula Editor later in this section.

The field name or formula appears with a sort direction arrow in the Criteria area.

3. If necessary, click the sort direction arrow in the Sort area to switch between ascending
and descending sort order.

Up is ascending; down is descending.

4. If necessary, repeat steps 2 and 3 to add secondary sort levels to the list.

For each sort level, you can specify ascending or descending order.
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Sorting a Selection (Cont’d)

5. Click on the ORDER BY button.

MSDSpro sorts the current selection.

FOR EXAMPLE: The sort order shown lists Products sorted by date, then by Product name.

Ascending sort

Decending sort
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One of the most important tasks in data management is the generation of reports. Frequently used
“built-in” reports are accessed from the Reports Control Panel.  However, for ad-hoc reporting capabilities,
you can use the Quick Report editor to create a wide variety of columnar reports.

Using the Quick Report editor you can do the following:

n Produce lists of records
n Create break areas between groups of sorted records
n Compute summary calculations
n Use fonts and styles in the report

The Quick Report editor produces reports from the current selection of records. Before you print a
report, you must select the records you want to include in your report (usually by performing a search
from the Selection menu in an Output form.)

MSDSpro’s Quick Report editor lets you create and print tabular reports. Output from a typical Quick
Report is shown below:

When you create a Quick Report, you can specify the following:

n Columns displaying fields or formulas, either from the current table or from related
tables

n Sort levels and order
n Break levels
n Summary calculations
n Text for labels
n Formats for numeric and Boolean data
n Font, font size, style, and justification for labels, summary calculations, and data
n Page headers and footers

Quick Reports (Ad-Hoc Reports)
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A Quick Report can be printed/output to:

n A Printer
n A Disk File
n A Graph

These options are discussed in Selecting an Output Device later in this section.

Creating a New Quick Report

The Quick Report editor lets you create reports in the User environment. To create a Quick Report
design, choose Report Editor from the Selection menu on any Output form.  MSDSpro displays the
Quick Report editor. If an existing design is displayed, choose New from the File menu to begin a new
Quick Report design.

Loading and Saving a Quick Report Design

You can save a Quick Report design as a file that you can open from the Quick Report editor. The
Quick Report design includes all your specifications, but not the data. By saving report designs, you
can maintain a library of Quick Reports that you can use depending on your needs.

Quick Reports (Ad-Hoc Reports) (Cont’d)

NOTE: If you do not save your design, it will not be displayed the next time you open the Quick Report editor.

 To save a Quick Report design, follow these steps:

1. Choose Save from the File menu.

MSDSpro displays a Save File window.
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When the Quick Report editor is open, you can load a saved design and use it to print a new report.
The same Quick Report design can be used repeatedly to print different selections of records.

To load a report design:

1. Choose Open from the File menu.

MSDSpro displays an Open File window displaying a list of available quick report designs.

Quick Reports (Ad-Hoc Reports) (Cont’d)

2. Select a file from the list and click OPEN.

MSDSpro replaces the current report design with the design you opened.

Loading a Quick Report Design

2. Enter a filename for the Quick Report and click on the SAVE button.

MSDSpro saves the report as a file that you can open with the Quick Report editor. You can
save the file to any hard disk available to you.

NOTE: If you are saving a report previously saved or loaded, it replaces the previous report.
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The Quick Report editor contains the following elements:

n Fields list: This list displays fields in the current table. You can view the names of
fields in other tables by expanding the foreign key fields.  A foreign key field has a
plus sign to its left.

n Sort list: This list displays the sort order assigned to the report and indicates whether
each sort level is ascending or descending.  If your report will contain summary
calculations from groups of records, you must sort the current selection on one or
more fields. You can change the order of fields in the Sort list by dragging the field
name vertically to the desired position in the list.

n Quick Report area: You use this area to design the report by dragging fields, adding
formulas, adjusting column widths, and adding or deleting breaks.

n Summary calculation buttons: You use these buttons to place summary calculations
in the Break and Total areas of the report.

n Column properties: You use these check boxes to set the following characteristics for
each column in the report:

n Sorted: Click this check box if you want the records to be sorted on the selected
column.

The Quick Report Editor

Fields List

Expanded foreign
key field

Sort List

Cell

Header, Detail,
Break, and Totals

rows

Row label bar
Column divider

Summary calculation buttons Column properties

Column headers

Quick
Report
area
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n Repeated Values: Use this check box to tell the Quick Report editor to repeat the
values in a Break column.  If you do not select the Repeated Values check box,
each Break value is displayed only once.

n Automatic Width: Click this check box to request that the Quick Report editor
calculate the column width of the selected column based on the maximum length
of the contents of the column. The sizing is done only at the time the report is
printed.  This option can be checked for each column individually. The check box
does not refer to the entire report. If the Auto Column Width check box is not
checked for a column, you can modify that column’s width by dragging column
indicators, and your reports may print much faster.

n Column Dividers: These lines indicate the boundaries between columns of the report.

n Right margin marker: This marker indicates the right margin of the report. The right
margin marker is meaningful only when no columns have the Auto Column Width
check box selected. You may have to scroll horizontally to view the right margin
marker.

n Column header: The column header displays names of fields or formulas in the report.

n Row label bar: This bar shows the different areas of the report: the Header, Detail,
Break, and Total rows.

n Header row: This row contains information that appears in the printed report above
the records. The Quick Report editor automatically places field names in the Header
row, but you can modify its contents.

n Detail row: This row prints information from individual records and will be repeated
in the printed report for each break.

n Break and Totals rows: These rows display summary calculations and any associated
labeling. The Break row displays summary calculations for each group of sorted
records in the report and the Totals row displays summary calculations obtained from
all records in the current selection.

n Cells: Cells are the intersection of a row and a column.

n Scroll bars: You use the scroll bars to view parts of the quick report design that extend
beyond the area of the quick report form.

The Quick Report Editor (Cont’d)



3 - 26 Administrator Guide

Section 3:  Database Conventions and Operations

The various list and display areas in the Quick Report editor can be resized.  Areas that can be resized
are bordered by a raised line.

The Quick Report editor has “hidden” pop-up menus that make it easy to access certain row, column,
and cell operations.  Instead of making menu selections or working with the Cell or Column properties
areas, you can perform certain operations by displaying a Quick Report pop-up menu.  There are
separate pop-up menus for row, column, and cell operations.

To use a pop-up menu:

1. Position the pointer in a cell, a row label, or a column heading and hold down the
right mouse button.

A pop-up menu appears.  The commands in the pop-up menu depend on where your pointer is
(i.e., a row label, column heading, or cell).  Also, menu commands that are inappropriate for
the particular row, column, or cell are disabled.

The three Quick Report pop-up menus consist of:

The Quick Report Editor (Cont’d)

Summary Calculations
(valid only in Break and Total rows)

Format
(valid only if a display format can be applied)

Text Attributes

n Rows

Break row operations

Text Attributes

Hide row

The Quick Report Pop-up Menus

n Cells
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2. Choose the desired menu command.

When designing a Quick Report, you need to select rows, columns, and cells in the Quick Report
layout. A cell is the intersection of a row and a column.

To select a row:

1. Click on the H, D, B, or T markers on the row label bar to the left of the Quick Report
layout. Or, click in a row to the right of all columns in the Quick Report layout.

To select a column:

1. Click above the Header row of a column.

To select a cell:

1. Click the cell.

The Quick Report Editor (Cont’d)

n Columns

Column operations

Text Attributes

Column Properties

Format
valid if a display format can be applied

Selecting Rows, Columns, and Cells
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You can add or modify text in the Quick Report layout. Text can be used to label parts of the report. For
example, if you requested summary calculations, you can add text to other cells in the Break and Total
rows to label the summary calculations.

You can do the following:

n Edit the text that MSDSpro automatically adds to the Header row of the report
n Insert text in empty cells of the Break and Totals rows
n Insert the value of a Break field in the Break rows
n Specify the font, font size, justification, and style for any text that appears in the

report

To add text:

1. Click twice on an empty cell in the Quick Report layout.

A text insertion point appears in the cell.  If you are entering a label for a summary calculation,
select a cell in the same row as the cell containing the calculation icons. You cannot enter
text into the same cell that contains summary calculations.

2. Type the text in the cell.

To modify text:

1. Drag across the text in the cell to modify.  MSDSpro highlights the selected text.

2. Type the new text in the cell.

The Quick Report Editor (Cont’d)

Adding and Modifying Text

Specifying Font, Font Size, Justification, and Style

While designing your Quick Report, you can specify different fonts, font sizes, justification, and styles.
You can apply these specifications to rows, columns, or cells in the Quick Report. These specifications
can be applied to text, data, and summary calculations.

If you assign specifications to the Detail row of the report, you will not see the results until you preview
or print the report.
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To specify a font, font size, style, or justification:

1. Select the column, row, or cell where you want to apply the font.

2. Choose a font from the Font menu or choose a font size, style, or justification
from the Style menu, or hold down the right mouse button to display the
Quick Report pop-up menu to select text attributes.

MSDSpro applies the font to text, data, and summary calculations in the selected
area.

The Quick Report Editor (Cont’d)

Adding Columns to the Report

You create columns by dragging field names from the Fields area to the Quick Report layout. You can
add fields from related tables, provided the relationship exists.  To add fields from related tables, click
the plus sign on the Foreign key field to expand the list of available related fields.

To add a column:

n Drag the name of a field to the right of existing columns in the Quick Report layout
and release the mouse button.

MSDSpro creates a column for the field and places the field name in both the column header
and the cell in the Header row.
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Inserting Columns

You can insert a column in a Quick Report.

To insert a column:

1. Select a column.

2. Choose Insert Column from the Edit menu, or hold down the mouse button to display
the Quick Report pop-up menu and choose Insert Column.

The Quick Report Editor (Cont’d)

The figure below shows the Product Name field added as a column to the Quick Report layout:
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The Quick Report Editor (Cont’d)

MSDSpro inserts a blank column to the left of the column you selected. You can then assign
a field to the empty column by dragging a field name to it. Or, you can choose to assign a
formula to the column. For information on assigning a formula to a column, see Adding Formulas
to the Report later in this section.

As you specify fields for your Quick Report, you may want to remove some columns so that
they can be placed elsewhere. You also might want to delete the column from the report.

To delete a column:

1. Select the column you want to delete.

2. Choose Delete Column from the Edit menu,
or hold down the right mouse button to display
the Quick Report pop-up menu and choose
Delete Column.

Deleting Columns
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MSDSpro removes the selected column from the Quick Report layout.

You can replace a column in the Quick Report by dragging another field over it. You can also replace
a field with a formula.

To replace a column:

1. Drag a field from the Fields area to the column you want to replace, or select the
column you want to replace and choose Edit Column from the Edit menu.

When you print the Quick Report, MSDSpro prints the results of the formula for each record
that appears in the Detail row.

See Adding Formulas to the Report later in this section for information on adding a formula to a Quick
Report.

By default, the Quick Report editor sizes columns automatically (as reflected in the Automatic Width
check box).  It sizes each column based on the maximum length of data displayed in the column and
any labels typed into the column. The Quick Report editor sizes columns at the time the report is
printed.

To view the widths of each column, preview the report to the screen. See Printing the Quick Report
later in this section for more information about previewing the report.

The Quick Report Editor (Cont’d)

Replacing Columns

Sizing Columns
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Because the Auto Column Width check box will change the width of a column based on the maximum
width of data in the records being printed, selecting different records can change the size of the
columns.

You can resize a column manually after turning off the Auto Column Width check box. When a column
is set manually, text in the column wraps within the specified area.  Print speed may also be much
faster because the Quick Report editor will not have to calculate the maximum width of each record
value being printed.

To resize a column manually:

1. Select the column you want to resize.

2. Deselect the Auto Column Width check box either in the Column Properties or in the
Quick Report pop-up menu for the column.

3. Move the pointer over the column indicator in the column header to change the
pointer into a column width cursor.

4. Drag the column indicator to the left or right to size the column.

You can add a formula to a column in a Quick Report. For example, you can add a formula that
calculates Inventory quantities from a quantity field.

To add a formula:

1. Insert an empty column or click an existing column and choose Edit Column... from
the Edit menu, or hold down the mouse button to display the Quick Report pop-up
menu and choose Edit Column...

MSDSpro displays the Formula editor where you can build a formula. If you selected an
existing column, the formula you create will replace the previous contents of the column.

2. Build the formula by clicking fields, keywords, and commands and entering values.
To save the formula as a disk file that you can recall and use in another column or in
another report, click the SAVE button and enter a filename in the Save File window.

For more information on using the Formula editor, refer to The Formula Editor in Database
Conventions.

The Quick Report Editor (Cont’d)

Adding Formulas to a Quick Report
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3. Click OK to assign the formula to the column.

MSDSpro adds a new label to the column that identifies it as a formula. You can relabel the
column by typing a label into the header cell for that column.  Formulas are labeled C1 through
Cn. The labels are the names of variables that contain the column’s value. You can use these
variables in other formulas.

An important feature of the Quick Report editor is the ability to sort the records in your report. You sort
records for two reasons:

n To view records in a particular order.

n To create groups of records and Break areas in the report for the purpose of reporting
summary calculations for groups.

See the section Setting Break Levels later in this section for information on summary calculations.

After you specify the columns for your report, you can specify a sort order. You set a sort order by
selecting the column to sort, and then set the Sorted property. For example, if you wanted to sort the
records of Inventory by the Storage_Location field, you would select the Sorted property for the
Storage_Location column.

You can also sort on a formula by selecting the column that contains the formula and then clicking the
Sorted check box or choosing Sorted from the Quick Report pop-up menu for that column. See Adding
Formulas to the Report earlier in this section for more information on adding formulas to Quick Reports.

To specify the sort order using the Sorted check box:

1. Select the column that contains the field or formula you want to specify as the first
sort level.

2. Click the Sorted check box.

To specify the sort order by dragging:

1. Drag a field from the Fields list to the Sort Order list.

If the field is not already in the Quick Report design, MSDSpro adds it as the last field in the
design.

The Quick Report Editor (Cont’d)

Sorting Records and Creating Breaks

Specifying a Sort Order
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To specify a sort order using the Quick Report pop-up menu:

1. Hold down the right mouse button on the column header belonging to the column to
sort.

The Quick Report pop-up menu appears.

2. Choose Sorted from the pop-up menu.

MSDSpro displays the name of the field in the Sort list.  To the right of the name is an arrow,
indicating an ascending sort order.  By default, all sorts are performed in ascending sort order.

3. If necessary, click the sort direction arrow to sort the column in descending order.

The Quick Report Editor (Cont’d)

Sort direction
arrow

Sorted check
box

4. If desired, select additional fields or formula columns and add the Sorted property
using either the Sorted check box or pop-up menu command.

You can specify ascending or descending sort order for any additional fields or formulas you
specify.

When you specify multiple sort levels, MSDSpro sorts the records on the first field in the Sort
field list, then on other fields in the order that they appear in the list. For example, if you
specify the Manufacturer field as the primary sort field and Product Name as the secondary
sort field, your design might look like the Quick Report design shown above.
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To change the level of a Sort field:

1. Drag the name of a field or formula up or down within the sort list to the
desired sort level.

You can delete any field or formula from the Sort list.

To delete a field or formula from the sort order:

1. Select the column and deselect the Sorted check box, or hold down the right
mouse button on the column header to display the Quick Report pop-up menu
and deselect the Sorted menu command.

MSDSpro removes the field or formula in the Sort field list.  It does not delete the
column itself from the report.  When you print the report, MSDSpro will no longer use
that field or formula to sort the records.

In a Quick Report, you set Break levels to separate or “break” records into groups according
to values in one or more sort fields. A Break area is printed at each break level. You can print
summary calculations in the Break area. The summary calculations - sum, average, minimum,
maximum, and count -  are calculated for each group of records.

Break levels are determined by the sort levels and Break rows. For example, if you tell MSDSpro
to sort records by Storage_Location and create a Break row, MSDSpro inserts a break between
each group of records that have the same Storage_Location.

After you add a Break row to the Quick Report, you can request summary calculations on
each break. For example, you can insert a summary calculation in a Break row to display
Count subtotals for each Storage_Location. Refer to “Adding Summary Calculations” later in
this chapter for more information on adding summary calculations to Break and Total rows.

To insert a Break row:

1. Choose Add Break from the Edit menu, or hold down the right mouse button
on the Total row label in the Row label bar and choose the Duplicate Break
menu command.

The Quick Report Editor (Cont’d)

Setting Break Levels
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The Quick Report Editor (Cont’d)

MSDSpro adds a Break row.  The figure shows a Break row in a quick report design:

2. If desired, add additional Break rows by repeating step 1.

There should be at least as many sort levels as Break levels.

MSDSpro adds a sequential number to each new Break label in the row label bar, for example,
Break1, Break2, Break3, and so forth.

You can improve the appearance and comprehensibility of your reports by labeling each Break row
using the value of the Break field.

To request that the value of a Break field be printed in a label placed in the Break area, use the number
sign (#) in the label. For example, the text “Subtotal for #” will insert the Storage_Location (in this
case, the value of the Storage_Location field) in place of the number sign when the report is printed.

The number sign does not need to be placed in the same column as the Break field. It will display the
value of the Break field in any cell in the Break row.

Using the Values of Break Fields in Labels

Break row
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The figure below illustrates the use of the number sign in a label in the Break row:

The Quick Report Editor (Cont’d)

Number sign
used in label

Summary calculations on the contents of fields and formulas can be added to each Break row and to
the Totals row.

The check boxes in the Cell area of the Quick Report editor identify the summary calculation options
available for quick reports. The following types of summary calculations are available.

n Sum: Totals the values in the report or Break.
n Minimum: Displays the lowest value in the report or Break.
n Maximum: Displays the highest value in the report or Break.
n Average: Calculates the average of the values in the report or Break.
n Count: Calculates the number of records in the report or Break.

These options also appear in the Quick Report pop-up menu for cells in the Break and Total rows.

When you place a summary calculation in the Totals row, the calculation is done for all records in the
report. If you place the summary calculation in a Break row, the calculation is done for the records in
the Break.

Adding Summary Calculations
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To add a summary calculation:

1. Select a cell in a Break row or in the Totals row where you want to insert the summary
calculation.

The Sum, Minimum, Maximum, and Average calculations work only on a numeric field or
formula.

2. Click as many summary calculation check boxes as you like, or hold down the mouse
button and choose the desired summary calculations from the Quick Report pop-up
menu for cells.

MSDSpro displays a calculation icon in the selected cell for each type of summary calculation
you request. The figure below shows a Count icon in the Break 1 and Total rows.

The Quick Report Editor (Cont’d)

If you add more than one summary calculation to a cell, MSDSpro stacks the calculation icons on top
of each other.

Calculation
icons in Break
and Total rows
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In a report with Breaks, the columns which are used to group records so that summary calculations
can be done are called Break columns. In the report shown below, the Storage_Location field is a
Break column since the records in the report are grouped by Storage_Location.

When a report like this is printed, the values for the Break column are printed only once per Break. In
other words, a Storage_Location is printed only for the first record in the group and is not repeated until
the Storage_Location changes.

In some cases you may want to repeat the values for the Break columns so that they appear for every
record in the Break area.  To do so, select the Repeated Values column property.  You can do so either
by clicking the Repeated Values check box in the Column Properties area or by choosing the Re-
peated Values menu command in the Quick Reports pop-up menu for that column.

To display repeated values for fields in Break columns, follow these steps:

1. Select the Break column by clicking above the Header row for that column and click
the Repeated Values check box, or hold down the mouse button on the Header row
of the Break column and choose Repeated Values from the Quick Reports pop-up
menu.

The Quick Report Editor (Cont’d)

Nonrepeating
Break values

Displaying Repeated Values for Break Columns

The figure shows the report at
the top of this page after the
Repeated Values check box
has been checked for the
Storage_Location column:
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You can specify display formats for columns that contain Numeric, Alphanumeric, or Boolean data.
For example, if you are displaying salaries in a column, you can add a numeric format to the Detail cell
for the quantity field. If your report includes Alpha fields such as a telephone number or Social Security
number, you can use an Alpha format. If your report displays values for a Boolean field such as true/
false or yes/no, you can use a Boolean format.

This section explains how to use Numeric, Alpha, and Boolean formats. It then shows you how to
specify a format for a particular field by entering the format into the Quick Report layout.

The following format places a dollar sign to the left of the number and allows up to 6 digits:
$###,###

This format can display dollar amounts up to $999,999.

You can use an Alpha format for fields that contain string information. For example, social security
number or telephone number fields can be formatted with an Alpha format.

The following format would be used to format Social Security numbers:
###-##-####

You can specify a Boolean format for fields that contain information which can be evaluated as either
TRUE or FALSE or as only one of two values (e.g. Yes or No).

If you do not apply a display format to a Boolean field, the values are displayed as either TRUE or
FALSE.

To substitute different values for TRUE and FALSE, separate the two values you want to display with a
semicolon. The example below shows a display format for a field in an invoicing database.
Paid;Unpaid

To enter a display format for a Numeric, Alpha, or Boolean field:

1. Click twice in the Detail cell for a Numeric, Alpha, or Boolean column.

The Quick Report Editor (Cont’d)

Setting Display Formats

Numeric Formats

Alpha Formats

Boolean  Formats

Entering the Display Format for a field
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The Quick Report Editor (Cont’d)

2. Type a display format.

If you have also requested summary calculations for that column, the format specified in the
Detail cell will automatically be applied to the summary calculations. The count is always
displayed as an integer without formatting symbols such as the dollar sign.  Different formats
can be applied to different columns in the report.

To enter a display format from the Quick Report pop-up menu:

1. Position the pointer over the Detail cell for a column and hold down the right mouse
button and choose a display format from the hierarchical menu.

The hierarchical menu will show display formats that are appropriate for the data type of the
column.  For example, if the field was an Alpha format, the menu command would be “Alpha”
instead of “Numeric” and the submenu would list only Alpha formats.

After you make your selection, you can edit the format normally.

If you have also requested summary calculations for that column, the format specified in the
Detail cell will automatically be applied to the summary calculations.  Regardless of the
display format, the count is always displayed as an integer without formatting symbols such
as the dollar sign.

Different formats can be applied to different columns in the report.
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MSDSpro lets you hide rows or columns when printing a Quick Report.  If desired, you can show a
hidden column or row.

Hiding rows is useful, for example, when you want the report to include only summary calculations.
For example, hide the Detail row if you want to display only the summary calculations that appear in
the Totals and Break rows. You can also use this feature to hide a Break row or the Totals row.

You can hide a column if you need to use the column as a sort column, but do not want the report to
display the column.

You can hide a row using either a Quick Report menu command or the Quick Reports pop-up menu.

To hide a row using the menu command:

1. Select the row you want to hide.

2. Choose Hide from the Edit menu.

To hide a row using the pop-up menu:

1. Hold down the right mouse button over the row label in the Row label bar.

The Quick Reports pop-up menu appears.

2. Choose Hide from the pop-up menu.

MSDSpro displays the row in gray to remind you that the row will not appear when you print or
preview the quick report.

The Quick Report Editor (Cont’d)

Hiding Rows and Columns
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The Quick Report Editor (Cont’d)

You can also use a menu command or the Quick Reports pop-up menu to hide a column.

To hide a column using the menu command:

1. Select the column you want to hide.

2. Choose Hide from the Edit menu.

To hide a column using the pop-up menu:

1. Hold down the right mouse button over the column header.

The Quick Reports pop-up menu appears.

2. Choose Hide from the pop-up menu.

MSDSpro displays the column in gray to remind you that the row will not appear when
you print or preview the quick report.

When a row or column is hidden, the Hide menu command in the Edit menu and Quick Report
pop-up menu becomes Show.  You can display a hidden row or column choosing Show from
either the Edit or pop-up menu.  When you do so, the row or column is displayed normally in
the Quick Report area.

Hidden row

Showing a Hidden Row or Column
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Before printing a Quick Report, you can add page headers and footers. You specify page headers and
footers in the Headers and Footers window. Use this dialog box to do the following:

n Add page header and footer text
n Specify the size of the page header and footer areas
n Specify fonts, font sizes, and font styles for page header and footer text
n Insert codes that add page numbers and the date and time to your reports

Page headers can only be specified when printing to a printer. See Printing a Quick Report later in this
section for more information about alternate output devices.

To add page headers and footers:

1. Choose Headers and Footers from the File menu.

The Headers and Footers window appears.

The Quick Report Editor (Cont’d)

The Header and Footers window lets you specify both headers and footers from the same screen.  You
use the Edit drop-down list to specify either the header or footer.

2. Choose Header or Footer from the Edit menu.

3. Enter the header or footer height in the Height area.

When you first enter the dialog box, the header and footer are set to 25 pixels each. You can
change values for the height and can use the measurement scale to enter values in inches or
centimeters.  As you enter the header and footer height, the dotted lines on the page preview
area change to indicate the size of the header and footer as they will appear on the printed
report.

Edit drop-down list

Measurement scale
drop-down list

Height

Header and Footer
entry areas

Page preview area

Adding Page Headers and Footers
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To the right of each entry area is a pop-up menu that lets you insert variables into the entry area.

You can insert the current Page Number, Time of Printing, or Date of Printing.

To insert a variable, choose it from the pop-up menu.  MSDSpro inserts the variable in the entry area at
the insertion point.  You can combine variables with text.

You can specify different fonts, font sizes, justification, and styles for page headers and footers.

To specify font attributes:

1. Choose a font and font size from the drop-down lists and click one or more Style
check boxes.

Specified attributes are applied to all three entry areas.  You cannot apply different font attributes
to different areas of the header or footer.  Some Style combinations are not valid.  For example,
you can choose Bold and Italic, but you cannot choose both Plain and Bold.

The Quick Report Editor (Cont’d)

4. Select an entry area and type the header or footer text.

Header and footer
variables

Specifying Font, Font Size, Justification, and Style
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The Quick Report Editor (Cont’d)

After you have completed your report design, you can print the Quick Report. You can print a Quick
Report to a variety of output devices:

n Printer

n Disk File

n Graph

To select an output device:

1. Choose Print Destination from the File menu.

The Print Destination hierarchical menu contains three items:

Printer

This option uses the default printer you have chosen.  You can print to a printer without using the Print
Destination item by choosing Print from the File menu.  If you are printing to a printer, you can preview
the report before printing it.

To print to a printer:

1. Choose Print from the File menu.

2. Click the OK button and follow the standard MSDSpro procedure for previewing and
printing your report.

3. Choose the settings that are appropriate for your report and click the OK button.

Disk File

This option sends your Quick Report to a disk file that you can open and modify with other applica-
tions, including text editors and spreadsheets.  This option exports the records in the Quick Report to
a text file.

When you use this option, MSDSpro automatically uses the column headings as the first “record” that
is exported.

Printing a Quick Report
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To print to a disk file:

1. Choose Disk File from the Print Destination hierarchical menu.

2. Choose Print from the File menu.

MSDSpro displays a standard Create File window to enter a filename for the new file.

3. Enter a filename and click the OK button.

MSDSpro displays a dialog box that keeps you informed of the progress of the operation.
Click the STOP PRINTING button to cancel the operation.

After the report is printed to a file, MSDSpro returns you to the Quick Report editor.  Remember
to change the output device if you want to resume sending a Quick Report to a standard
printer.

Graph

This option directs the report to a 4D Chart, MSDSpro’s plug-in for plotting data.  When you choose the
Graph item in the Print Destination hierarchical menu, your report is presented as a graph rather than
in tabular form.  4D Chart uses only the summary calculations and labels in the Break row.  It uses the
left-most non-numeric column for the Values axis (the horizontal axis).

To use the graph feature, the report should do the following:

n Include from one to five numeric fields or formulas. These columns will be assigned
to the values axis in the graph.

n Use one type of summary calculation per numeric field.

For example, if you want to graph average quantities by Storage_Location, you should create a Quick
Report with two columns, Storage_Location and Number_Containers. Use the Average summary
calculation for Number_Containers.

The Quick Report Editor (Cont’d)
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To print to a graph:

1. Choose Graph from the Print Destination hierarchical menu.

2. Choose Print from the File menu.

MSDSpro graphs your data as a column graph.

The following figure shows the graph produced from the Quick Report design shown on the previous
page:

The Quick Report Editor (Cont’d)

Value to be graphed
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Importing Data

Printing From Output Forms

To print the current selection of records shown in the Output form of the current table, select Print from
the File menu.

Printing From Data Entry Forms

To print the current record that is shown in the Data Entry form, select Print from the File menu.

The import of external data into MSDSpro is a simple process.  MSDSpro automatically removes
extraneous characters from the data being imported (control characters, escape codes, and quotes).

To import data into MSDSpro:

1. Select Import/Export from the Admin Control Panel Special Functions tab.
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2. Select the Import Table.

The Output form will display all records for the selected table.

3. Select Import Data from the File menu to display the Import editor, as shown:

4. Select from the Fields List on the left side to APPEND or INSERT into the Fields to
Import list on the right side.

The order shown in Fields to Import must be the same order that the data columns are stored
in the file to be imported.

5. Select fields that need to be removed from the Fields to Import and click REMOVE.

6. Select the proper field and record delimiters.

If you are importing data that contains free-flowing text fields (like Notes fields in the Product
table, or the Document field), you must use a non-standard delimiter in the file to import.  The
reason is that a Tab (ASCII Code 9) or Return (ASCII Code 13) could be typed in the free-
flowing text fields, but are sometimes also used as field and record delimiters.  You must
choose delimiters that were used to create the file to import, and will not be contained in the
data itself.

7. Click Skip Header Record if header information exists in the data being imported.

8. Click IMPORT to import the data from disk file.

Importing Data (Cont’d)
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Exporting Data

The exporting of data from MSDSpro is a simple process.  To export data from MSDSpro:

1. Select Import/Export from the Admin Control Panel Special Functions tab.

2. Select the Export Table.

The Output form will display all records for the selected table.

3. Search for the records that will be exported using the Search editor.

4. Sort the records in the order required in the final disk file using the Sort editor.

5. Select Export Data from the File menu to display the Export editor, as shown:

6. Select from the Fields List on the left side to APPEND or INSERT into the Fields to
Export list on the right side.

The order shown in Fields to Export will be the same order when they are exported.

7. Select fields that need to be removed from the Fields to Export, and click REMOVE.

8. Select the proper field and record delimiters.

If you are exporting data that contains free-flowing text fields (like Notes fields in the Product
table, or the Document field), select Special from the choice list of available delimiters, and be
sure to not use Tab (ASCII Code 9) or Return (ASCII Code 13) because they may be contained
in the data itself and would not be useful as delimiters.
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You do a global update when you want to make a special change to a group of records or to automate
changes to a database that would otherwise be tedious and time-consuming. For example, you would
perform a global update if you wanted to do the following:

n Change all End Dates in the Inventory table to a certain date

n Format a Numeric or Alpha field

The global update is done by “applying” a formula to the current selection of records. That is, the
formula is used to make the change to each record in the current selection.

Here are two example formulas and explanations of the functions they perform:

End Date:= !12/31/97!

This formula applies the date of 12/31/97 (contained within “!” on each side of the date) to the End
Date field.  The !12/31/97! format is how MSDSpro recognizes the value specified as a date value.
A null date would be typed as !00/00/00!, for example.

Product Name := Uppercase (Product Name)

This formula uses a built-in function to make the contents of the Product Name field uppercase. It
ensures uniformity in the way Product Name appears in labels and reports.

To perform a global update, you use the Formula editor to write a formula that is applied to each record
in the current selection in the current table only.

You use MSDSpro’s built-in commands to create formulas.

The Formula editor provides many shortcuts for writing formulas. You can click field names, operators,
and commands to add them to the formula.

The Formula editor contains the following areas:

n Editing area: This area displays the formula as you build and edit it. You create the
formula in this area.

The Formula Editor

Apply Formula

9. Click Include Header Record if you want to include headers in the exported data.

10. Click EXPORT to export the data to a new file.

Exporting Data (Cont’d)
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n Keywords list: This area contains a list of operators used to build a formula.

n Fields list: This area displays the names of the fields and layouts in the current table.
The cycle arrows at the top of the fields list allow you to view the contents of other
tables in the database. Click between the cycle arrows to display a complete list of
all table names to select from.

n Routines list: This area contains an alphabetical listing of all MSDSpro built-in
commands and functions.

n Buttons area: This area contains buttons for saving your formula, loading other formulas
from disk, canceling an editing session, and applying the formula.

You build a formula by clicking keywords, field names, and commands. When you click an item, it
automatically appears in the Editing area, where you can modify it with standard cut, copy, and paste
techniques. You can also type directly into the Editing area.  A formula can be only one logical line
long. You cannot press Return and type another line.

To perform a global update to all records in the current selection:

1. Set the current selection to the records to be updated using searches or Show Subset
from the Output form of the current table.

2. Choose Apply Formula from the Selection menu.

3. Use the Formula editor to build the formula. Or, click the LOAD button to retrieve an
existing formula from disk.

If you click the Load button, MSDSpro displays an Open File window and asks you to select
a file. When you load a file, it replaces any formula that currently appears in the Formula
editor. After you load a formula, you can modify it in the editing area.

4. If you want to save a new formula in a disk file, click the SAVE button.

MSDSpro displays a Save File window and asks you to name a file to store the new formula.

The Formula Editor (Cont’d)
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5. Click the OK button to apply the formula to the current selection.

MSDSpro closes the editor and applies the formula to the records in the current selection.
Click the CANCEL button to close the editor and return to the Output form without applying
the formula.

The formula shown will append a carriage return (char(13) is the ASCII value of 13) and “Entered
by KJP from Source TAW” to the existing contents of the Notes field in the Product table, for
each record in the current selection.

The Formula Editor (Cont’d)
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The Find Function

The Find Function is used to search the MSDSpro database and/or the MSDSpro CD library for
MSDSs. It is only available on those computers upon which MSDSpro has been installed. The Find
Function is accessed by clicking on the Find button located on the floating toolbar. Clicking on the
Find button brings up the Find MSDS dialog. The Find MSDS dialog consists of three tabs, the
Simple Search tab, the Complex Search tab, and the Location Criteria tab.

Simple Search Tab: The Simple Search tab allows users of the Find Function to search either the
MSDSpro database, the MSDSpro CD library, or both simultaneously. The Simple Search tab consists
of the following components.

Search Methods: Search Methods defines how searching will occur.  Search Methods available
under the simple search tab include:

n Word Begins With/Word Contains: Controls whether the information being searched
upon must match the beginning of a word or be contained within that word. Selecting
“Word Begins With” and searching for “ace” will only return records in which “ace”
is in the beginning of the field being searched. For example, if the search was
performed on the Product Name field then the product “Acetone” would be returned
but the product “Formace” would not.

n Exclude/Include CD-ROM MSDS library: Controls whether or not the MSDSpro CD
library will be included in the search. If the checkbox is checked, the MSDSpro CD
library will be included in the search.

n Include products without documents: Controls whether or not product records with
no attached MSDS will be included in the search.

NOTE: Include products without documents is only available to users logged in as DBA.



Administrator Guide 3 - 57

Section 3:  Database Conventions and Operations

n Limit: Sets the maximum number of search results that will be returned in a search.
For example, if the limit pull down menu is set to 1000, then only the first 1000 matches
to the information being searched upon will be returned, regardless of the total number
of matches in the database.

Search Criteria: Search Criteria define which fields will be searched. Performing a search with the
Search Criteria “Product Name” selected will return matches only to entries made in the Product
Name field within the Product record. Search Criteria for performing a Simple Search include:

n Product Name: Searches the Product Name field. This field is found under the Product
tab within the Product record.

n Sounds Like: Searches for product names that are phonetically similar to the search
criteria.

n Manufacturer: Searches the Manufacturer Name field. This field is found under the
Product tab within the Product record.

n Ingredient CAS #: Designates the Ingredient CAS # field as the field to be searched
upon. This field is found under the Ingredient tab within the Product record.

Complex Search tab: The Complex Search tab allows users of the Find Function to perform much
more specific searches. Whereas in the simple search mode a user can search on only one field at a
time, under the Complex Search tab a user can search multiple fields simultaneously. For example,
a user could search for product “acetone” made by manufacturer “Example Corporation” within a single
search. The Complex Search tab is useful when significant information is known about a specific
product to be searched upon and greatly reduces the number of search results the end user will have
to look through in order to find the information desired.

The Find Function (Cont’d)
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Search Methods: Search Methods available under the Complex Search tab include:

n Word Begins With/Word Contains: Controls whether the information being searched
upon must match the beginning of a word or be contained within that word. Selecting
“Word Begins With” and searching for “ace” will only return records in which “ace”
is in the beginning of the field being searched. For example, if the search was
performed on the Product Name field then the product “Acetone” would be returned
but the product “Formace” would not.

n All words/Either word: Controls whether MSDSpro will try to match all the words or
any word entered into the search field.

n Exclude/Include CD-ROM MSDS library: Controls whether or not the MSDSpro CD
library will be included in the search. If the checkbox is checked, the MSDSpro CD
library will be included in the search.

n Include Products without documents: Controls whether or not a product record that
does not have an attached MSDS will be included in the search.

n Limit: Sets the maximum number of search results that will be returned in a search.
If the limit is set to 1000, then only the first 1000 matches to the search criteria will be
returned regardless of the total number of matches in the database.

Search Criteria: Search Criteria available under the Complex Search tab include:

n Product Name: Searches the Product Name field. This field is found under the Product
tab within the Product Record.

n Sounds Like: Searches for words that sound similar to the search criteria.

n Manufacturer: Searches the Manufacturer Name field. This field is found under the
Product tab within the Product Record.

n MSDS ID: Searches the MSDS ID field. This field is found under the Product tab within
the Product Record.

The Find Function (Cont’d)
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Location Criteria tab: The Location Criteria tab allows users to search for MSDSs based on the
location at which the product is stored. This tab is used when users not only want to find an MSDS but
also want to know to which locations, if any, it has been assigned as inventory. The Location Criteria
tab is only used to further refine the criteria under which either a simple or a complex search will be
performed.

The Find Function (Cont’d)

Search Methods: Search methods available under the Location Criteria tab include:

n All Locations/This Location/All Sub Locations: Controls which locations will be searched
for MSDSs matching the information searched upon. Choosing “This location” will
only search the location selected but will not search any sublocations of that location.
Choosing “All Sublocations” will search all the sublocations of the location selected.
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Data Access allows access to the following tables/data entry areas within MSDSpro:

n Product Entry Wizard

n Products

n Company

n Locations

n Inventory

n Chemicals

n Chemical Authorization Requests

n Phrase Library

n Containers

n Assets

n Users

n MSDS Requests

n Waste Codes

Data Access areas are accessed from the Admin Control Panel.

Admin Control Panel

Data Access
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Product Entry Wizard

The Product Entry Wizard allows the end user to add new product records to the MSDSpro database
quickly and easily with basic information. When new product records are created using the Wizard,
information can be added to the following fields within the Product record.

n Document: Documents of many types and sources may be imported into the system.

n Product Information: Product Name, MSDS ID and Product Properties or
characteristics such as PH and Specific Gravity can be added in this field.

n Details: Specific information such as Synonyms, specific flagging, can be added in
this field.

n Company: Manufacturer Information.

n Ingredients: Ingredient Name, CAS number and Weight percents can be added in
this field.

n Inventory: Detailed Inventory information on each product can be entered into this
field.

The Wizard requires only the Product Name and Manufacturer Name fields to be populated. The
Wizard is accessed from the Data Access tab on the Admin Control Panel.

Click the WIZARD button to access
the Product Entry Wizard
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Product Entry Wizard (cont’d)

Document Tab:

Import/Create: Inside the Document tab you can Import Supported Document files from your hard Drive,
the Manufacturers web site or create an ANSI Text Document.

CD Document: Import a MSDS from the CD library.  Product Ingredient and manufacturer information will be
populated automatically.

Revision Date:  This is the date the MSDS was revised.

Import Date: The date that the MSDS was entered into your system.

Special Instructions: Additional information from the administrator regarding specific fields.
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Product Entry Wizard (cont’d)

WIZARD PRODUCT TAB

Product Name: Enter the name of your product here.

MSDS ID: If you currently have a tracking number devised for your MSDSs you may enter in that
number into this field.  Otherwise you may let the database automatically assign new
tracking numbers for your MSDS.

Special Instructions: Additional information from the administrator regarding specific fields.
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Product Entry Wizard (cont’d)

Details Tab

Synonyms: Enter all synonyms for your MSDS here.

NFPA Ratings: Enter in the NFPA symbol rating here, if relevant.

HMIS Ratings: Enter in the HMIS symbol ratings here, if relevant.
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Product Entry Wizard (cont’d)

Manufacturer Tab

I

Ingredient Tab

Company Name: When you enter in the Company name, MSDSpro will automatically complete this field, if
the company has already been entered into your system.  If it is a new entry, type in the company name, hit next
and you will be prompted to enter in that manufactures information.  See MANUFACTURE DATA ENTRY FORM 4-
50 (this page number will/has changed  update for final review)

The Ingredient tab allows you to enter the chemical components of each product that you enter.

CAS Number: Enter in the designated chemical number.

Ingredient Name:    Enter in the chemical name of the chemical.

Min Weight: Enter in the Minimum Weight Percentage of this chemical.

Max Weight: Enter in the Maximum Weight Percentage of the chemical.
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Product Entry Wizard (cont’d)

Inventory Tab

This is where you will assign your product to specific locations.  Use the Location Drill Down to find the locations
where the product is used or stored.
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The Wizard Setup

The Wizard Setup can be found by going to ADMIN, Special Functions.

New: Create a new Wizard job.
Delete: Delete an existing Wizard job.
Duplicate: Duplicate an existing Wizard format job.
Export: Save your Wizard job to a file.
Import: Import a saved job from a file.
Close: Close this window.

The Administrator may modify the information presented within the Wizard.  New wizard configurations may also be
created.
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To customize a new Wizard job, first select the pages that will be available.  PRODUCT, DETAILS,
MANUFACTURER, INGREDIENT, INVENTORY or DOCUMENT.

The Wizard Setup (cont’d)

Title Page

n Default Help: By selecting the Default Help button, the pre-designed help menus will be
visible.

n Special Instructions: By selecting the Special Instructions button, the administrator will have the
ability to add specific instructions for each feild.
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The Wizard Setup (cont’d)

Document

With each field that you select, the Database Administrator has the ability to check those fields as being Optional or
Required. The Database Administrator will also be able to enter default values and any Special Instructions to aid in the
entry process. Double click within the cell to enter information.

Choose which fields to track in the Document Tab, Revision Date, Import Date or Path.

With Default Help on, Special Instruc-
tions will not be visible.

Default Help is off, and the Special
Instructions are now  visible.
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The Wizard Setup (cont’d)

Product
The Product Tab of the Wizard setup will allow the Database Administrator to select specific information to enter into
MSDSpro from the MSDS. Special Instructions can be added for each entry for Product Name, MSDS ID, Date Entered,
Notes, Specific Gravity, Melting/Freezing Point, Boiling/Cond. Point, pH, Oder, Viscosity, ,Color/Apperance, Physical
State, Vapor Pressure, Vapor Density, UEL, FP Method, Flash Point, Density lbs/Gal., Molecular Weight, Solubility,
Evaporation Rate, VOC%, Percent Volatile and Molecular Formula.
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Details

The Details Tab of the Wizard setup will allow the Database Administrator to select specific information to enter into
MSDSpro from the MSDS.  Special Instructions can be added for each entry for Synonyms, NFPA, HMIS, PPE,
Route of Entry, Target Organs & Effects, Health Hazards and Physical Hazards.

The Wizard Setup (cont’d)
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The Wizard Setup (cont’d)

Manufacturer

The Manufacturer Tab of the Wizard setup will allow the Database Administrator to select specific information to
enter into MSDSpro from the MSDS regarding the Manufacturer.  Each field can be marked as Required or Optional,
and Special Instructions can be added for each entry for Company Name, Address, City, State, Prov., Postal Code,
Phone number, Phone Extension, Emergency Phone, Fax Number, Contact name, Country, Notes and Website
URL.
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The Wizard Setup (cont’d)

Ingredient

The Ingredient Tab of the Wizard Setup will allow the Database Administrator to select specific information to enter
into MSDSpro regarding key ingredient information.  Each field can be marked as Required or Optional, and Special
Instructions can be added for each entry for Ingredient Name, CAS Number, Min Weight %, Max Weight % and
Weight %.
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The Wizard Setup (cont’d)

Inventory

The Inventory Tab of the Wizard Setup will allow the Database Administrator to select specific information to enter
regarding Inventory.  Each field can be marked as Required or Optional, and Special Instructions can be added for
each entry for Start Date, End Date and Notes.



Section 4:  Data Access

4 - 16 Administrator Guide

Products

Product records are the basis for the entire MSDSpro system.  The Product record itself consists of
the data needed to describe the MSDS product represented.  There are many data tables that are
related to the Product table.

Product Output Form

By choosing Print from the File menu, the displayed Product records can be printed.  In addition to the
contents of the current window, the MSDS Documents and Product Summaries can also be printed.

From the Product Data Entry form, the MSDS Documents and Product Summary for the current
Product record can be printed.
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Product Data Entry Form

The Product record consists of the MSDS Product information that is only stored once.  For example,
Product Name, Manufacturer, Revision Date, Intended Use, Shelf Life, Description, etc.

The CANCEL and SAVE buttons will function on any form page and affect the data on all other form
pages.

Product Data Entry Form - Product Tab

n Click on the CD-ROM button to search for the MSDSpro CD Library for an MSDS.

n Click on the SELECT button to select from a list of all existing company records.

n Click on the VIEW button to view the information associated with the selected company.

n Click on the DELETE button to delete this product record from the database.

n Click on the DUPLICATE button to create a second copy of this product record.

n Click on the EDIT LOG button to manually view the text log tracking changes to this
product record.
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Product Data Entry Form - Product Dates subtab

The Product Dates subtab displays and stores important dates associated with a particular product.

Product Data Entry Form (cont’d)

n The Date Entered field displays the date the product record was created.

n The Entered By field displays the name of the person who created the product record.

n The Review Date field displays the date on which the MSDS was last reviewed for
accuracy.

n The Start Date field displays the date on which usage of the product began.

n The End Date field displays the date on which usage of the product was terminated.

n The Review Number field displays a unique numeric identifier designed to differentiate
the review of this MSDS from others.

n The Expected End Date field displays the date on which usage of the product is
expected to cease.

n The Shelf Life field displays how long the product can be stored before it must be
disposed of.

n The Reviewed By field lists the name of the person who last reviewed the document.
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Product Data Entry Form - Characteristics subtab

The Characteristics subtab displays and stores important characteristics of a particular product.

Product Data Entry Form (cont’d)

n The Specific Gravity fields displays the ratio of the density of the product to the density
of water.

n The Density field indicates the how many pounds one gallon of the product weighs.

n The Flash Point field displays the temperature at which the product is expected to
ignite or explode.

n The FP Method field displays the proper storage to prevent the product from causing
a fire.

n The LEL field displays the lower exposure limit for the product.

n The UEL field displays the upper exposure limit for the product.

n The Pure and Mixture checkboxes indicate whether the product is a pure substance
or a mixture of 2 or more substances.

n The Product CAS Number field displays the associated Chemical Abstract Service
number for this product, if one exists.

n The Pounds per Cubic Foot field indicates the how many pounds one cubic foot of the
product weighs.
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Product Data Entry Form - Properties subtab

The Properties subtab displays and stores important properties of a particular product.

Product Data Entry Form (cont’d)

n The Physical State field displays whether the product exists and a solid, liquid or gas.

n The Color/Appearance and Odor fields indicate the appearance and smell of the
product.

n The Viscosity field lists the products associated resistance to flow.

n The pH field lists the acidity of the product.

n The Boiling Point and Melting Point fields indicate at what temperature the product
converts from a solid to a liquid and from a liquid to a gas.

n The Solubility field displays the products capacity to be dissolved.

n The Evaporation Rate field displays the products potential for evaporation.

n The VOC % field displays the percentage of the product classified as volatile organic
compounds.

n The Vapor Density and Vapor Pressure fields display the density of and pressure
exerted by the product’s evaporate at normal atmospheric pressure.

n The Percent Volatile field lists the percentage of the product with the potential to
evaporate at normal atmospheric and temperature ranges.

n The Molecular Formula field displays the chemical makeup of the product.

n The Molecular Weight field displays the weight of one mole of a compound.
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Product Data Entry Form - Document Tab

The Document tab displays a list of MSDSs or other documents attached to the product record and
information associated with each one.

The attached
documents window
lists each MSDS
attached to the
product record and
its related
information

n Click on the NEW button to create a new document for the current product.

n Click on the IMPORT button to attach a MSDS to the highlighted document.

n Click on the VIEW button to view the highlighted document.

The EDIT button appears when either the selected Document is a Text or ANSI text.

n Click on the DELETE button to delete the highlighted document.

n Check the Show Archived checkbox to list MSDSs that have been archived for this
product.

n Click on the SELECT button to choose the appropriate Manufacturer or Supplier record
from a list of all existing records.



Section 4:  Data Access

4 - 22 Administrator Guide

Product Data Entry Form - Document Tab (cont’d)

n Click on the VIEW button (to the right of the Company Name and Document Supplier fields) to
view the record associated with the entry in the Manufacturer Name  or Supplier field.

n Check the No Auto Update checkbox to prevent this document from being included in any of
MSDSpro’s automatic update functions.

n Check the WHIMIS Document checkbox to indicate that this product is covered under WHIMIS.

n The Revision Date field displays the date the highlighted document was last revised.

n In the Document Language field, select the language the highlighted document is written in.

n In the Document Status field, select whether the highlighted document is available or
unailable.

If the Document Status is set as unavailable, this document will not be returned in search
results.

n The Classification field shows what kind of document is associated with the highlighted line
item.

The Classification field defaults to MSDS but will show proper text if the attachment is a Site
Map, Technical Data Sheet, or Data Sheet.
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Adding a document to the product record

To add a document to the product record

1.  Within the Document Tab, Click on the NEW button.

2.  Click Import.

3.  Select your import Source.

Import Source
There are three ways to import documents.

1. Internet

2. Hard Disk File

3. Scanning Devices

Internet - Adding a web page document to the product record

To add a document to the Product Record from the Internet, choose the Internet option from Import
Source.  A prompt will appear asking for a URL.  To acquire a URL see section 4-24
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Adding a web document to the Product Record

Acquiring the URL for MSDSpro:

To download:

1. Copy the URL from your Web Browser.
This is accomplished either of two ways:

n View the HTML document through
your Web Browser.  Highlight the Lo-
cation (URL) shown and copy to the
clipboard (Ctrl-C).

n Instead of viewing the HTML
document, right-mouse click on the
Link, and select Copy Link Location
(URL), which will copy the URL to the
clipboard.

2. Select INTERNET as Import Source.

3. Click DOWNLOAD.

4. MSDSpro will automatically add the
URL to the Internet Location (URL) field.
MSDSpro will automatically detect the
type of document that is being down
loaded. (PDF, HTML)

5. Click DOW NLOAD.

If errors are encountered, the Proxy settings may
need to be configured in the Preferences area.  See
Preferences within the Special Functions section.
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Adding a document to the Product Record from Hard Disk

Acquiring file from the Hard Disk:

n Select Hard Disk from the Import Source.

n Locate the file on your computer, select the
file to be linked to the Product.

n Press OPEN.

Adding a document from a Scanning Device

n Select Scanning Device from the Import Source
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Adding a document from a Scanning Device (Cont’d)

n Hard Disk: Import images from your hard drive.

n Scanning Device: Access the scanner to be used by selecting it from the drop down menu.

n Remove Pages: Pages selected will be removed.

n Acquire Pages: Activate your scanner.

n Preview Document: View your image before accepting
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Author an ANSI 16 format document

To author an ANSI Text document to the product record:

1. Within the Document tab, click on the NEW button.

A new line item is displayed. The new line item is automatically highlighted.

2. Click on the Author an ANSI 16 format document button.

3. Click on NEXT.

4. Enter MSDS information under the relevant sections.

Product and Ingredient information cannot be added in the ANSI 16 Section Document Data
Entry form. Enter this information under the Product tab and the Ingredient tab within the
product record.

5. Use the Phrase Library to enter as much information as possible.  To learn how to use
the Phrase Library to add phrases to an ANSI 16 Section Document, see Section 4-84.

6. Enter the remaining information by manually typing into the lower text feild of each
section.

7. Once all the information has been entered, click the SAVE button in the lower right
hand corner.

Note: ANSI documents are exported to a PDF document. The PDF version of the document
will be used for display over the Intranet and in any printing or reports.
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Exporting ANSI MSDS Documents

The SAVE AS... button allows for the exporting of the MSDS document.  The file is created after using
the Save File window to select the name for the new disk file and the location to save.  Use this button
to save a copy of the MSDS outside the MSDSpro database

The different export options are:

n PDF 16 Section
Create an ANSI 16 section format MSDS.

n PDF 10 Section
Create a 10 section format MSDS will be created.

n Rich Text (.RTF)
Create a Text file with rich text formatting.

n ASCII Text (.TXT)
Create a plain text file.

n HTML file (.HTM)
Create a Web based file.

1. Select Author or Import a Plain
Text document.

2. Enter in the MSDS information
as needed.

Author or import a Plain Text document

There are two Import Source options for Text MSDS documents:

n Hard Disk: Imports .TXT files from the hard drive.
n Internet: Imports .TXT files from the web.
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Product Data Entry Form - Synonym Tab

The Synonym tab displays the current Synonyms for this Product.  An unlimited number of Synonyms
may exist for each Product.  By default, there is always one Synonym that matches the Product
Name, which cannot be modified or deleted.

When searching MSDSpro by Product Name, the Synonyms are searched for matching keywords.
Sounds-Like Phonetic searching is also used in conjunction with Synonym keywords.

n Click the ADD button to create a new Synonym record.

n Click the DELETE button to remove a highlighted Synonym record.

n Double-click a Synonym to modify the record.
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The Inventory tab is used to add, modify, or delete Inventory and Container records for each Product.
An unlimited number of Inventory and Container records may exist for a Product. The Product is stored
as Inventory at the Locations shown in bold under the Inventory tab.

n Click the ADD button to add an Inventory record.

n Click the DELETE button to remove a highlighted Inventory record.

n Click the EDIT button or double-click to modify an Inventory record.

Clicking on the ADD or EDIT button
loads the Inventory Data Entry form.

The Inventory Data Entry form is
covered on pp. 4-61 through 4-56.

Product Data Entry Form - Inventory Tab
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Adding a Inventory Location

Clicking on the ADD or EDIT button on the Inventory tab loads the Inventory Data Entry form. The
Inventory Data Entry form is covered on pp. 4-61 and 4-62.

1. To add the Product as Inventory to a Location, click on the SELECT button to the right
of the Storage Name field.

This loads a list of all Locations known as the Select Location Output form.
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Adding a Inventory Location  (Cont’d)

The Select Location Output form:

Click SELECT on the Inventory Data Entry form to display a list of all Storage Locations, arranged
within Locations and Sublocations.  MSDSpro can accommodate several thousand levels of Inventory
Locations.  An Inventory item can be assigned to any Location at any level.

n Click the plus sign (+) to the left of a Location name to display its Sublocations.

n Click the minus sign (-) to the left of a Location name to hide its Sublocations.

2. To add a Product as Inventory, highlight a Storage Location and click the SELECT
button  .

To select multiple locations at a single time, hold down the CTRL key and select each location.
Once all of the desired locatoins are highlighted, click on the SELECT button. Once selected,
a Location will appear as bold in the Location list.

3. Click on the DONE button to finish adding the Products as Inventory.
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Product Data Entry Form - Ingredient Tab

The Ingredient tab displays the current Ingredients for this Product.  An unlimited number of Ingredients
may exist for each Product.

n Click the ADD button to create a new Ingredient record.

n Click the DELETE button to remove a highlighted Ingredient record.

n Double-click an Ingredient to modify the record.

To view the list of CAS Numbers
and associated Chemical
records, click the Select button.

A list will appears listing all CAS
Numbers  in the Chemical Table.
If the CAS Number is not found,
the Administrator must enter the
new listing in the Chemical Table
(see Chemicals in Data Access).

Indicate if Chemical is Trade Secret
(Printing is restricted on MSDS)
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Product Data Entry Form - Ingredient Tab (cont’d)

Ordering Ingredients:

MSDSpro  administrators  have  the ability to list ingredients in any order they  desire.  By  default,
ingredients  are  listed in descending order by weight  percent.  Checking  the  Order  Manually
checkbox  allows  MSDSpro administrators to list ingredients in any order they desire.

To change the order of ingredients:

1. Place a check in the Order Manually checkbox.

2. Click on the first ingredient whose position is to be changed.

3. Click on the MOVE UP or MOVE DOWN buttons to move the selected ingredient up
or down the list.

4. Repeat this process until the ingredients are listed in the order desired.
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Product Data Entry Form - PPE & Hazards Tab

The PPE & Hazards tab displays the current PPE and Hazards for this Product.  Click all Hazard or
PPE flags that apply to this Product.

Selections made here will be visible from the Product Hazard Summary report.
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Product Data Entry Form - Phrases Tab

The Phrases tab displays the current Phrase Library records that are associated with this Product.
An unlimited number of Phrase records may exist for each Product.

n Click the ADD button to create a new Phrase record.

n Click the DELETE button to remove a highlighted Phrase record.

n Double-click a Phrase record to modify the record.

n Click the PHRASE LIBRARY button to drag and drop phrases directly into the product
record.
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Product Data Entry Form - Phrases Tab (cont’d)

Ordering Phrases

MSDSpro  administrators  have  the ability to list phrases in any order they  desire.

To change the order of phrases:

1. Click on the first ingredient whose position is to be changed.

2. Click on the MOVE UP or MOVE DOWN buttons to move the selected ingredient up
or down the list.

3. Repeat this process until the phrases are listed in the order desired.
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Product Data Entry Form - Stock Number Tab

The Stock Number tab displays the current Stock Numbers for this Product.  An unlimited number of
Stock Numbers may exist for each Product.  There can be an internal Stock number entered, as well
as a manufacturer Stock Number (which can use the same Stock Number record) and a Bar Code ID.

n Click the ADD button to create a new Stock Number record.

n Click the DELETE button to remove a highlighted Stock Number record.

n Double-click a Stock Number to modify the record.



Section 4:  Data Access

Administrator Guide 4 - 39

Product Data Entry Form - Specific Tab

The Specific tab displays the specific information relating to this Product record.

The Definable Fields are defined by the DBA in the Preferences area, and are completely customizable
for your installed version of MSDSpro.  Changes made are retained in your local data file for future use.
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Product Data Entry Form - Label Tab

The Label tab displays the current NFPA or HMIS hazard rating for this Product.  Either the NFPA or
the HMIS hazard rating can be used at any time, but when presenting the hazard rating to the end
user, the use of the NFPA rating will default if both are specified.

1. Click NFPA or HMIS to allow entry into the hazard rating fields for the appropriate
type of hazard.

2. Select the NFPA or HMIS hazard ratings from the pull-down lists.

3. Click CREATE LABEL to create a container label using blank or preprinted forms.
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Printing Labels for a Specific Product

1. Click CREATE LABEL to select a label style.

2 Select Label Style.
Some labels have pre-printed stock, others print on plain stock.  Use the descriptions and
sock numbers to select the correct label.

3. Select the labels on the page to print.

4. Click OK.
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Product Data Entry Form - Users Tab

The Users tab displays the currently assigned Product Users.

Product Users can have associated distribution information, which streamlines the update process for
those users of specific products.  For example, fax number, mailing address or e-mail address can be
utilized to automatically update Product Users when new updates occur to the MSDS document.

n Click the ADD button to create a new Product User record.

n Click the DELETE button to remove a highlighted Product User record.

n Double-click a Product User to modify the record.
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Product Data Entry Form - Regulatory Tab

The Regulatory tab displays the associated SARA Report codes.  These codes are required if SARA
reporting is utilized within MSDSpro.

SARA Reporting is an optional and powerful function available within MSDSpro, and may not be
required for the purposes of your organization.

n The Import Source pull down menu allows the MSDSpro Administrator to indicate
whether this product was purchased from inside or outside of Canada or manufactured
onsite.

n The Trademarked checkbox indicates if this product is trademarked by the owner
company.

n The TDG checkbox indicates if this product is regulated under the Canadian Dangerous
Goods Transportation Act.

n The Class of Transportation field allows for the entry of additional information relating
to proper procedures governing transportation of the product.
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Product Data Entry Form - Authorization Tab

The Authorization tab displays the departments currently authorized to use the product.

n Check the Authorization Exempted checkbox if this product does not require a
Chemical Authorization Request (C.A.R.) to be submitted before being used.

n Click on the VIEW CAR button to view the C.A.R. submitted by the highlighted
department.
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Product Data Entry Form - Waste Tab

The Waste tab displays the Waste Codes associated with the product. A Waste Code describes the
proper method for disposing of a product.

Clicking on the ADD button
loads the Add Product User
Record Data Entry form.

Click on the SELECT button
to attach a Waste Code.

Enter additional information
into the Specific Description
field if desired.
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n If this product is not required to carry a WHMIS label, check the Not a WHMIS product
checkbox.

n If the product is covered under WHMIS, check the WHMIS label checkbox and check
the WHMIS classification checkboxes that apply to this product.

n Select the Non manufacturer checkbox if the WHMIS information comes from a source
other than the product’s manufacturer.

n Enter into the WHMIS date of Non-Compliance field the date WHMIS information from
a source other than the product’s manufacturer was entered into the product record.

The WHMIS tab provides for the selection of WHMIS categories associated with the product and for
the printing of WHMIS labels.

Product Data Entry Form - WHMIS Tab
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To print a WHMIS label:

1. Enter into the Label Revision field the number of times that this label has been revised
since it was first created.

2. Select the number of labels that will be printed on each page.

3. Select whether the labels to be printed will be either WHMIS or non-WHMIS labels.

4. Check the Advanced Options checkbox to configure additional options.

5. Click on the PRINT LABEL button to print the label(s).

Product Data Entry Form - WHMIS Tab (Cont’d)
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Adding ANSI MSDS Documents from the MSDSpro CD

In order for MSDSpro to access the CD Library, the MSDSpro CD must be in the server CD-ROM drive
before the MSDSpro application is started. MSDSs in the MSDSpro CD Library are formatted as ANSI
text documents. To locate the desired MSDS in the CD Library and attach it to the product record,
click the CD-ROM button on the Product Data Entry form Product tab.

New SearchClick Column Heading to  Sort Search Found Records

Ascending or
Descending
Sort Order

Search Results Limit

Click here

The Select a CD product to add output form appears.

n The Search For entry area is used to specify keywords used in the CD Product Name
and Manufacturer search.

Typing more than one word will search for CD Products that either contain all words entered,
or either of the words entered, depending on the method chosen.
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Adding ANSI MSDS Documents from the MSDSpro CD (cont’d)

New SearchClick Column Heading to  Sort Search Found Records

Ascending or
Descending
Sort Order

Search Results Limit

n The Method choice allows a search that will find word(s) in the Product Name that begin with
the specified word(s), or word(s) that are contained within a larger word string.

Note: choosing the Word begins with is a much faster search than Word contains.

n The Field choice allows a search for a Product Name that matches the specified word(s)
typed (optionally using the Sounds Like phonetic search), or a search for Manufacturer Name
that matches the specified word(s).

n After clicking the SEARCH button, a resulting list of matches will appear (limited to the se-
lected Limit pull-down choice).

n Using SEARCH SELECTION will narrow the search within the currently found records only.

For example, searching for “red paint” first, then specifying a Manufacturer Name of “krylon”
and clicking SEARCH SELECTION will search the currently found “red paint” records for only
the records belonging to the new manufacturer specified.

n Click PREVIOUS to restore the previous records.

n Simply select the Product and click the ADD button to add it as a new Product and ANSI
MSDS, or double-click the Product to preview the document (previewing the document does
not save it within MSDSpro).
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Company

The Company table stores all data for Manufacturers and Suppliers.  A company is entered only once.
The record is then referenced by the Product table, where many Products may exist that relate to only
one Company record.

A modification to the Company record is then immediately available to Products that are related to the
Company record.

Note:  In Versions prior to 4.1 this table was called Manufacturer.

Company Output Form
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Company Data Entry Form

The Company name is required to be entered before saving the record.

n Enter the electronic contact information for each Company to take advantage of
efficiencies, such as Fax number, E-mail address, and Internet URL locations.
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Locations

The Modify Locations window allows modification of existing Location records and association of
various hierarchies within each Location.  Sublocations may be several thousand levels deep within
each Location.

2. Select Locations.

3. Click the SELECT button.

The Modify Locations screen is displayed.

Adding a Location

1. Click the ADMIN button on the Floating Toolbar.

The Data Access tab of the Admin Control Panel is presented.
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Adding a Location (Cont’d)

4. Click on the Location to add a Location to.

If there is a plus sign to the left of any of the existing Locations, you can click on it and drill
down to the next level.  Click on <TOP> to add a top level Location.

5. Click the NEW button.

The Edit Location screen is presented.

6. Type the name of the new level in the LOCATION NAME field.

7. Click the SAVE button.

You are returned to the Modify Locations screen.

8. Click CLOSE to exit.

This information also displays when you are in the Inventory tab of a Product.
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1. Click on the ADMIN button of the Floating Toolbar.

The Data Access tab of the Admin Control Panel is presented.

Editing a Location

2. Select Locations.

3. Click the SELECT button.

The Modify Locations screen is displayed.
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4. Click on the Location to edit.

If there is a plus sign to the left of any of the existing Locations, you can click on it and drill
down to the next level. A Location can be moved from one level to another by clicking and
dragging it.

5. Click the EDIT button.

The Edit Location screen is presented.

6. Edit the Location name, the Location Bar Code, who to contact in an emergency,
how to store the material, Asset Information and Asset Name.

The Location Bar Code is for scanning and tracking stored material and relevant MSDS
information.

7. Click hide from Web if web users should not see this location and related
inventory.

8. Inventory review Date and Reviewed by are the last time inventory at this location
was reviewed.

9. Click the SAVE button.

1. Click on the ADMIN button of the Floating Toolbar.

The Data Access tab of the Admin Control Panel is presented.

2. Select Locations.

3. Click the SELECT button.

The Modify Locations screen is displayed.

Deleting a Location

Editing a Location (Cont’d)
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4. Click on the Location you want to delete.

If there is a plus sign to the left of any of the existing Locations, you can click on it and drill
down to the next level.

5. Click the DELETE button.

6. Confirm the delete action.

The Location and all related Inventory records are deleted.

7. Click the CLOSE button.

1 Click on the ADMIN button of the Floating Toolbar.

The Data Access tab of the Admin Control Panel is presented.

2. Select Locations.

3. Click the SELECT button.

The Modify Locations screen is displayed.

Moving Locations

Deleting a Location (Cont’d)
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4. Select the Location you want to move

If there is a plus sign to the left of a Location, you can click on it to drill down to the next
level.

5. Drag the Location to move it from one level to another

Moving Locations (Cont’d)
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Inventory

The Inventory section allows access to Inventory records, the records that identify which products are
stored at which locations.

Accessing Inventory Records

1. Click the ADMIN button on the Floating Toolbar.

The Data Access tab of the Admin Control Panel is presented.

To access Inventory information listed by Product Name, select Inventory by Product:

2. Select Inventory.

3. Click the SELECT button.

The Select Inventory View screen appears



Section 4:  Data Access

Administrator Guide 4 - 59

Inventory by Product Output Form

Choosing Inventory by Product will display the Inventory by Product Output form.  By double-clicking
on one of the listed Product records, the inventory locations for that given product are listed in the
Inventory by Product Data Entry form.
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The Inventory by Product Data Entry form displays one Product and all of its associated Inventory
records.

Inventory by Product Data Entry Form

n The Start Date field displays the date the Product was first stored at this Location.

n The Maximum Amount Daily field lists the maximum amount of the Product that has
ever been stored at a Location.

n Click the ADD button to add the Product to any Location.

n Click the DELETE button to delete the Product from the selected Location.

n Click the EDIT button or Double-click a Location to modify information on the selected
Location.

Clicking on the ADD or EDIT buttons loads the Inventory Data Entry form.
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The Physical Inventory tab:

The Physical Inventory tab is where all the information relating to storing the Product at this Location
is entered.

n Click the SELECT button to the right of the Product Name field, a list of all Product
records in the MSDSpro database will appear.

From this list, select the Product to be added as Inventory. If a Product does not appear in the
listing, the Product has not yet been created within MSDSpro.

n Click the SELECT button to the right of the Storage Name field and a list of all Storage
Locations will appear.

From this list, select the Location to which the Product is to be added as Inventory. If a
Location does not appear in the listing, the Location has not yet been created within MSDSpro.
Locations are covered on pp. 4-43 through 4-48.

Inventory Data Entry Form

The Inventory Data Entry form is where Products are added as Inventory to a Location. Additional
information related to Product Inventory and the SARA Title III (Tier 2) report is also added or modified
on this form. The Inventory Data Entry form contains three internal tabs; the Physical Inventory tab,
the SARA Inventory tab and the SARA Containers tab.

Click here to view a list
of all existing locations

Click here to view a list
of all existing products

Check here to flag the
product as Non-Periodic

Enter start and
end dates here

Enter additional
information

about Product
Inventory here
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Inventory Data Entry Form (Cont’d)

n Enter into the Start and End Date fields the dates that the Product started and stopped
being stored at that Location.

n Check the Non-Periodic checkbox if the Product should be included in the SARA Title
III (Tier 2) regardless of start and end dates.

n The Temperature field lists at what temperature the Product is stored.

The Temperature field is usually only used if the Product will be stored in a chilled or heated
state. For SARA reporting the containers have SARA codes related to temperature.

n Enter into the Inventory Person field the name of the individual responsible for tracking
the inventory of the product at this location.

n The Solid, Liquid or Gas checkboxes list the state(s) of the Product.

n The Disposal Method field details how the Product will be discarded.

n The Notes field is used to enter additional information relating to Product Inventory.
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Inventory Data Entry Form (cont’d)

The Sara Inventory tab:

The fields on the SARA Inventory tab are used in calculating Inventory quantities for the SARA Title
III (Tier 2) report.

n Selecting the Containers radio button will set MSDSpro to automatically calculate
the quantity of the Product stored at the selected Location.

n If the Manual Only radio button is selected, MSDSpro will not calculate Product
quantities.

Use this option if the Product quantities are to be entered manually into MSDSpro.

n The Days on Site field lists the total number of days a Product has been stored at a
Location.

n The Maximum Amount Daily field lists the maximum amount of the Product that has
been stored at the specified Location.

n The Average Amount Daily field lists the average amount of the Product that has
been stored as Inventory.

n The Inventory Type field gives information on how the Product is used.
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Inventory Data Entry Form (cont’d)

The Sara Inventory tab (cont’d):

n The SARA Report Usage Field controls whether MSDSpro should include this Product
when a SARA Title III (Tier 2) report.

By default MSDSpro will automatically will compare product quantities stored with minimum
amounts required for inclusion in the SARA Title III (Tier 2) report. If this Product is to be
included or excluded in the SARA Title III (Tier 2) report by default, select that option from this
field.

Click here to begin
entering information

on the type of
containers used to

store a Product

The Sara Containers tab:

The fields on the SARA Containers tab report information relating to the physical containers that are
used to store a Product as Inventory. Some of these fields are also used in calculating quantities for
SARA Title III (Tier 2) reporting. MSDSpro can track a Product stored in many different types of
containers at one Location. To begin entering information on the type of containers used to store a
Product, click on the ADD button.

n The Item Number field stores an internal company code assigned to a Product for the
purpose of tracking Inventory.
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n The Responsible Person field lists the name of the person responsible for tracking
product inventory in the selected container type.

n The Start and Expires Date fields list the dates in which this product began and
ceased being stored at this location in the selected container type.

n The Number of Containers field lists the quantity of containers that are used to store
the Product as Inventory.

For example, if a Product is stored at a Location in ten 55-gallon drums, the Number of
Containers field should contain the number ten.

n The Container Size field lists the size of each container.

Using the previous example, the Container Size field should contain the number fifty-five.

n The Container Unit field lists the units of weight or volume that the Inventory quantity
is measured in.

Using the previous example, the Container Unit field should contain the word gallons.

n The Days on Site field lists the number of days that the product is stored as Inventory.

n The Current Amount field lists the current amount of the Product stored at the specified
Location.

n The Maximum Amount field lists the maximum amount of the Product that has ever
been stored at the specified Location.

n The Average Amount field lists the average amount of the Product that has been
stored at the specified Location.

n The Container Type field lists the type of container used to store the Product.

n The Container Pressure field details whether the Product will be compressed, expanded
or stored at the ambient pressure.

n The Container Temperature field details whether the product will be heated, chilled
or stored at the ambient temperature.

Inventory Data Entry Form (cont’d)

The Sara Containers tab (cont’d):
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Inventory by Location

The Inventory section allows access to Inventory records (the records that link a Product to a Storage
Location).

To access Inventory information listed by Location Name, select Inventory by Location:

To modify or view an Inventory record by using the Inventory by Location window:

1. Select (highlight) the Location with associated Inventory to edit or view.

2. Click the INVENTORY button.

The Inventory by Location Data Entry form is displayed

Inventory by Location Display Form

Choosing Inventory by Location will display the Inventory by Location display form.
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The Inventory by Location Data Entry form displays one Storage Location and all of its associated
Inventory records.

n Click the ADD button to add a new Inventory record.

n Click the DELETE button to delete a highlighted Inventory record.

n Double-click an Inventory record to modify it.

n Inventroy review date and reviewed by are the last time inventory was revised at this
location.

Double-clicking an existing Product
Name displays the Inventory Data
Entry form for edit.

Inventory by Location Data Entry Form
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Chemical

The Chemical table records information about Chemicals. Chemical CAS numbers are not considered
unique. Two or more Chemical records may share the same CAS number if needed.

Chemical records contain information that is stored only once.  Many Products may use each Chemical
through the use of Ingredients (available within the Products Data Entry form Ingredient tab.)

Chemical Output Form
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Chemical Data Entry Form - Chemicals Tab

The Chemicals tab allows the CAS number to be entered for a Chemical Name, as well as EHS
(Extremely Hazardous Substance), EHS TPQ, TSCA, Carcinogen, TLV ACGIH, OSHA PEL, and
various SARA flags.  CAS Number data entry is checked to verify that the CAS Number is valid.

Chemical Data Entry Form - Regulatory Flags Tab

The Regulatory Flags tab displays the federal and state qualifications for this Chemical.
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Chemical Data Entry Form - Definable Fields Tab

The Products tab displays all Products which contain this Chemical as an Ingredient.

The Definable Fields tab displays all fields created by MSDSpro Administrator(s) for use in the
chemical record.

Chemical Data Entry Form - Products Tab
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Chemical Data Entry Form - Inventory Tab

The Inventory tab displays the locations where this Chemical is stored.
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Containers

The Containers section stores information about the different types of containers used to store products
as inventory.

Accessing Container Records

1. Click the ADMIN button on the Floating Toolbar.

The Data Access tab of the Admin Control Panel is presented.

2. Select Containers.

3. Click the SELECT button.

The Select Records screen appears.

3. Select whether to list all container records, search for container records or add new
records.
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Containers Output Form

Choosing List All Records from the Select Records screen will display the Containers Output form.
Double-clicking on one of the listed records loads the Containers Data Entry form. This form contains
the information regarding individual containers.

n Click on the NEW button to create a new container record.

n Click on the DELETE button to remove the highlighted container record.

n Double-click the highlighted container record to edit that record’s information.

n Click on the ALL button to view the entire list of container records.

n Click on the SEARCH button to search for container records matching a specific criteria.

n Click on the SORT button to sort container records by different criteria.

n Click on the CLOSE button to close the Containers Output form.
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Containers Data Entry Form

The Containers Data Entry form allows for the entry of container information relating to a specific
product being stored at a specific location.

Container information that can be entered into the Container Data Entry form includes:

n The Item Number field stores an optional internal company code assigned to a specific
container for the purpose of tracking Inventory.

n The Responsible Person field lists the name of the person responsible for the current
container.

n The Auto Generated checkbox indicates whether the container record was
automatically created by MSDSpro or created manually by a user.

n The Start Date field displays the date the Container was first stored at this Location.

n The Expires Date field displays the date the Container stopped or will stop being
stored at this Location.
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n The Days on Site field lists the total number of days the listed container has been
stored at the listed Location.

n The Last Updated field shows the date the information in a container record was last
updated.

n The Number of Containers field lists the quantity of containers that are used to store
the Product as Inventory at the listed Location.

For example, if a Product is stored at a Location in ten 55-gallon drums, the Number of
Containers field should contain the number ten.

n The Container Size field lists the size of each container .

Using the previous example, the Container Size field should contain the number fifty-five.

n The Container Unit field lists the units of weight or volume that the Inventory quantity
is measured in.

Using the previous example, the Container Unit field should contain the word gallons.

n The Container Type field lists the type of container used to store the Product at the
listed location.

n The Container Pressure field details whether the Product will be compressed, expanded
or stored at the ambient pressure.

n The Container Temperature field details whether the product will be heated, chilled
or stored at the ambient temperature.

n The Current Amount field lists the current Product quantity in pounds for this container
record.

n The Maximum Amount field lists the maximum Product quantity in pounds for this
container record.

n The Average Amount field lists the average Product quantity in pounds for this container
record.

Containers cont’d
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Chemical Authorization Requests

Selecting Chemical Authorization Requests from the Admin Control Panel prompts the user to list all
C.A.R. records, search for a specific C.A.R. record or add a new C.A.R. record. Selecting Search for
Records loads the Query Editor, covered on pp. 3-8 through 3-12. Selecting Add Records loads the
Chemical Authorization Entry Form, covered on pp. 4-77 through 4-83. Selecting List All records loads
the Chemical Authorization Output form. The Chemical Authorization Output form allows for seven
actions.

The Chemical Authorization Requests selection tracks and stores information about which employee
has requested and received or been denied authorization for the use of a specific chemical. Chemical
Authorization Requests are also referred to as C.A.R.s.
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The Chemical Authorization Entry Form consists of five tabs; Specific Information, Requestor
Information, Location Used, Usage Information, & Approvers. These five tabs contain all the
information pertinent to a single request made for authorization to use a chemical.

n Click on the NEW button to create a new request.

n Click on the DELETE button to remove the highlighted request.

n Double click on a specific record to modify it’s information.

n Click on the ALL button to view the entire list of requests.

n Click on the SEARCH button to search for requests matching a specific criteria.

n Click on the SORT button to sort the requests alphabetically.

n Click on the CLOSE button to close the Chemical Authorization Output form.

Chemical Authorization Requests (cont’d)
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Chemical Authorization Requests (cont’d)

Specific Information Tab: The Specific Information tab contains information about the chemical for
which authorization is being requested. The following fields are available for population under the
Specific Information tab.

The C.A.R. record will only be editable if the current user has logged in as a member of the Chemical
Manager Group. Users who have not logged in as a member of the Chemical Manager Group will only
be able to view the C.A.R.. Members of the Approvers group will be able to approve C.A.R.s.

n CAR Number:  A unique number designed to identify a specific Chemical Authorization
Request (CAR)  and keep it separate from other CARs.

n Status: Displays at what step in the chemical authorization process the request
currently resides.

n Department: Lists the name of the Department for which the chemical is to be
authorized.

n MSDS ID: The MSDS ID field is a unique number assigned to identify and differentiate
one Product record from other product records.

n Product Name: The name of the chemical for which Authorization is being requested.
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n Select Product button: Clicking on the SELECT PRODUCT button produces a list of all
product records.

Click on the desired product to link the request to a specific product.

n Create Product Record: Clicking on the CREATE PRODUCT RECORD button will create
a new product record.

Use this button if a product record does not currently exist for the chemical being authorized.

n Manufacturer: The name of the company that manufactures the chemical.

n Supplier: The name of the company from which the chemical was purchased.

n URL of MSDS: The Internet Address of the MSDS for the requested chemical.

n Revision Date: The date the chemicals MSDS was most recently revised.

n Submitted Date: The date the chemical authorization was submitted.

n Approved date: The date chemical authorization was approved.

n Initial/Final Comments: Comments made during the submission of the authorization
or upon approval of the authorization.

Initial comments are emailed to the selected approvers. Final comments are emailed to the
requestor.

Chemical Authorization Requests (cont’d)
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Chemical Authorization Requests (cont’d)

Requestor Information Tab: The Requestor Information tab provides additional information about
the employee requesting authorization to use a chemical. The following fields are available for population
under the Requestor Information tab.

n Employee Number: A unique number assigned to a employee to help differentiate,
identify and distinguish one employee from other employees.

n Employee Name: The name of the employee requesting the chemical authorization.

n Phone: The phone number of the employee requesting the chemical authorization.

n Department: The department in which the employee requesting the chemical
authorization works.

n Technical Contact: Contact information for someone who can answer technical
questions on the chemical or request.

n Contractor name: The name of the contractor for whom the employee works if
applicable.

n Check the Rush checkbox if this C.A.R. is especially urgent.

n Enter the reason why this request is especially urgent in the Rush Reason field.
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Chemical Authorization Requests (cont’d)

Location Used Tab: Fields under the Location Used tab provide additional information about the
location at which the chemical will be used. The following fields are available for population under the
Location Used tab.

n Building:  Lists the building in which the chemical will be used.

n CAR definable fields will also show up on this tab.
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Chemical Authorization Requests (cont’d)

Approvers Tab: The Approvers tab lists persons who must authorize the use of the chemical. The
order in which each employee must approve the chemical is listed along with the status of that
employee’s review of the authorization and their comments on it. Clicking on the ADD button allows
current employee records to be imported into the approvers list.

n Status: The status field shows at what step in the approval process the chemical
currently resides.

n Set Default Approvers List Check Box: Selecting the Set Default Approvers List check
box will set the list of approvers currently displayed as a default list.

The default approvers list will be automatically loaded into future new C.A.R.s.
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To add an employee as an approver (the employee must already have an MSDSpro employee record):

1. Click on the ADD button at the bottom of the Approvers tab.

Clicking on the ADD button loads the Select Approver Entry form.

2. Click on the SELECT APPROVER button to choose from all employee records.

Clicking on the SELECT APPROVER button loads the Select Employee Output form. To
review and approve a C.A.R. an employee record must be a part of either the Chemical
Manager or Approver group.

Chemical Authorization Requests (cont’d)

3. Highlight the Employee record to be added as an approver.

n Click on the NEW button to create a new Employee record.

n Click on the SEARCH button to search for a specific Employee record.

n Click on the VIEW button to view the information contained in the highlighted
Employee record.

n Click on the CANCEL button to close the Select Employee Output form.

4. Click on the OK button to add the highlighted Employee record to the Select Approver
Entry form.

5. Select the appropriate Status from the Status pull down menu.

6. Enter any additional comments in the Comments field and click on the SAVE button.
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Phrase Library

The Phrase Library is used to store commonly used phrases that describe characteristics of one or
more products.  Using the Phrase Library is the fastest and easiest way to add common information to
a product record or ANSI Document. A phrase library record may be associated with any product
record. When a phrase library record is modified, all product records or ANSI Documents using that
phrase will also be updated.

Phrase Library Output Form

Phrase Text Window

Delete the
selected phrase

Search for a
specific phrase

Edit the
selected phrase

Close the
Phrase Library

Phrase
Library
phrases

Select
a phrase
category

Click here to see in
which products the

highlighted phrase is used

List all
phrases

n Click on an individual phrase to view the phrase text in the Phrase Text Window.

n Open the Phrase Category pull down menu to select a specific phrase library
category. This will cause only phrases in that category to be listed.

n Click on the NEW button to begin adding a new phrase to the phrase library. See
pp. 4-57) on adding a new phrase to the phrase library.

n Click on the DELETE button to delete the highlighted phrase from the phrase
library.

n Use the Text Contains field to search all phrases for a specific string of text.

Create a new
phrase
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n Upon opening the Phrase Library Output form,  only active Phrase Library records are
shown.

To view all records (including inactive Phrase Library records), click on the ALL button.

n Click on the EDIT button to modify an existing phrase.

n Click on the SEARCH button to search the Phrase Library. See pp. 4-58 on searching
the phrase library.

n The USED BY button reveals which product records contain the selected phrase.

Phrase Library (cont’d)

Adding a new phrase to the Phrase Library:

New phrases can be added to the Phrase Library by clicking  on the NEW button in the lower left hand
corner of the Phrase Library Output form. Clicking on the NEW button brings up the Phrase Library:
Adding new record Data Entry form.

1. Select the category that describes the phrase most accurately. If desired, create a
new category by clicking on the NEW button, typing in the name of the new category
and clicking the OK button.

Click here to
create a new
category
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2. Fill in the Heading and Title fields so that the new phrase is accurately summarized.

The Heading field acts as a subcategory to the Category field and provides additional information
as to the subject of the phrase. The Title field gives a brief description as to what the
phrase will describe.

3. Enter today’s date in the Date Started field. If the phrase is to become inactive on a
set date, enter that date into the Date Ended field.

4. Select the language in which the new phrase will be written.

5. Click on the Phrase Text tab. Enter the new phrase into the Phrase Text field.

6. Click on the SAVE button to finish adding the new phrase to the Phrase Library.

Phrase Library (Cont’d)

Adding a new foreign language phrase to the Phrase Library:

MSDSpro has the ability to store phrases in French, German, and Spanish. These phrases can then
be added to any new or existing product record or used to author MSDSs in their respective languages.
To create a new phrase in a foreign language:

1. Click  on the NEW button on the Phrase Library Output form to add a new foreign
language phrase OR select the phrase and click on the EDIT button to add a foreign
language translation.

Clicking on the NEW or EDIT button brings up the Phrase Library Data Entry form.
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Adding Existing Phrases to the Product Record

To add an existing phrase to the Product Record:

1. From the Phrase Library Output form select the phrase to be added. The Product
Record must be at least partially visible behind the Phrase Library.

2. Holding down the left mouse button, move the mouse cursor over the Product Record.

3. Release the left mouse key.

The phrase will now appear in the Product Record. This procedure is known as drag and drop.

Searching the Phrase Library

To locate a specific phrase within the Phrase Library click on the SEARCH button along the bottom of
the Phrase Library Output form. To search all phrases for a specific string of text type the words into
the Text Contains field and hit the Enter key to start the search.

Clicking on the SEARCH button along the bottom of the Phrase Library Output form loads the Query
Editor. Use of the Query Editor is covered on pp 3-8 through 3-12.

Editing an existing Phrase

Existing phrases can be modified by clicking on the EDIT button along the bottom of the Phrase
Library Output form. The process for editing an existing phrase is the same as creating a new phrase.
Rather than entering new information however, modify the existing information as necessary.

Phrase Library (cont’d)

2. Click on the tab of the language in which the new phrase will be created.

3. Click on the O.K. button to translate the phrase into the language desired.

4. Enter the new translation into the Heading, Title and Phrase Text fields.

5. Select the category to which the new foreign language phrase belongs or create a
new category by clicking on the NEW button.

6. If the dates in which the phrase will be active are known, enter them in the Date
Started and Date Ended fields.

7. Click on the SAVE button in the lower right hand corner to save the new foreign
language phrase.
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Phrase Library (cont’d)

Adding Existing Phrases to an ANSI 16 Section Document

To add an existing phrase to an ANSI 16 Section Document:

1. Open the desired Product record.

2. Make sure ANSI Document is selected as the Document Type.

3. Click on the Document tab.

4. Select the tab under which the phrase(s) will be added. Phrases can be added to
sections 3-16.

5. Click on the PHRASE LIBRARY button in the lower left hand corner of the ANSI 16
Section Document.

6. The ANSI 16 Section Document must be at least partially visible behind the Phrase
Library.

7. Holding down the left mouse button, move the mouse cursor over the ANSI 16 Section
Document.

8. Release the left mouse key.

The phrase will now appear in the ANSI 16 Section Document. This procedure is known as
drag and drop.
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Asset

The Asset table is used to categorize any Location records.  By modifying a record in the Asset table,
changes will immediately take effect in the Location lookup values.

Asset records are helpful to categorize Location records (and subsequently, all Sublocations and
Inventory records that are associated with them), but Asset records are not mandatory to be assigned
to a Location record.

Asset Output Form
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Asset Data Entry Form

The Asset Data Entry form allows the entry of the Asset Name and Description fields.
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User

The User table is used to link Users (Individuals or Organizations) to a specific MSDS Product.

User records allow for streamlined updates for users of a specific MSDS Product.

User Output Form
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The Linked Products tab allows viewing, addition, or removal of specific MSDS Products for a User:

User Data Entry Form - Linked Products Tab

User Data Entry Form - User Information Tab

The User Information tab displays information that is entered only once for a specific User record.
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MSDS Request

MSDS Request Output Form

MSDS Requests are automatically provided from the web interfaces built into MSDSpro Enterprise
and MSDSpro PlusWeb, allowing any user of the system to request an MSDS, by and providing basic
information about the required document.

Upon opening the MSDS Requests Output form (as shown above), only unfulfilled MSDS Requests
are shown.  To view all records (including fulfilled MSDS Requests), click ALL.

Double-click an entry to view the MSDS Request detail information in the MSDS Request Data Entry
form and make any modifications to the record.
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MSDS Request Data Entry Form - MSDS Request Tab

MSDS Request Data Entry Form - Requestor Information Tab

The MSDS Request tab displays information about the MSDS request.

The Requestor Information tab displays information about the MSDS requestor.
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Waste Codes

Waste Codes are unique identifiers designed to identify a method by which a product should be
disposed.

Waste Code Output form

Selecting Waste Codes from the Admin Control Panel loads the Waste Code Output form. The
Waste Code Output form lists all active Waste Code records.
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Waste Code tab

n Waste Code: The Waste Code field holds the alphanumeric string that uniquely
identifies this Waste Code.

n State: The State field indicates whether the waste is a solid or a liquid.

n Active: The Active checkbox indicates whether or not this Waste Code is currently
used. If the Active checkbox is not checked the Waste Code will not show up on the
Waste Code Output form.

n Description: The Description field indicates the method of disposal to which this Waste
Code relates.

The Waste Code tab describes the method of disposal to which this Waste Code relates.
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Waste Codes Products tab

The Products tab displays which products are currently linked to this Waste Code.
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Human Resources

The Human Resources tab allows access to the following tables/data entry areas within MSDSpro:

n Departments

n Employees

n Groups

Admin Control Panel

Human Resources are accessed from the Admin Control Panel.
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Departments

The Departments selection, under the Human Resources tab, tracks and organizes information relating
to company departments. Selecting Departments from the Admin Control Panel prompts the user to
list all department records, search for a specific department record or add a new department record.
Selecting Search for Records loads the Query Editor, covered on pp. 3-8 through 3-12. Selecting Add
Records loads the Department Data Entry Form, covered on pp. 5-4. Selecting List All records loads
the Department Output form. The Department Output form allows for seven actions.

n Click on the NEW button to create a new department.

n Click on the DELETE button to remove the highlighted department.

n Click on the EDIT button to modify the information relating to the highlighted
department.

n Click on the ALL button to view the entire list of departments.

n Click on the SEARCH button to search for departments matching a specific criteria.

n Click on the SORT button to sort the departments alphabetically.

n Click on the CLOSE button to close the Modify Departments Output form.
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Moving Departments

The Modify Departments Output form allows the user to move departments within the hierarchy.
Users can:

n Make one department a subsidiary of another department.

n Change a subdepartment to a parent department.

n Move a subdepartment from one parent department to another.

To move a department from one Parent department to another:

1. Highlight the department to be moved.

2. Click the left mouse button and drag the department on top of the desired Parent
department.

To make a subdepartment a parent department, move the subdepartment on top of the word <Top>.
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Adding or Editing Departments

Clicking on the NEW or EDIT button on the Modify Departments Output form loads the Department
Data Entry form.

To Add or Edit a Department:

1. Enter or Edit the number representing the Department in the Department Number
field.

2. Enter or Edit the name of the Department in the Department Name field.

3. Select whether the primary contact will be the manager or the employee.

4. Click on the SELECT button to populate the Manager and Contact sections.

If the Manager is set as the primary contact, the contact section is not available for population.

5. Click on the SAVE button to save the newly created information.
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Employees

The Employees selection, under the Human Resources tab, tracks and organizes information relating
to employees. Selecting Employees from the Admin Control Panel prompts the user to list all employee
records, search for a specific employee record or add a new employee record. Selecting Search for
Records loads the Query Editor, covered on pp. 3-8 through 3-12. Selecting Add Records loads the
Employee Data Entry Form, covered on pp. 5-6. Selecting List All records loads the Employee Output
form. The Employee Output form allows for seven actions.

n Click on the NEW button to create a new employee record.

n Click on the DELETE button to remove the highlighted employee record.

n Double-click the highlighted employee record to edit that record’s information.

n Click on the ALL button to view the entire list of employees.

n Click on the SEARCH button to search for employees matching a specific criteria.

n Click on the SORT button to sort the employees alphabetically.

n Click on the CLOSE button to close the Employees Output form.
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Adding or Editing Employee records

Employee records can be added or modified in three different ways.

1. By clicking on the NEW button on the Employee Output form.

2. By double clicking on an existing employee record in the Employee Output form.

3. By selecting add records after selecting Employees from the Admin Control Panel.

To Add or Edit an Employee record:

1. Enter the employee’s name, email address & phone number in the appropriate fields.

2. Click on the SELECT button to choose the Department to which the employee will
belong.

3. Click on the SELECT button to choose the MSDSpro Account the employee will use to
log in to MSDSpro.

Clicking on the CLEAR button clears the contents of the Department or MSDSpro Account
fields.

4. Click on the ADD button to add the employee to a group.

Clicking on the ADD button will load the Select Group Output form. Highlight the desired
group and click on the OK button.

5. Click on the DELETE button to remove the employee from the highlighted group.

Once the information desired has been added, click on the SAVE button.
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Groups

The Groups selection, under the Human Resources tab, organizes and stores information detailing
employee group membership. A group as defined within MSDSpro is a discrete set of employees
whom share a common responsibility, privilege or other characteristic relating to the company.  Selecting
Groups from the Admin Control Panel prompts the user to list all group records, search for a specific
group record or add a new group record. Selecting Search for Records loads the Query Editor, covered
on pp. 3-8 through 3-12. Selecting Add Records loads the Group Data Entry Form, covered on pp. 5-
8. Selecting List All Records loads the Group Output form. The Group Output form allows for seven
actions.

n Click on the NEW button to create a new group record.

n Click on the DELETE button to remove the highlighted group record.

n Double-click the highlighted group record to edit that record’s information.

n Click on the ALL button to view the entire list of groups.

n Click on the SEARCH button to search for groups matching a specific criteria.

n Click on the SORT button to sort groups by different criteria.

n Click on the CLOSE button to close the Groups Output form.
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Adding or Editing Group records

Group records can be added or modified in three different ways.

1. By clicking on the NEW button on the Group Output form.

2. By double clicking on an existing employee record in the Group Output form.

3. By selecting add records after selecting Groups from the Admin Control Panel.

The addition or modification of Group records is performed on the Group Data Entry form.

To add a new group:

1. Enter into the Group Name field the name of the Group to be created.

2. Enter into the Description field a description of the new group including the roles,
responsibilities, privileges and authorities group members will have.

3. Some Groups are used by the system and cannot be changed. These Groups are
locked and the Locked checkbox will be checked.

4. Click on the SAVE button to save the new group.
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Special Functions consist of:

n Import/Export n Web Server Configuration

n Archives n Create Product Package

n Password Editor n Import Product Package

n Preferences n Edit Logs

n Dictionary n Edit User Lists

n Wizard Setup

Special Functions

Special Functions are accessed from the Admin Control Panel.

Admin Control Panel
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Import/Export

To Import data into or Export data out of any table in the database:

1. Select Import/Export from the Administration Control Panel.

A scrolling list of tables is presented in alphabetical order.

2. Select the table to import data into, or to export data out of.

3. Click OK.

All records will be listed for the table selected in the associated Output form.

4. Select Import Data or Export Data from the Selection menu (see Importing Data and
Exporting Data in Database Conventions and Operations).

Perform any necessary searches or sorts prior to starting an export.
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Archives

The database archive is available to browse Products, MSDS Document, and associated information
that has been archived at some point in the past.  Any Product may be archived.  The MSDS document,
Synonyms, Inventory, Ingredients, and other related information are also archived automatically.

The archival of MSDS data (not the simple deletion of unused MSDS records) is important to determine
the contents of the database at any time during the past.  This makes it simple to satisfy regulations
that require the availability of previous information, whether or not the data is currently active in the
database.

Another reason to archive unused data is to improve the performance of the database system.  The
data records are physically moved into an alternate set of data tables located internally in the data file,
which increases the performance of searches and sorts on the active data tables, and increases the
security of the data which has been archived.

The interface for the Archive is identical to the interface for the Product Output and Data Entry forms,
however it is not possible to modify any data or to import into the Archive tables.

Archiving Products

Activating Archived Products

To archive active Products:

1. Open the Products Output form.

2. Select Product records.

3. Choose Archive Selected Products from the Selection
menu.

4. Confirm the archive date and click OK to continue.

To activate archived Products:

1. Open the Archive Output form.

2. Select (highlight) Product records.

3. Choose Activate Selected Products from the Selection
menu.

The selected Products will be available once again in the active
Product Output form.
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Password Editor

User Profiles, Passwords, and System Policies are edited from the Password editor.

Users & Groups

Multiple User Roles are available, allowing persons accessing MSDSpro to be permitted or limited to
performing certain functions within the software.

The ability to add, modify, and delete data depends on the authorization granted to the specific user
name:

User Role Access Group Privilege

Database Database Owner Password Editor Only (DBO is optional)
Owner (DBO)

Database DB Admin View Records
Administrator (DBA) Add Records

Edit Records
Delete Records
Import/Export from all tables
Archives
Password Editor (If DBO not engaged)
System Preferences
All Update Options
Reports

EHS Edit View Records
Add Records
Edit Records
Delete Records
Import/Export from all tables
Archives
All Update Options
Reports

Supervisor Browse View Records
Basic Reports & Labels

Viewer/User & - Read-only MSDS viewing interface
Web User
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The User Profiles tab allows an MSDSpro Administrator to create new User Names and link them to
specific employees. The Administrator can also specify other characteristics of the User Names such
as the dates the User Name begins and ceases to be valid.

The default installation of MSDSpro contains specific User Names and Groups that contain those
User Names.  Each User belongs to one Group.  Each Group can have many Users.

Standard password modification features and profile settings are supported.

To create or modify a User Profile:

1. Select the User Name in the scrolling list from the User Name field OR click on the
NEW button.

2. Enter the User Name for a new profile or edit the existing User Name to modify an
existing profile.

3. Enter or Edit Assigned Group, Password, and associated Date fields.

4. Click on the SELECT button to choose an employee record to link to the User Name.

5. Click on the SAVE button to save changes or the CANCEL button to discard changes.

Modification of these settings apply immediately after choosing to SAVE the modifications.

Password Editor - User Profiles Tab

n Check the User Must Change Password at Next Logon checkbox to force the MSDSpro
Administrator to change the password associated with the User Profile the next time
they login.

n Check the Account Disabled checkbox to prevent a login using this User Profile.
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Password Editor - System Policies Tab

The System Policies tab allows global password behaviors to be implemented.

By selecting Database Owner Manages Security, a special User Name will be created called
“Database Owner”.  This will be the only User Name which will have access to the Password editor
after being created.  By default, the Database Owner password is “dbo” and must be changed the first
time the Database Owner successfully logs on.  Once created, only the Database Owner will have
privileges to access the Password editor.

To remove the Database Owner after being created, the Database Owner must successfully logon to
the system and deselect Database Owner Manages Security.

Modification of these settings apply immediately after choosing to SAVE the modifications.
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Password Editor - ODBC Connections Tab

The ODBC Connections tab allows specific privileges to be assigned to incoming ODBC connections
from other application systems.  ODBC is the Open DataBase Connectivity standard that allows
databases of various design and technology to share data.

ODBC is available with MSDSpro Enterprise Server.  Contact your MSDSpro representative for more
information on how to enable ODBC data access from your MSDSpro database system.

n Allow ODBC Select:  Allows an ODBC connection to view records.

n Allow ODBC Update:  Allows an ODBC connection to edit records.

n Allow ODBC Insert:  Allows an ODBC connection to add records.

n Allow ODBC Delete:  Allows an ODBC connection to delete records.

Modification of these settings apply immediately after choosing to SAVE the modifications.
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Preferences

n Company Information fields are used on various reports generated by the system.

n Contact Name and E-Mail address are used when sending an Manufacturer Update
Request E-Mail.

n Company Logo is the graphic image used on some reports that are generated by
MSDSpro.  Click CLEAR LOGO to clear the graphic image.

To load and use the Company Logo:

1. Click LOAD LOGO... to select an image file from hard disk.

NOTE: The Company Logo is also used by MSDSpro Enterprise and PlusWeb web browser interfaces
if the Web Server Control Panel does not specify an existing alternate graphic image.

Preferences - Company Information Tab

Preferences are available to the DBA system role to modify certain behaviors and selections.  Any
modification to preferences will immediately effect other MSDSpro users.
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Preferences - Business Information Tab

Business Information fields are used by various reports generated by MSDSpro.
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n MSDS Footer:  A single line of text that will be printed in the footer of each MSDS
document page (ANSI or Text MSDS documents only.)

n Update Document Folder:  The location of the folder on the local hard disk in which
the system expects to find the import disk files containing MSDS documents, used by
Update MSDS From Hard Disk, located in the Updates area.

n Compress Text MSDS:  Turns ON or OFF the internal compression of Text MSDS
documents.  Default is ON.

n Compress Image MSDS:  Turns ON or OFF the internal compression of Image MSDS
documents.  Default is ON.

n Create Web GIF Image: Turns ON or OFF the internal creation of GIF images for
display of Image MSDS documents for Web users.  Default is ON.

n Exclude CD:  Turns ON or OFF use of the MSDSpro CD. Default is OFF.

n CD Volume:  The letter of the drive containing the MSDSpro CD.

n Non-Library Search Default:  Turns ON or OFF library searches as search default.  Default
is OFF.

Preferences - MSDS Document Tab
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Preferences - Printing Tab

n ANSI Print Style:  Determines which printing template to use when printing ANSI
MSDS documents.  Default is 1.

n ANSI Fonts:  Determines which fonts to use on the 3 ANSI document template areas.

n Summary Fonts:  Determines which fonts to use on the 3 Summary template areas.
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Preferences - Configuration Tab

n Auto Logoff Time:  Specifies the length in minutes that the system will wait before
logging off an inactive user.  Default is 15.

n Max Search Results:  The default number of records to return when performing
searches.  Default is 1000.

n MSDS ID Prefix:  The alphanumeric beginning to each MSDS ID.

n Number of MSDS ID Places:  The number of places to use when automatically
numbering MSDS ID values for new Product records.

n Inventory Synchronization:  Specific fields for an integrated Inventory synchronization
routine.

n 4 Digit Year Entry:  Turns ON or OFF the forced 4 digit entry of years.  When OFF, a
pivot year is used (see next item, Pivot Year).  When ON, the user must enter all 4
digits of the year during date entry.  Default is OFF.

n Pivot Year:  Specifies which year to use as a pivot during date entry.  If the year
entered is equal to the pivot year or higher, the current century (1900) will be used.  If
the year entered is less than the pivot year, the next century will be used (2000).
Default is 50.

n Max Log File Days:  The number of days in which to keep log files of system activity.



Section 6:  Special Functions

Administrator Guide 6 - 13

n No Edit Log:  Turns ON or OFF the internal edit log system.  When turned OFF, MSDSpro
will create a log record for each modification to any record within the system.  When
turned ON, no edit log records will be created, and the EDIT LOG buttons are hidden
on all screens.  Default is OFF.

n Product Log: Create a log file tracking changes made to a product record

n Email Product Changes: Automatically generates an email to be sent to a specified
user  or users when changes are made to a product record.

n Dialog Options: Determines whether the Admin and Reports Control Panel remain
open until closed by the user. If unchecked the Control Panels close once a selection
has been made from them.

n Disable SARA Reports:  Disables the SARA Reporting functions within MSDSpro.

n SARA Hazardous Reports: Specifies product quantities in pounds above which a
product will be included in the SARA Report.

n RESET REGISTRATION: Reset the registration information originally entered for
MSDSpro. Contact MSDSpro for the reset password and your organization’s new
registration information if this is required.

Preferences - Configuration Tab (Cont’d)
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Preferences - Interface Tab

n Suppress Tool Tips:  Turns ON or OFF tool tips present on screens. Default is OFF.

n Suppress Spell Check:  Turns ON or OFF Spell Checking throughout data entry screens
within MSDSpro. Default is OFF.

n Use Logon Name For Entered by:  Display the User Name when a MSDS is entered.

n Disable Typeahead:  Turns off Typeahead functionality

n Execute Method:  Enter in commands for advanced programming.
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Preferences - Definable Fields Tab

MSDSpro provides for 13 customizable fields to be added to the Product table, and 12 to the Chemical
table, and 8 to the CAR table. These fields can be used to store any additional product or chemical
information the company that has purchased MSDSpro would like to have.

The Definable fields on the Product subtab consist of:

n (2) Boolean fields (Yes/No, True/False)

n (4) Number fields (Real number, with decimal precision to 15 places)

n (4) Alpha (Alphanumeric up to 80 characters)

n (2) Definable PPE (Yes/No, True/False)

n Definable Special (Yes/No, True/False) If defined products with this flagging will appear
with an * on searches from the web.

n Application Decimal Separator:  Determines the default decimal separator.  Default
is “.”

n Logon Message:  Allows a generic message to be displayed when a user successfully
logs into MSDSpro.  The user must click the OK button to continue after reading the
Logon Message.

n Before/After Login Screen:  Determines whether the Logon Message is displayed
before or after the user has successfully logged onto MSDSpro.  Default is AFTER.

Preferences - Interface Tab (Cont’d)
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n The definable fields listed on the Product subtab are physically located in the Product
table and appear on the Product Data Entry form Specific tab.

n The definable fields listed on the Chemical subtab are physically located in the
Chemical table and appear on the Chemical Data Entry form Definable Fields tab.

The Definable field names must be customized before the fields will appear on the associated Data
Entry form.  Simply type the name the field should appear with, and it will be reflected in the Data Entry
form, Query editor, Sort editor, and Quick Report editor.

Any of the Definable fields may be indexed.  This will make searches using the Definable field much
faster than a normal field.  Note: An indexed field can use considerably more space on the hard drive
when indexed.

Preferences - Definable Fields Tab (Cont’d)

The Definable fields on the Chemical subtab consist of:

n (10) Boolean fields (Yes/No, True/False)

n (2) Alpha (Alphanumeric up to 80 characters)

Click the mouse
cursor here and
start typing to
add a Chemical
Definable Field.
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Preferences - Definable Fields Tab (Cont’d)

The Definable fields on the CAR tab consist of:

n (4) Boolean fields (Yes/No, True/False)

n (4) Alpha (Alphanumeric up to 80 characters)
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Preferences - TCP/IP & E-Mail Tab

MSDSpro can automatically e-mail a notification when an MSDS Request is submitted by an MSDSpro
user.

MSDSpro e-mail functions through use of SMTP (Simple Mail Transfer Protocol), the Internet standard
e-mail protocol.  Virtually any e-mail server will allow SMTP e-mail to be sent and received.  After
entering the appropriate SMTP Server Address and SMTP Sender Address, click TEST E-MAIL to
allow MSDSpro to send a test e-mail and verify the connection.  If the test is successful, SMTP
Verified will be “Yes”.  If the test is not successful, SMTP Verified will remain as “No” and the e-mail
system is not activated.
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Preferences - TCP/IP & E-Mail Tab (Cont’d)

n SMTP Server Address:  The SMTP server name.  Example: domino.acme.com, or
192.168.0.1.

n SMTP Sender Address:  The SMTP address of the sender’s e-mail account.  Example:
msdspro@snowflowerinc.com.  This is the e-mail account the messages will originate
from.

n Send MSDS Request E-Mail:  Turns on the capability to send an e-mail notification
when an MSDS Request has been submitted (only after the SMTP settings have been
verified.)

n MSDS Request Notification E-Mail Addresses:  The e-mail address(es) to notify when
an MSDS Request is submitted (separate addresses by typing the Return key between
addresses.)

n TEST E-MAIL:  Used to test the SMTP settings, after SMTP Server Address and SMTP
Sender Address have been entered.  If the test is successful, SMTP Verified will be
“Yes”.  If the test is not successful, SMTP Verified will remain as “No” and the e-mail
system is not activated.

Optional settings can be configured if your organization requires the use of a Proxy Server to access
the Internet:

n Connect to Internet Using Proxy Server:  Is used when the company network requires
that a Proxy Server is used to connect to the Internet (for security purposes, as a
firewall).

n HTTP Proxy:  Is the address of the Proxy Server.

n Port:  The port which the Proxy Server will permit HTTP traffic on (usually 80).

n TCP Debug:  Selecting this option will turn on the debug mode for TCP/IP requests.
This option requires a password and should only be used to troubleshoot problems
that may be occurring with the TCP/IP Internet requests.  Contact MSDSpro Technical
Support for assistance.

If your organization uses a Proxy Server, MSDSpro must be configured to function with it in order to
use the Internet.  The following are two examples of how to acquire the settings used for the Proxy
Server configuration (both Netscape Navigator and Internet Explorer are used as examples.)
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Using Internet Explorer®:

1. Select Internet Options... from the Tools menu

2. Choose the Connections tab

3. Click LAN SETTINGS

4. Click ADVANCED

Preferences - TCP/IP & E-Mail Tab (Cont’d)

Using Netscape Navigator®:

1. Select Preferences... from the Edit menu.

2. Choose to expand Advanced.

3. Select Proxies.

4. Click VIEW.
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Preferences - Applications Tab

The Applications tab specifies the default location of additional “helper” applications which may be
used to open and/or print external documents.

Click on the BROWSE button to locate the application executable (.exe) file for each application type,
if required.

NOTE: It is important to locate and specify the PDF Viewer Path and HTML Viewer Path in order to print
PDF and HTML documents correctly.
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Dictionary

The Dictionary table is used to store commonly used words and definitions.  These definitions are
made available to the system users through the MSDS Document Define Word button.

The NFPA/HMIS Hazard Definitions are also stored in the Dictionary table, and can be edited at any
time.

Dictionary Output Form
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Dictionary Data Entry Form

The Dictionary table is used to store commonly used words and definitions.  These definitions are
made available to the system users through the MSDS Document Define Word button.

The NFPA/HMIS Hazard Definitions are also stored in the Dictionary table.

The NFPA records are stored with words starting with “N”.  The Type of Rating is “H”, “F”, or “R”.  For
example,  the definition for NFPA Health 2 is stored in the Dictionary record as word “NH2”, etc.

The HMIS records are stored with words starting with “H”.  The Type of Rating is “H”, “F”, or “R”.  For
example,  the definition for HMIS Health 2 is stored in the Dictionary record as word “HH2”, etc.
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Download from Bar Code Scanner

The Download from Bar Code Scanner function allows Inventory information that has been loaded into
a hand-held Bar Code scanner to be downloaded into MSDSpro Inventory.  The Inventory created is a
“snapshot” of the current Inventory.  MSDSpro assumes that the amount scanned is the total amount
of the Product that is currently stored at the specified Location.

To Download Inventory information from a Bar Code Scanner:

1. Select Download from Bar Code Scanner from the Admin Control Panel.

2. Click the Settings tab.

3. Check the settings.

n Product Identifier:  This field sets how MSDSpro will relate the Bar Code ID to the
Product in MSDSpro.  The choices are Bar Code ID, Stock Number, or MSDS ID.

n Location Identifier:  This field sets how MSDSpro will relate the Location
information to the specific Location in MSDSpro.  The choices are Bar Code ID or
Location ID.

n Assign Amount:  The quantity set on the Bar Code scanner can be assigned to
either the Average Amount Daily or the Maximum Amount Daily fields.

n Data Format:  This setting describes how the data will be transferred from the
scanner to MSDSpro.  Please contact your MSDSpro Sales Consultant for status
on other supported formats.
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Download from Bar Code Scanner (Cont’d)

n Defaults:  Restores the default download settings.

4. Click the Data tab.

5. Click the DOWNLOAD button to download the data.

6. Verify the downloaded data for accuracy and completeness.

Confirm that the correct Locations, Products and quantities have been downloaded.  Incorrect
items can be deleted by selecting the item and clicking the DELETE INVENTORY button.

7. Click the SAVE button to save the data.
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Web Server Configuration

The Web Server Configuration radio button allows an MSDSpro Administrator to access the MSDSpro
Web Server Control Panel. The MSDSpro Web Server Control Panel is described on pages 9-2 through
9-10.
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Using Product Packages to Import or Export Data

An MSDSpro Product Package is a disk file that contains one or more Product records and associated
MSDS Document (Images, Text, ANSI, PDF, HTML), Synonyms, Ingredients, Inventory, etc.

Product Packages are collections of MSDS Product information that are designed to be moved from
one MSDSpro installation to another.  This allows safe and secure transfer of MSDSpro data in a
convenient manner among organizations and work locations.

The Product Package can be password protected if required.  If a password is assigned when the
Product Package is exported, MSDSpro will import the Product Package only if the correct password
is given.  If an MSDS ID value is present in the imported Product Package that matches an existing
MSDS ID, you will be prompted.

An MSDSpro Product Package cannot be used by any other MSDS software system.  It is based on
an advanced internal format which is only utilized by MSDSpro and no other MSDS software.

When using the optional MSDSpro Scanning Services to supplement your organization’s MSDS data
entry, the MSDS data may be returned to you as Product Packages that are imported from CD-ROM.
Please contact your MSDSpro representative for more information about MSDS Scanning Services.

To Create a Product Package:

1. Select Create Product Package from under the Special Functions tab.

Selecting Create Product Package loads the Create Product Package Data Entry form.

n Click on the ALL button to list all the product records.

n Click on the SHOW SUBSET button to show only the highlighted records.

n Click on the SEARCH button to search for Product Records matching a specific criteria.
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To Import a Product Package:

1. Select Import Product Package from under the Special Functions tab.

2. Browse to and select the MSDSpro Product Package file to import.

Only a MSDSpro Product Package file can be imported using Import Product Package from
under the Special Functions tab.

3. MSDSpro will import the Product Package.

2. Click on the BROWSE button to name the Product Package and select the location to
which it will be saved.

3. Click on the Settings tab to select the information to be exported into the Product
Package.

Information available to be exported includes Manufacturer, Document, Ingredients, Inventory,
Phrases and User information.

Using Product Packages to Import or Export Data (Cont’d)

4. Select the desired option from the Update Type field.

5. If desired, click on the Advanced radio button to select additional options.

6. Click on the CREATE PACKAGE button to create the Product Package or the CANCEL
button to close the Create Product Package Data Entry form.



Section 6:  Special Functions

Administrator Guide 6 - 29

Edit Logs

The Edit Logs radio button allows an MSDSpro administrator to view the specific changes that were
made to a product record and when those changes were made. Each edit log record shows one
occurrence of changes being made to a product record. If a product record is edited multiple times
then multiple edit logs are created. Logging is disabled by default. Enabling logging is covered on page
6-12 and 6-13. Selecting Edit Logs from the Admin Control Panel prompts the user to list all records,
search for a specific record or add a new record. Selecting Search for Records loads the Query Editor,
covered on pp. 3-8 through 3-12. Selecting Add Records loads the Log Data Entry Form, covered on
pp. 6-24. Selecting List All records loads the Log Output form. The Log Output form allows for six
actions.

n Click on the DELETE button to remove the highlighted log record.

n Double-click on a highlighted record to view its contents.

n Click on the ALL button to view the entire list of log records.

n Click on the SEARCH button to search for log records matching a specific criteria.

n Click on the SORT button to sort the log records alphabetically.

n Click on the CLOSE button to close the Logs Output form.
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Edit Logs  (Cont’d)

Edit Logs Data Entry form

Double-clicking on an entry in the Edit Logs Output form loads the Edit Logs Data Entry form. The Edit
Logs Data Entry form shows a list of what changes were made to the product record at a single point
in time, the date and time that those changes were made and the login name that the administrator
who made the changes was using.

n The Edit Date field shows the date the changes listed in this edit log record occurred.

n The Edit Time field shows the time the changes listed in this edit log record occurred.

n The User field shows the MSDSpro log in used by the administrator who made the
changes.

n The Machine-Name field shows the name of the computer on the local network from
which the changes  listed in this edit log record were made.

n The Network ID field shows under what name the administrator whom made the
changes was logged into the company network.

n The Log field shows what was entered into the fields that were changed before the
changes were made and to what the data in the fields was changed.
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Edit User Lists

The Edit User Lists radio button allows an MSDSpro administrator to view the lists that currently exist
in MSDSpro and the specific description for each one. For example, the Container Material list shows
all the different materials from which a container used to store a product may be made. Should a new
type of container made of ceramic, Pyrex, or other material begin to be used, an MSDSpro Administrator
could add it to the Container Material list by selecting Edit User Lists from under the Special Functions
tab. Other users of MSDSpro could then select that Container Material from the appropriate pull down
menu. Selecting Edit User Lists from the Admin Control Panel loads the User List Editor Data Entry
form.

n Use the List pull down menu to select a specific list.

n The Locked checkbox indicates whether or not the list cannot be modified without
the correct password.

n Use the Item pull down menu to choose a specific item in the selected list.

n Click on the ADD button to add a new Item to the selected list.

n Click on the DELETE button to delete the chosen Item from the selected list.

n The Value field indicates a value corresponding to the chosen Item.

n The Detailed Text field gives additional information on the chosen Item.
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Updates consist of:

n Update MSDS from Hard Disk

n Update MSDS from Internet

n Launch Web Browser to MSDS Links

n Synchronize with Provider

n Update MSDSpro CD Index

n Down Load from Bar code Scanner

Updates

Admin Control Panel

Updates are accessed from the Admin Control Panel.



7 - 2 Administrator Guide

Section 7:  Updates

Update MSDS From Hard Disk

Updating the MSDS Document from Text (ASCII), Image (all supported image types), and PDF disk
files can be accomplished either singularly within the Product Data Entry form (click IMPORT from the
Document tab), or by a batch update process from the Updates area (recommended).

To load and update MSDS documents from individual files within a single folder on the local hard disk:

1. Place MSDS files to load into the update folder (the default location in Preferences).

File names should match the MSDS ID of the Product to be updated plus the file extension.
For example, a product record with an MSDS ID of “12345” will match a text file called 12345.txt
located in the update folder.  If Images are to be loaded, place them in a folder named with the
MSDS ID.  The image files within the folder will be loaded in alphabetical order ( 001, 002 or A,
B will become pages 1-2).

2. Select Update MSDS From Hard Disk from the Admin Control Panel Updates area.

File names found in the update folder are compared to Product MSDS ID values.  Verify that
the Products listed match the files that are present in the update folder.

3. Verify the import date (the current date is the default).

4. Verify the Archive Existing Document setting (archival is the default).

If Archive Existing Document is selected, MSDSpro will archive the existing document if a
replacement document is located and successfully loaded from the update folder.  If it is not
selected, it will only be overwritten by the replacement document if a replacement document
is successfully loaded from the update folder.  If no replacement is found, the existing document
will not be replaced or archived.

5. Verify the Document language.

Select the language in which the updated document is written. The language selection made
here will be reflected in the language column within the attached documents window. See pp.
4-18. for more detail.

6. Click UPDATE FROM HARD DISK.

A thermometer will appear showing the status of the update.  All files that are successfully
loaded are moved into a folder named “Processed”, within the update folder.
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Update MSDS From Internet

MSDS documents may be imported from the Internet into MSDSpro. MSDSpro remembers the location
on the Internet from which the MSDS was imported. MSDSpro can then return to that same location on
the Internet to check for an updated MSDS. An updated MSDS will be imported from the Internet only
if the size of the MSDS or its last modified date has changed.  By default, when an MSDS is updated,
the old MSDS is archived unless the user has turned off this feature.

The Update MSDS from Internet Output form displays all the MSDS documents imported from the
Internet, their last modified date and the URL from which they were imported. Buttons on the Update
MSDS from Internet Output form allow the user to print the list of MSDS documents to be updated,
remove MSDSs from the update list, or search the MSDSpro database.

Print the list of
MSDSs to be updated

Remove a product record from
the list of MSDSs to be updated

Click here to update
MSDSs from the Internet

Search the
MSDSpro database

Status
column
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Update MSDS From Internet (Cont’d)

To update MSDS documents from the Internet:

1. Click on the ADMIN button on the floating toolbar.

2. Click on the Updates tab.

3. Click Update MSDS from Internet and then click on the SELECT button.

The Update MSDS from Internet Output form appears displaying all the MSDS documents imported
from the Internet, their last modified date and the URL from which they were imported.

5. Click the UPDATE FROM INTERNET button to begin the update process .

6. Click OK in the Confirm dialog to continue the update process.

Prior to updating, the Status column displays the word “Verify”. After the update process has completed,
the Status column will display one of several other entries. They are:

n Not Modified - The MSDS has not been modified since the last time it was updated.

n Not Found - The MSDS no longer exists at the original URL.

n Pending - An updated MSDS has been imported into the system. Before the new
MSDS will replace the old one the user needs to click on the ACCEPT button under
the Updated Documents tab.

n Unavailable - The original URL is valid however the server hosting the MSDS on the
Internet is not responding.
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MSDSs for which updates have been found will be listed under the Updated Documents tab.

Update MSDS From Internet (Cont’d)

Discard the
selected update

Accept the
selected update

Launch the web browser
to the selected updateDiscard all

updates

Archive Before
Replacing Checkbox

Print the list of
records shown

n Before the new MSDS will be attached to the Product Record, the ACCEPT button
must be clicked.

n When an MSDS is updated, the old MSDS is archived by default. Unchecking the
Archive Before Replacing checkbox will prevent the old MSDS from being archived.

n To prevent any one of the listed product records from being updated, highlight the
record and click the DISCARD button.

n If no updates are desired, click the DISCARD ALL button.

n To view the URL from which the update has been imported, highlight the product
record and click the LAUNCH button.

n Once all the MSDSs desired have been updated, click the CLOSE button to complete
the process.
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Launch Web Browser to MSDS Links

Selecting Launch Web Browser to MSDS Links from the Admin Control Panel will launch the default
web browser to a comprehensive Internet resource (www.MSDSprovider.net) which provides free links
to Manufacturer MSDS information.

To Launch your Web Browser to MSDS Links:

1. Select Launch Web Browser to MSDS Links from Admin Control Panel Updates area.

Note:  Indepth information pertaining to PROVIDER can be found in at section 9-30.
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Update MSDSpro CD Index

Updating the MSDSpro CD Index occurs automatically when inserting the new MSDSpro CD for the
first time.  However, it may be required to manually initiate the process after database rebuild.  To
manually initiate the update, select Update MSDSpro CD Index in the Admin Control Panel.  A window
will be presented to select options for the update.

Warning: The Update MSDSpro CD Index process can take a significant amount of time, and cannot
be interrupted.

Update MSDSpro CD Index

To update the MSDSpro CD Index:

1. Select Update MSDSpro CD Index from the Admin Control Panel Updates area.

2. If all update files are correctly found, the NEXT >> button will be available.

If all update files are not correctly found, the NEXT >> button will not be available.  The screen
will show which files were not found correctly.  They are normally installed by the MSDSpro
Updater in a folder called “Updates\Index” within the MSDSpro Program folder.

3. Click the NEXT >> button.

The process of updating the internal data with the latest information contained on the current
CD will begin, and a progress thermometer will be shown.  Allow it to complete.
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Reports

Reports Control Panel

The Reports Control Panel allows Admin users to use various reports from the data in MSDSpro.

The Reports Control Panel is divided into four sections: Product and Inventory, Chemical, Regulatory,
and Ad Hoc.

n Product and Inventory reports include standard reports that Admin Users may regularly
access.

n Chemical reports include standard reports that show what Chemicals are in use at
specific Locations.
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n Ad Hoc reports provides access to produce reports and container labeling for custom
needs.

Reports Control Panel (Cont’d)

n Regulatory reports include standard reports that Admin Users may access to produce
reports for Regulatory Agencies, such as SARA reports for the local and state
emergency planning authorities.
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MSDS/Hazards by Location

MSDS/Hazards by Location is available from the Reports Control Panel.  This allows for the batch
printing of multiple MSDS documents or associated Hazard Summaries, by any Location entered in
MSDSpro, with or without an index sheet.  This feature is commonly used to print entire MSDS binders
with index sheets.  Only MSDS documents which are available will be included in this report.

To print MSDS/Hazards by Location:

1. Choose MSDS/Hazards by Location from the Reports Control Panel, and click SELECT.

The Storage Locations scrolling area will list all Locations within the MSDSpro database.

2. Select the Location to search.

The Product records associated with the Location are found and the number found is shown.

3. Select items to print (Index, Synonyms, MSDS, and Hazard Summary).

Any combination of items may be printed at one time.  If Synonyms is selected, an alternate
index will be printed that contains all the Synonyms associated with each Product, in addition
to the normal index listing the Product name.

4. If desired, check the Inventory current as of date to indicate that only those records
active specific to a certain date should be printed.
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MSDS/Hazards by Location (Cont’d)

4. Click the Linked MSDS tab to preview the MSDS documents that were found for the
selected Location(s).

Click PRINT to print the Index, Synonyms, MSDS documents, or Hazard Summaries, as
determined on the Select Location tab.
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Inventory by Location

Inventory by Location is available from the Reports Control Panel.  This allows printing of all Inventory
and Chemical records for Products at specific Storage Locations.

To create an Inventory by Location report:

1. Choose Inventory by Location from the Reports Control Panel, and click SELECT.

The Storage Locations scrolling area will list all Locations within the MSDSpro database.

2. Select the Location to search.

The Product records associated with the Location are found and the number found is shown.

3. Select items to print (Products and/or Chemicals).

Either Products or Chemicals may be printed at one time.
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Inventory by Location (Cont’d)

4. Click the Inventory tab to preview the Inventory records that were found for the selected
Location(s).

5. Click the Chemicals tab to preview the associated Chemical records that were found
at the selected Location(s).

Click PRINT to print the Inventory records.
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Product Summary

Product Summaries are summarized versions of the Product information for a particular MSDS. The
Product Summary will include information about the Product, Manufacturer, NFPA or HMIS hazard
rating, hazardous ingredients, and associated Phrases.

To create Product Summaries for a selection of Products:

1. Choose Product Summary from the Reports Control Panel, and click SELECT.

2. Choose Use All Records, or to Execute Query to Find Records, and click SELECT.

For detailed information describing how to use the Query editor, see The Query Editor in
Database Conventions.

After finding Product records, the Product Summaries will be printed.
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Periodic New Products

MSDSpro allows the DBA to find Products which have been added during a specific time period.  For
instance, it may be necessary to know which Product records have been added during the first 3
months of the current year for Emergency Response planning.

To create a Periodic New Products report:

1. Choose Periodic New Products from the Reports Control Panel, and click SELECT.

2. Enter the Period Begin date and the Period End date.

3. Choose to Print MSDS Documents if it is necessary to also have all documents in
addition to the listing of the Product Names, Manufacturer Names, and Revision Dates.

4. Click OK to print.



Section 8:  Reports

Administrator Guide 8 - 9

Container by Location

Container by Location is available from the Reports Control Panel. This report creates a list of all
Containers and their associated Products stored at a Location.

To create a Container by Location report:

1. Choose Container by Location from the Reports Control Panel, and click on the SELECT
button.

The Storage Locations scrolling area will list all Locations within the MSDSpro database.

2. Select the Location to search.

n Choose All Locations to run the report on all locations.

n Choose This Location to run the report on only the highlighted location.

n Choose All Sub Locations to run the report at the highlighted location and all its child
(sub) locations.

The Container records associated with the selected Location(s) and the number found is
shown.

3. Check the Inventory current as of: checkbox to print only container records present on
a specific date.

Leaving Inventory current as of checkbox blank will print all container records regardless of
the start and end dates.
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Container by Location  (Cont’d)

4. Click the Containers tab to preview the Container records that were found for the
selected Location(s).

5. Click on the PRINT button to print the Inventory records.
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Inventory Past End Date

To determine which product records have passed their end date at a specific Location, choose Inventory
Past End Date from the Reports Control Panel.

To create an Inventory Past End Date Report:

1. Choose Inventory Past End Date from the Reports Control Panel, and click SELECT.

2. Either select the Number of Months, or enter the Start Date.

Product records that have a revision date earlier than the start date entered or the number of
months entered will be included in the report
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3. Click the Found Inventory to review the search results.

4. Click on the PRINT button to print the report.

Inventory Past End Date (Cont’d)
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Manufacturer Request

MSDSpro allows an administrator to send an e-mail or printed request for updated MSDSs to one or
more manufacturers simultaneously. This function is known as a Manufacturer Request and it simplifies
the process of obtaining new MSDS documents from product manufacturers.

To create a Manufacturer Request:

1. Choose Manufacturer Request from the Reports Control Panel, and click on the SELECT
button.

2. The Manufacturer Update Request Entry form loads.

n If desired, enter a date into the Limit by Revision Date field.

Only MSDSs containing a Revision Date older than the entry into this field will be requested
from the manufacturer.

n Check the Include products with updated documents checkbox if product records
that have already been updated using the Update MSDS from Internet function are to
be included in this request.

n The Date field shows the current date.

3. Click on the SELECT button to select to which manufacturers a request is to be sent.

Clicking on the SELECT button loads the Select Company form.
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Manufacturer Request (Cont’d)

4. Click on the name of each manufacturer to be included in the Manufacturer Request.

n Click on the NEW button to create a new manufacturer record.

n Click on the SEARCH button to search for manufacturers meeting a specific criteria.

n Click on the SELECT ALL button to select all manufacturers.

n Click on the CLEAR ALL button to deselect all currently selected manufacturers.

n Click on the VIEW button to view the highlighted manufacturer record.

n Click on the CANCEL button to close the Select Company form.

5. Click on the OK button to continue creating the Manufacturer Request.

Drag the mouse cursor over multiple manufacturers to select all of them.
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Manufacturer Request (Cont’d)

6. Click on the Linked Products tab to view the products to be requested from the
manufacturer(s).

7. Click on the REMOVE button to remove any highlighted products not to be included in
the request(s).

8. Click on the E-MAIL or PRINT button to either e-mail the request(s) to the Manufacturer(s)
or print out the request(s) for regular mailing.

9. Once the request has been either e-mailed or printed, click on the CLOSE button to
close the Manufacturer Update Request Entry form.
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Manufacturer Request (Cont’d)

Tracking Requests to manufacturers

MSDSpro also has the ability to track those MSDS’s that have previously been requested.  This provides providing
an
electronic record for your compliance.

To view reports, click the
Request button.

This will open the SELECT
RECORDS dialog.

Choose the product you wish
to review.
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Manufacturer Request (Cont’d)

Tracking Requests to manufacturers (Cont’d)

n     Notes can be added to track specific details pertaining to each MSDS.

n     When the MSDS arrives from the Manufacture check the MSDS_Received
    button.
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E-mailing a Manufacturer Request

Clicking on the EMAIL button on the Manufacturer Update Request Entry form loads the Send E-Mail
Message Entry form.

To email a manufacturer request:

1. Enter into the Recipient E-mail field the email addresses of the manufacturers to
which this request is to be sent.

2. Enter into the Your E-Mail and Your Name fields the contact information of the MSDSpro
administrator.

3. Modify the Subject and Message fields as desired.

4. Check the Send copy to my E-Mail address checkbox to send a copy of the request to
the MSDSpro administrator listed in the form.

5. Click on the SEND button to send the request or the CLOSE button to close the Send
E-Mail Message Entry form.
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MSDS Aging Report

To determine which MSDS documents are older than a certain number of months, or have revision
dates before a certain date, choose MSDS Aging Report from the Reports Control Panel.

To create an MSDS Aging Report:

1. Choose MSDS Aging Report from the Reports Control Panel, and click SELECT.

2. Either select the Number of Months, or enter the Start Date.

Product records that have a revision date earlier than the start date entered or the number of
months entered will be included in the report

3. Check the Limit by Review Date checkbox to further limit search results by the Review
Date field in the Product Record.

Use this checkbox if only MSDSs that have not been reviewed in a certain amount of time are
to be included in the MSDS Aging report.
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4. Click the Found MSDS Documents tab to review the documents found.

5. Click on the PRINT button to print the report.

MSDS Aging Report (Cont’d)

3. Click the Select Location tab to choose the location, or locations to query.
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Products without MSDS

MSDSpro allows Product records to be added to the system at any time, without requiring that an
MSDS document be added.  This facilitates the addition of MSDS and related data at any time, and
increases convenience for the users.

Occasionally it is necessary to determine which Product records have no associated Document records.
The Products without MSDS report is available from the Reports Control Panel.  It will search the
database for Product Records that have no associated MSDS Document record and create a report
containing the records found.

To create a Products without MSDS Report:

1. Choose Products without MSDS from the Reports Control Panel, and click on the SELECT
button.

If any Product records are found that do not have corresponding MSDS Document records,
the report will be sent to the selected printer.
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Products without Location

MSDSpro allows product records to be added to the MSDSpro database at any time, without
requiring that the product record be added to an inventory location. MSDSpro has the ability to
generate a report detailing which product records have not been added to an inventory location.
The Products without Location report is available from the Reports Control Panel. It will search
the database for product records that have not been added to an inventory location and create a
report containing a list of the records found.

To create a Products without Location Report:

1. Choose Products without Location from the Reports Control Panel, and click on the
SELECT button.

If any Product records are found that have not been added to an inventory location, the
report will be sent to the selected printer.
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MSDS Binder

The MSDS Binder report allows for the creation of a single PDF document containing all the PDF, Text,
and ANSI Text MSDSs for products used at either a single location or at all the sublocations of a single
location. MSDSs in Image or HTML format will not be included in the document. However, HTML
documents can be converted to PDF and stored in addition to the HTML version for binder printing. To
access the MSDS Binder report, click on the MSDS Binder radio button under the Products and
Inventory tab on the Reports Control Panel.

To create an MSDS Binder report:

1. Choose MSDS Binder from the Reports Control Panel and click on the SELECT button.

2. Highlight the location for which the MSDS Binder will be created.

3. Select either This Location or All Sublocations.

Choosing This Location will create a binder of the MSDSs at the highlighted location. Choosing
All Sublocations will create a binder of the MSDSs at all sublocations of the highlighted
location. MSDSs at the highlighted location will be included.

4. Check the Print Table of Contents checkbox to include a table of contents.

5. Click on the NEXT button.



8 - 24 Administrator Guide

Section 8:  Reports

MSDS Binder (Cont’d)

6. Review any warnings displayed in the Status column.

Product records that have MSDSs in HTML or Image format will have warnings listed in the
Status column. Decide whether to convert those MSDSs to PDFs or leave them out of the
MSDS binder. These documents will be included in the index so they can be easily printed
and inserted later.

7. Click on the NEXT button.
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MSDS Binder (Cont’d)

8. Edit the Location Name, Current Date or Table of Contents title if desired.

9. Add additional text in these fields if desired.

Location Name

Current Date

Table of Contents

10. Uncheck the MSDS ID, Document Number, Manufacturer or Revision Date fields if any
of these fields are not to be included in the binder.

11. Click on the NEXT button.
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MSDS Binder (Cont’d)

12. Click on the BROWSE button to select the location to which the binder will be saved.

13. Enter the desired name for the new binder in the File Name field.

14. Click on the SAVE button.
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MSDS Binder (Cont’d)

15. Click on the CREATE BINDER button

MSDSpro will now create the new binder in the directory specified.

16. Click on the NEXT button to begin creating another binder or click on the CANCEL
button to exit the MSDS Binder report.
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Chemical Location

The Chemical Location report is available from the Reports Control Panel.  This allows printing of all
Chemical listings which are stored at specific Storage Locations, sorted by the Product it comprises.

To create a Chemical Location report:

1. Choose Chemical Location from the Reports Control Panel, and click on the SELECT
button.

The Chemical Ingredient scrolling area will display all Chemicals within the database. The first
Chemical is selected by default.

2. Select the Chemical(s) to report.

The number of Locations in which the Chemical is stored will be displayed under the list of
Chemicals.  If a plus sign (+) is shown to the left of a Chemical, clicking it will show the
Product names that use the Chemical as an Ingredient.

3. Choose whether to Print Chemicals with or without Locations by clicking the
checkboxes.
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Chemical Location (Cont’d)

4. Click the Locations tab to preview the Products and Locations which contain the selected
Chemical(s).

The number of Locations in which the Chemical is stored will be displayed under the list of Chemicals.

5. Click PRINT to print the report.
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Chemical Hazards

The Chemical Hazards report allows interactive searching of Chemicals by their associated hazards
(as entered with Federal and State regulatory flags.)  After a specific Chemical is found by the
associated hazards, the Chemical Location report may be used to locate the actual Location of the
Products which contain the Chemical.

To create a Chemical Hazards report:

1. Choose Chemical Hazards from the Reports Control Panel, and click on the SELECT
button.

The Chemical Hazards Report window appears.

2. Select the Hazards required from the Hazards tab and State Lists tab.

3. Select  Search Match, requiring that Any selected Hazards are sufficient, or if All of
the Hazards will be required for each Chemical during this search.

4. Select Inventory, to Require Inventory records to exist, or if Inventory records are Not
Required to exist for each Chemical during this search.

5. Click on the SEARCH button.
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SARA Title III (Tier 2)

MSDSpro generates the annual SARA Title III (Tier 2) report based on Product (or Chemical) quantities
stored at a location.  Product quantities can be either manually entered into MSDSpro or calculated
automatically. Manually entering product quantities into MSDSpro is covered on pp. 4-54. In order for
MSDSpro to accurately calculate the SARA Title III (Tier 2) report, six fields must be filled out. The
first four fields are found on the Inventory Data Entry form. The Inventory Data Entry form is covered on
pp. 4-51 through 4-56.

n Inventory Start Date: The Inventory Start Date field lists the date that the Product was
first stored at a Location.

MSDSpro automatically enters the current date into this field when a Product is first added as
Inventory to a Location. If a different Inventory Start Date is desired, any MSDSpro administrator
can edit this field at any time.

Inventory Start Date
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n Number of Containers: The Number of Containers field lists the quantity of containers
that are used to store the Product.

For example, if a Product is stored at a location in ten 55-gallon drums, the Number of
Containers field should contain the number ten.

n Container Size: The Container Size field lists the size of each container.

Using the previous example, the Container Size field should contain the number fifty-five.

n Container Unit: The Container Unit field lists the units of weight or volume that the
inventory quantity is measured in.

Using the previous example, the Container Unit field should contain the word gallons.

SARA Title III (Tier 2) (Cont’d)
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n Specific Gravity or Density: The Specific Gravity and Density fields are used by MSDSpro
to convert inventory quantities from a volume measurement such as gallons to a
weight measurement such as pounds.

Only one of the two fields needs to be filled in for MSDSpro to calculate quantities for the
SARA Tier 2 report. If both fields contain information, MSDSpro will use the Specific Gravity
field. Information is entered into the Specific Gravity and Density fields on the Characteristics
tab under the Product tab within the Product record.

SARA Title III (Tier 2) (Cont’d)

Specific Gravity &
Density fields
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n Maximum Weight Percent: If a Chemical is listed as an Ingredient in a Product,
MSDSpro uses the information in the Maximum Weight Percent field to calculate the
total amount of the Chemical in that Product.

MSDSpro does this for every Product that contains the Chemical as an Ingredient and then
sums the total amount of the Chemical in each Product to arrive at a total stored as Inventory.
The Maximum Weight Percent field is located on the Ingredient Data Entry form. This form is
covered on pp. 4-51 through 4-56.

SARA Title III (Tier 2) (Cont’d)
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To create a SARA Title III (Tier 2) report:

1. Choose SARA Title III (Tier 2) from the Reports Control Panel, and click on the SELECT
button.

2. Select the Location upon which to run the report.

3. Click the SELECT button.

Clicking on the SELECT button loads the SARA Tier 2 Facility to Report Data Entry form.
Information entered in this form appears in the SARA Title III (Tier 2) report and can be saved
by clicking on the SAVE button. If contact information has not yet been created for this
Location, MSDSpro will prompt you to create it at this time.

4. Verify Facility and Owner Information is accurate.

SARA Title III (Tier 2) (Cont’d)
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6. Fill in the Name and Title information.

5. Verify Emergency Contact Information.

SARA Title III (Tier 2) (Cont’d)

Check the appropriate checkbox if a site plan, site coordinate abbreviations or a description of other
safeguard measures will be submitted with the SARA Title III (Tier 2) report. MSDSpro does not have
the capability of creating these attachments but will indicate in the SARA Title III (Tier 2) report
whether or not any of these optional attachments are being submitted with the report.
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7. Select the Date Range, Days Onsite, and Reporting Quantities for the report.

n The Date Range field determines the period over which quantities will be calculated.

This is most often the previous calendar year. Inventory that is present at any time during the
date range will be calculated.

n The Days on Site field lists the default number of days a Product has been stored at a
Location.

n If Inventory quantities meet or exceed the amount entered in the Reporting Quantities
field, the Product or Chemical will be included in the SARA Title III (Tier 2) report.

8. Select whether to generate the Chemical Inclusion report and/or include non periodic
products.

n Selecting the Include Non Periodic checkbox will add to the SARA Title III (Tier 2)
report all those Products that have been selected as non-periodic.

A Product is selected as non-periodic only if it is not permanently stored at a Location. A
Product is flagged as non- periodic in the Inventory Data Entry form.

n Selecting the Use Chemical Specific TPQ if Present checkbox tells MSDSpro to use a
threshold planning quantity specific to a Chemical if one has been entered.

A TPQ for a Chemical is entered in the Chemical Data Entry form.

Include Non Periodic
checkbox

Chemical Inclusion
Report checkbox

SARA Title III (Tier 2) (Cont’d)
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n Selecting the Chemical Inclusion Report checkbox prints out this additional report.

The Chemical Inclusion report provides a list of every Chemical in the SARA Title III (Tier 2)
report and shows which Products contain each Chemical as an Ingredient.

8. Select whether the report to be generated should be the Federal, Texas or Louisiana
SARA Title III (Tier 2) report or the PA ACT 165 report.

9. Click PRINT to print the report(s) selected.

Once the SARA Tier II report is finished, you may print an index of the report called the
Federal Tier II Report Summary.  This summary may be sorted by CAS#, Chemical Name or
Page Number.

SARA Title III (Tier 2) (Cont’d)

n Click on a column header to sort the summary by that column.

Column Header

Federal Tier II Report Summary:
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SARA Inventory Checklist

MSDSpro generates the annual SARA Title III (Tier 2) report based on Inventory and quantities.  The
SARA Inventory Checklist may also be saved to the hard drive for external data collection use.

To export a SARA Inventory Checklist:

1. Choose SARA Inventory Checklist from the Reports Control Panel, and click SELECT.

2. Select the Location to report.

The Inventory records associated with the Location are found and the number found is shown.

3. Click the EXPORT button.

4. Type a filename for the new file in the Save File window.

5. Click the SAVE button to export the data to the new file.
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Labels

Container Labels are available from the Reports Control Panel.

To create Labels:

1. Select Labels from the Reports Control Panel, and click on the SELECT button.

2. Select Use All Records or Execute Query to Find Records, and click on the SELECT
button.

Usually, executing a query to find records is the best method to print Labels.  For detailed
information describing how to use the Query editor see The Query Editor in Database
Conventions.

3. Select the Label Stock from the pull down and press OK.
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Custom Reports (Ad-Hoc Quick Reports)

Custom Reports (Ad-Hoc Quick reports) are available from the Reports Control Panel.

To create a Custom Report:

1. Select Custom Reports from the Reports Control Panel, and click on the SELECT button.

2. In the list of table names, select the default table to report from.

3. Enter a search criteria using the Query editor.

For detailed information describing how to use the Query editor, see The Query Editor in
Database Conventions.

4. Create the Quick Report using the graphical Quick Report editor.

For detailed information describing how to use the Quick Report editor, see Quick Reports in
Database Conventions.
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Understanding MSDSpro Web Server

MSDSpro Web Server  was created to be a simple, reliable method to deliver high quality standardized
MSDS documents to employees over a company network, or intranet, with zero administration.

The problem associated with traditional web servers and intranet systems is the high cost of mainte-
nance.  Imagine the amount of effort needed to compile and publish hundreds or thousands of MSDS
documents for searching and viewing through a web browser on your company intranet.  A great deal
of time and effort is therefore saved by relying upon a dynamic database system to deliver this informa-
tion in an effective manner.

MSDSpro Web Server is the most simple and effective database delivery of standardized MSDS
documents available.  The web browsers can be Netscape Navigator® or Internet Explorer® for Win-
dows® Macintosh®, Power Macintosh®, or UNIX.

When MSDSpro Enterprise or MSDSpro PlusWeb is launched, the internal web server is started (no
additional web server application or service is used).  It uses a variable number of internal “web pro-
cesses” which “listen” on the specified TCP Port Number for incoming Web User requests.  Each Web
User request is handled individually and concurrently, producing a high-performance multiprocessing
web server that is adaptable to all environmental conditions.  Web Server configuration and tuning is
allowed by optimizing settings in the Web Server Control Panel.

To access MSDSpro Web Server from a web browser, simply type the TCP/IP address (or if config-
ured, the DNS name of the computer) in the “Location” or “Address” field of the web browser. For
example, entering “192.168.0.3” will access the MSDSpro Web Server which is located at the IP
Address of 192.168.0.3. No special addresses or filenames are needed.

MSDSpro Web Server Requirements

MSDSpro Web Server requires that TCP/IP (“IP”) be correctly installed on the computer used as the
web server.  The IP address must be a static IP address.

MSDSpro Web Technology

NOTE: If another web server application or service is currently running on the same machine, a TCP port
number conflict may arise.  Simply change the port number of either MSDSpro Web Server or the
other web server application or service from the default value of 80 to another number, such as 81.  To
refer to this alternate IP address from any web browser, simply type the original IP address, such as
192.168.0.3, with an additional “:” and the new port number, such as 81.  In this case, the web browser
Location/URL would read “192.168.0.3:81”.
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Launching MSDSpro Web Server

To Launch MSDSpro Enterprise Web Server:

1. Launch MSDSpro 4D Server. (See pg. 1-4)

To Launch MSDSpro PlusWeb Web Server:

1. Launch MSDSpro PlusWeb. (See pg. 1-16)

2. Logon as any user.

Configuring Web Server Settings

MSDSpro Web Server settings can be configured at any time by opening the MSDSpro Web Server
Control Panel, allowing review and modification of the internal web server configuration.  Open the Web
Server Control Panel by selecting it from the Windows pull-down menu (MSDSpro PlusWeb), or by
clicking on the MODIFY WEB SETTINGS button within the server application window (MSDSpro
Enterprise), or by selecting Web Settings from Admin - Special functions (MSDSpro Plusweb or
MSDSpro client).

Web Server Control Panel - Web Server Configuration Tab

To revert all settings back
to the original defaults,
click the DEFAULTS button.

To edit the
configuration,

click the EDIT button.

After editing the configuration
you can CANCEL or SAVE

the changes.
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n TCP/IP Address:  The address as configured in the Operating System (OS) network
settings.

n TCP/IP Port Number:  The port upon which the MSDSpro Web Server is broadcasting.
The default value for the TCP/IP Port Number is 80.

n Number of Web Processes:  The number of “listening” processes at any time.  The
maximum number of Web Processes is limited by available RAM.  Default value is 3.

n Bytes Per Web Process:  The amount of RAM to dedicate to each Web Process.  The
default value for Bytes Per Process is 48,000.

n Max Search Results Returned:  The maximum number of matching records returned
when a search is performed via the web browser.  The default value is 500.

n Exit URL Title:  The title under the company logo which indicates the company logo
can be clicked to exit the MSDSpro area and “return” to another web URL/location.

n Exit URL HTTP://:  The URL/location which will be used by the company logo when
the web browser clicks the graphic image in the web interface to “return” to another
web URL/location.

n No Search Results Additional Message:  An additional message to display on the web
browser following a query when no search results are found.

n AUTO LOGON button:  Clicking this button will create a file called AUTOLOGON.TXT,
found in the MSDSpro Program folder.  This file enables MSDSpro PlusWeb/Web CD
to start in Web Server mode without entering a password.  Hold down the Shift Key
during startup to disable.

Web Server Control Panel - Web Server Configuration Tab (Cont’d)
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n Logo Name:  The name of the .JPG or .GIF file that will be used as the company logo
on the web search interface.  The shape of the graphic should be square for the best
appearance on the web browser.  Default name is “logo.jpg”.

n Transparent Logo:  Select this if the color at pixel coordinates 1,1 should be replaced
with a transparent color on the web browser.  Default is OFF.

n Web Image Max Height and Width:  If MSDS document images are sent to the web
browser, these settings determine the maximum size the image will be displayed on
the browser interface. Note: the images are not modified, they are displayed by the
web browser at a different pixel size.

n Disable MSDS Requests:  MSDS documents can be requested through the web
interface by the web user, if this MSDS Requests are not disabled.  Default is OFF.

Web Server Control Panel - Interface Tab

n Default Language:  You can set the web browser default language to English, Spanish
or French.

n Default search Type:  The administrator can choose the specific field that will be the
main search on the web browser.
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Web Server Control Panel - Contents Tab

n Web Style: Controls the appearance and functionality of the MSDSpro Web Interface.

n Location Drilldown: MSDS searches are performed within a specific Location or level of
Locations. See pp. 8-10 through 8-13.

n Classic: MSDS searches are performed based on Product Name, Manufacturer, MSDS ID,
CAS Number, Locations, Stock Numbers or Ingredient Name.

n Product Summary Label:  Users may view the Product Summary, which includes
Manufacturer emergency contact information and NFPA/HMIS information, if available.

      n Hazard Summary Label:  Users may view the Manufacturer emergency contact
information, Synonyms, NFPA/HMIS information, if available.  Also included is
information entered under the PPE, Routes of Entry, Target Organs, Physical Hazards
and Health Hazards tabs in the product record

n Secondary Containment Labels:  This selection activates the Label printing through the
browser.  See section 9-17.

n Depth to Start Showing Inventory:  Depth at which MSDS links to products in a location’s
inventory will be displayed.  If the depth is set to 2, then inventory will be displayed at the
second level as in Warehouse A -> Room 1.

n Number of Location Columns:  Number of columns in which Location links will be displayed
in.

n Level to use Category Display:  Level at which the catagory display should be used.

n Use Catagory display:  Show the Levels of Inventory at once for Easier Drill Down.

n Display only current Inventory:  Displays only products whose End Date has not already
arrived.
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Web Server Control Panel - Menu Tab

The Menu tab controls what functionality is available when the Menu hyperlink is clicked on in the
MSDSpro Web Interface.

n Homepage Style: Determines if the Menu or Location Drilldown will be displayed
from the homepage by default.

n Enable Menu:  Turns the Menu hyperlink on and off.

n Location Drilldown: Turns the Search for MSDS by Inventory Location hyperlink on
and off.

n Department information: Turns the Waste Codes and Products by Department hyperlink
on and off.

n Modification report: Turns the List of product modifications hyperlink on and off.

n Chemical Authorization: Turns the Search for Chemical Authorization Request and
create a new Chemical Authorization Request hyperlinks on and off.

n Search Results Columns: Checking and unchecking each individual search results
column checkbox determines whether or not that information is displayed for each
product record returned as a search result.
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Web Server Control Panel - Searching Tab

n Available column: Indicates whether or not the field is available for searching. If set
to True, the field is available for searching.

n Field column:  Indicates the name of the field in the software.

n English column: How the field name will be displayed in the English portion of the
Web Interface.

n French column: How the field name will be displayed in the French portion of the
Web Interface.

n Spanish column (not shown): How the field name will be displayed in the Spanish
portion of the Web Interface.
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Web Server Control Panel - Security Tab

n Required Referring URL:  Specifies a URL location (web address) which all web
browsers must come from in order to use the MSDSpro web interface. If the web
browser links to MSDSpro directly from this URL, the web browser will be allowed to
use the MSDSpro web interface.  If the web browser does not link to MSDSpro from
the specified URL, the Security Failure Message is displayed and no access to the
MSDSpro web interface is allowed.  The specified Required Referring URL should
have security methods implemented as part of a standardized network security system.

n Security Failure Message:  A message displayed when a web browser attempts to
utilize the MSDSpro web interface without properly linking from the Required Referring
URL.

n Proxy Server Username:  Specifies the username required by the Proxy Server in
order for  MSDSpro to import an MSDS from the Internet. Not all Proxy Servers require
a valid username.

n Proxy Server Password:  Specifies the password required by the Proxy Server in
order for  MSDSpro to import an MSDS from the Internet. Not all Proxy Servers require
a valid password.
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Web Server Control Panel - Web Inventory

Enable Web Based Inventory:  Allows administrators to update their current inventory from the web.

Delete Removed inventory:  When a product is removed from the set location, the data will be deleted.
If not checked removed inventory has the end date set, but still remains in the system.

Number of Results on each Page:  The number if inventory records that will be displayed on a single
page.

Inventory Message Text:  Any text here will be displayed on the web inventory.

Displayed Columns:  Specifies the columns that will be seen from the web inventory pages.

See section 9-34 for the web browser side of the WIM functionality.
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Web Server Control Panel - Statistics Tab

n Session Start Date:  The date the Web Server was started.

n Total Requests Handled:  The number of “hits” the Web Server has handled since the
session start date.

n Avg Response:  The average time required to process each web request (expressed
in ticks, 1/60th of 1 second).

n Total Products:  The total number of Product records in the database at any given
time.

n Total Manufacturers:  The total number of Product Manufacturer records in the database
at any given time.

 n The Statistics tab is not available from the client interface.
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Using the MSDSpro Web Interface

The web interface allows users who have access to the company intranet to view information in the
MSDSpro database using their web browser. To view the MSDSpro database via the Web Interface,
enter into the web browser the Internet Protocol (IP) address of the computer from which the MSDSpro
Web Server has been installed. For example, entering “http://24.237.115.47” will access the
MSDSpro Web Server which is located at the IP Address of 24.237.115.47. Determining what
IP address the MSDSpro Web Server is broadcasting on is covered on pages 8-2 and 8-3.

The first screen user’s encounter when using the Web Interface is the “Welcome to MSDSpro screen”.
The “Welcome to MSDSpro screen” consists of the MSDSpro logo and three hyperlinks. These
hyperlinks serve up the rest of the MSDSpro Web Interface in three different languages; English,
French,  and Spanish. Click on the hyperlink for the desired language. Once a language has been
chosen, the remaining portion of the web interface is served up in one of two differing layouts; the
Location Drilldown Interface and the Classic Interface.

MSDSpro logo

Language
Hyperlinks

Note: If a default language has been selected, the user will jump right to the main
page for the selected language.  See 9-4 for setting the Default Language.
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Location Drilldown Interface:

The Location Drilldown interface is designed to allow users to view product information from the MSDSpro
database via their web browser. The Location Drilldown Interface consists of the Search Area, the
Current Location Bar, the Search by Location Area and the Search Results Area:

Search Results
Area

Search Area: The Search Area is the top portion of the Location Drilldown Interface. In the Search Area,
the data to be searched for is entered and the search parameters are set. The Search Area contains
the Search field, the Search Criteria and Search Method radio buttons, and the Company Logo.

Current Location Bar

Search Method
Parameters

Search for Location
Hyperlink

Search by
Location Area

Hyperlinks to
Location Inventories

Product and Hazard
Summary Hyperlinks

Hyperlink
to

MSDS

Hyperlink to
Product Inventory
 & Product Details

Search Criteria
Radio Buttons

Company
Logo

Company
Name

Hyperlink
to

www.MSDSpro.com

Hyperlink to
MSDSpro web

menu & help file

Search
Area

WIM
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Search by MSDS field: The Search by MSDS field is where the search criteria is entered.

Search Criteria radio buttons: The Search Criteria radio buttons define what will be searched upon.
For example, performing a search with “Product Name” selected will return matches only to the Product
Name field within the product record. The Search Criteria radio buttons include:

n Product Name
n MSDS ID
n Manufacturer Name
n Product Name Sounds Like

Search Method parameters: The Search Method parameters define how searching will
occur. They are:

n Word Begins With/Word Contains: The search method “Word Contains” finds only
those records in the database or library that contain the search criteria. Word Begins
With finds only those records that begin with the search string.

n All Locations/Only this Location/All Sub Locations: Determines which locations will
be included in the search . If All Locations is selected, the search string will search
for products as inventory at all locations as well as products that are not currently
linked to any inventory locations. Choosing Only this Location will search for
products only at the location listed in the Location Bar. Choosing All Sub
Locations searches all the sublocations that have been created in MSDSpro.
A sublocation is a location that is a subsidiary of another location.

n Exclude/Include CD-ROM MSDS library: Determines whether or not the MSDSpro CD
Library will be included in the search.

Company Logo: The company logo resides on the right hand side of the Search Area. The
company logo is added to the web interface from the Company Interface tab under the
Administrative Preferences Entry form. It displays the logo of the company that has
purchased MSDSpro. The company logo is also a hyperlink. The company logo and the
Internet address (URL) of the company logo’s link is set in the Web Server Control Panel.

Search by Location Area: The search by location portion of the web interface displays the
sublocations for the current location. In the figure on the preceding page, the web interface
is displaying Storage rooms 1, 2, 3, & 4, sublocations of the current location, Chemical
Warehouse.

Search Results Area: The Search Results Area displays the search results for the current
search. Search results are displayed in columns many of which can be turned on or off at
any time via the Web Server Configuration selection on the Admin Control Panel. Columns
that can be displayed in the Search Results Area include:

n Summary/Hazard column: The Summary/Hazard column hyperlinks to the
product summary and hazard summary pages.

The Product and Hazard Summary pages are further described on pp. 8-18 and 8-19.

Location Drilldown Interface (Cont’d)
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n Hyperlink to www.MSDSpro.com: The graphic stating “This site powered by
MSDSpro” can be clicked on to jump the web browser to the MSDSpro LLC
company website.

n Product Name column: The Product Name column lists the name of the product. The
product name is also a hyperlink to the MSDS for the product.

n Manufacturer column: The Manufacturer column lists the name of the manufacturer
of the product.

n Supplier column: The Supplier column lists the name of the company from which the
product was purchased.

n Revision Date column: The Revision Date column lists the date on which the product
was last revised. This date is found either on the MSDS or in the Revision Date field
on the Product Dates tab within the Product record.

n Locations hyperlink: The Locations hyperlink links to a list of the locations where the
product is stored as inventory.

n Details hyperlink: The Details hyperlink links to a page displaying additional details
about the product.

n The Help hyperlink links to the MSDSpro web interface help file

n The Menu hyperlink displays hyperlinks  that allow the MSDSpro Administrator to
perform additional tasks from the MSDSpro web interface.

These tasks are set to be either hidden or displayed from the Web Server Configuration
selection on the Admin Control Panel. The tasks the hyperlinks link to include:

1. Search for MSDS by Inventory Location
2. Search for Chemical Authorization Request
3. Create a new Chemical Authorization Request
4. List of product modifications
5. Waste Codes and Products by Department

The execution of these tasks is described on page 8-17 through 8-19.

Current Location Bar: The Current Location Barr shows which location, if any, is currently having its
inventory and/or sublocations displayed. If the search results displayed are not part of a location's
inventory, then the Current Location Bar displays only "HOME>".  In the figure on Page 8-10, the
inventory of location “Chemical Warehouse” is currently being displayed. The Current Location
Bar also contains the "Search for Location" hyperlink.

Location Drilldown Interface (Cont’d)
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Location Drilldown Interface (Cont’d)

Search for Location Hyperlink: The search for location hyperlink searches for locations matching
information entered into the Search for Location field. Clicking on the Search for Location hyperlink
loads the Search for Location area into the web interface. Search Methods included in the Search for
Location area include Word Begins With/Word Contains and All Locations/All Child Locations. In the
above graphic the location “Building” has been searched for and the matching search results are
displayed as hyperlinks to each location’s inventory.

Search for location
search results for
all locations
containing the word
“room”. These are
also hyperlinks to
inventory listings of
each location.
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Location Drilldown Interface Advanced Search

Location Drilldown Interface Advanced Search: The Advanced Search feature within the Location
Drilldown Interface is accessed by clicking on the Advanced Search hyperlink. This feature allows for
searching multiple product record fields simultaneously. The Advanced Search Interface consists of
the search fields and the search parameters. The search fields include:

n Product Name: The product as named in the Product record.

n Product Name Sounds Like: Product names that sound similar to the search string.

n Manufacturer Name: The manufacturer as named in the Product and Manufacturer
records.

n MSDS ID: The identification number assigned to a product when a new product record
is created. The MSDS ID is located on the Product tab within the Product record.
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n Location Name: The name assigned to a inventory location created in MSDSpro.

n Internal Number: A number created and assigned to a specific product for the purpose
of tracking product inventory. Entering an Internal Number into MSDSpro is covered
in section four of the MSDSpro Administrator guide.

n Manufacturing Number: A number created by the Manufacturer of the product. Entering
the Manufacturer number is covered in section four of the MSDSpro Administrator
guide.

n Ingredient Name: The name of a chemical that comprises a portion of a product.

n CAS Number: A number assigned to a chemical by the Chemical Abstracts Service.

Search Method Parameters: The Search Method parameters define how searching will occur. They
are:

n All Conditions/Any Conditions: Determines whether information in the database will
have to match all of the criteria or any one criteria entered in the advanced search
fields.

n Exclude/Include CD-ROM MSDS library: Controls whether or not the MSDSpro CD
Library will be included in the search.

Location Drilldown Interface Advanced Search (cont’d)
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Location Drilldown Interface Details Page

The Details hyperlink links to the Detailed Information page. The Detailed Information page displays
additional information about the product. Information about the product available from the Detailed
Information page includes:

n PPE phrases: PPE phrases describe personal protective equipment to be used with
the product.

n First Aid Phrases: First aid phrases describe first aid procedures to be used in case of
an accident involving the product.

n Waste Codes: Waste codes describe appropriate disposal methods of the product.

n Summary Sheets and Labels: The Summary Sheets and Labels section contains
hyperlinks to the product and hazard summary sheet pages for this product and to a
list of inventory locations.

Product and hazard summary sheet pages are covered on pp. 8-24 and 8-27.

n Authorized Departments: The Authorized Departments section of the Detailed
Information page displays the departments that have been approved to use the product.

n Product Synonyms: Product synonyms displays a list of names that the product might
otherwise be called.

n Density: Density shows the volume displaced by a certain mass of the product.

n Specific Gravity: Specific gravity displays the ratio between the density of the product
and the density of water.

n Ingredients: Ingredients lists the constituent chemicals of which the product is
composed.
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Location Drilldown Menu Functionality

The Menu hyperlink displays hyperlinks that allow the MSDSpro Administrator to perform additional
tasks from the MSDSpro web interface.

These tasks are set to be either hidden or displayed from the Web Server Configuration selection on
the Admin Control Panel.  The tasks the hyperlinks link to include:

1. Search for MSDS by Inventory Location
2. Search for Chemical Authorization Request
3. Create a new Chemical Authorization Request
4. List of product modifications
5. Waste Codes and Products by Department

To Search for an MSDS by Inventory Location:

1. Click on the Search for MSDS by Inventory Location hyperlink.

2. Click on the link of the location in which the MSDS is to be searched for or click on
the link of the parent location that contains the location in which the MSDS is to be
searched for.

3. If the location in which the MSDS is to be searched for does not display any inventory,
set the Depth to Start Showing Inventory field to 1 within the Web Server Control
Panel.

The Web Server Control panel is accessed via the Web Server Configuration radio button on
the Admin Control Panel.

To Search for a Chemical Authorization Request (C.A.R):

1. Click on the Search for Chemical Authorization Request hyperlink.

2. Select the field in which to search for the search item.

3. Enter into the search field the information by which the C.A.R. is to be searched.

For Example, select the Product Name radio button and enter the product name WD-40 into
the search field if you wish to find a C.A.R. for WD-40.

4. Click on the SEARCH Button.

5. If the C.A.R. desired is listed in the search results, select it and click on the CONTINUE
button to view its details.

Clicking on the RESUME CAR ENTRY button allows additional information to be entered into the
C.A.R form if the C.A.R. status is currently set to “not submitted” and the user clicking on
the button is the original C.A.R. author.
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To Search for a List of product modifications:

1. Click on the List of product modifications hyperlink.

2. Enter the term to be searched for and select the field in which to search for the search
item.

3. Select either the Word Contains or Word Begins With radio button.

4. If desired, check the Search only in specified Date Range checkbox and enter the
dates in which modifications to the product must have been made.

5. Click on the SEARCH Button.

6. Click on the product name in any of the search results to see the changes that were
made to the product record at that time.

To Create a new Chemical Authorization Request:

1. Click on the Create a new Chemical Authorization Request hyperlink.

2. Enter the Employee ID and the information to be searched for in the C.A.R. records.

3. Select the radio button corresponding to the field in the C.A.R. record in which the
information is to be searched for.

4. Click on the CONTINUE button.

5. Once search results have been returned, selecting the radio button for a specific
product will allow for the creation of a new C.A.R. with information relating to that
product already entered.

Clicking on a product name will display a specific C.A.R. submitted for that product.

6. If the search results do not display a C.A.R. from which information can be used to
create a new C.A.R., select the Request a New Product radio button and click on the
CONTINUE button.

7. Fill out the required fields in the C.A.R. and any desired additional information.

8. Click on the CONTINUE button to move to the next step in the C.A.R. submittal process
or click on the SAVE AS DRAFT button to save this C.A.R. for submittal at a later date.

9. Review the information entered into the C.A.R. for accuracy

10. Click on the EDIT ENTRY button to go back and edit the information in the C.A.R. or
click on the SUBMIT CAR button to submit the C.A.R. or click on the SAVE AS DRAFT
button to save this C.A.R. for submittal at a later date.

Location Drilldown Menu Functionality (Cont’d)
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To Search for a List of Waste Codes and Products by Department:

1. Click on the Waste Codes and Products by Department hyperlink.

2. Select either the Product or the Waste Code radio button.

3. Enter the name of the Department to be searched for.

4. Click on the SEARCH button.

Location Drilldown Menu Functionality (cont’d)
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Classic Interface:

The Classic Interface is a simplified interface that allows the end user to search for MSDSs using a
wider variety of search criteria than does the Location Drilldown Interface. The Classic Interface consists
of the Search Area and the Search Results Area.

Search Area: The search area is the top portion of the Classic Interface. In the search area, the
search criteria and the parameters of the search are entered. The Search Area contains the Search
Criteria, the Search field, the Search Method parameters, the Web Logo and the Logo Hyperlink.

Search Criteria: The Search Criteria is where the words to search for are entered.

Search Method parameters: The Search Method parameters define how  searching will occur. They
are:

n Word Begins With/Word Contains: The search method “Word Contains” finds only
those records in the database or library that contain the search criteria. Word Begins
With finds only those records that begin with the search string.

n All words/Either Word: Controls if MSDSpro will search for all of the words or any of
the words in the search string.

n Exclude/Include CD-ROM MSDS library: Controls whether or not the MSDSpro CD
Library will be included in the search.

Company
Logo

Logo
Hyperlink

Search Methods

Search Field

Product & Hazard Hyperlink to Manufacturer Revision Date
Summary Hyperlinks MSDS Name
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Classic Interface (Cont’d)

Search field: The Search field selects which field will be searched. Performing a search with “Product
Name” selected will return matches only to entries made in the Product Name field within the product
record. Search Criteria include:

n Product Name: The product as named in the Product record.

n MSDS ID: The identification number assigned to a product when a new product record
is created. The MSDS ID is located on the Product tab within the Product record.

n Manufacturer Name: The manufacturer as named in the Product and Manufacturer
records.

n Product Name Sounds Like: Product names that sound similar to the search string.

n Ingredient CAS Number: A number assigned to a chemical by the Chemical Abstracts
Service.

n Stock Number (Internal): A number created by the company that has purchased
MSDSpro and assigned to a specific product for the purpose of tracking product
inventory.

n Stock Number (Mfg.): A number created by the manufacturer of the product.

n Ingredient Name: The name of a chemical that comprises a portion of a product.

Web Logo: In the Classic Interface, the web logo is much more prominently displayed than it is in the
Location Drilldown Interface.  The web logo is added to the web interface from the Company
Interface tab under the Administrative Preferences Entry form. It is usually the logo of the
company that has purchased MSDSpro. The web logo is also a hyperlink. The web logo and
the Internet address (URL) to which the web logo links to are set in the Web Server Control
Panel. The Web Server Control Panel is covered on pp. 8-2 through 8-8.

Logo Hyperlink: The logo hyperlink is located below the web logo. It provides additional information
about the website to which the logo links. In the graphic on the preceding page, the logo hyperlink is
the word “MSDSpro”. It tells the user of the web interface that the company logo is hyperlinked to the
MSDSpro website, www.MSDSpro.com.

Search Results Area: The Search Results Area displays information matching the word or words
originally searched upon. Search results are displayed in five columns; Summary/Hazard, Product
Name, Manufacturer, Date, and Locations.

n Summary/Hazard column: The Summary/Hazard column contains hyperlinks to the
product summary and hazard summary pages. The product and hazard summary
pages are described on pp 8-17 & pp. 8-18.

n Product Name column: The Product Name column lists the name of the product. The
product name listed in the Product Name column is also a hyperlink to the product’s
MSDS.

n Manufacturer column: The Manufacturer column lists the product’s manufacturer
name.
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n Date column: The date column lists the date on which the product was last revised.

 This date is found on the Product Dates tab within the product record.

Classic Interface (Cont’d)
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MSDS Document Page

The MSDS document is viewed by clicking the Product Name link in the Search Results area.
In most cases, the MSDS will be viewable via the web browser. In other instances, the web interface
will  launch a separate application to display the MSDS. MSDSs in ANSI text format will open as a
PDF file.
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Product Summary Page

The Product Summary Page is retrieved by clicking the Product Summary hyperlink in the Search
Results area. Click the browser’s “Back” button to return to the main page. The Product Summary
Page displays the following:

n Product Name
n Manufacturer Name
n Manufacturer Emergency Phone, or if not listed, Manufacturer Phone
n Any listed hazardous ingredients, or if the Product is hazardous, all ingredients
n NFPA or HMIS rating for the product
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NFPA Definition Page

The NFPA Definition is retrieved by clicking the NFPA Definition link from the Product or Hazard
Summary pages. The hazard rating is based on National Fire Protection Association (NFPA)  rating.
Click the browser’s “Back” button to return to the Product or Hazard Summary page.
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The HMIS Definition is retrieved by clicking the HMIS Definition link from the Hazard Summary page.
The hazard rating is based on Hazardous Materials Information System (HMIS) rating. Click the browser’s
“Back” button to return to the Hazard Summary page.

HMIS Definition Page
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The Hazard Summary Page is retrieved by clicking the Hazard Summary hyperlink in the Search
Results area. Click the browser’s “Back” button to return to the main page. The Hazard Summary
Page displays the following:

n Product Name
n MSDS ID
n Manufacturer Name
n Synonyms
n Target Organs
n Routes of Entry

n Personal Protective Equipment (PPE)
n Manufacturer Emergency Phone
n Health Hazards
n Physical Hazards
n HMIS Rating
n NFPA Rating

NFPA Rating

Hyperlink to
NFPA Definition

HMIS Rating

Hyperlink to
HMIS Definition

Hazard Summary Page
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Provider

MSDS Provider

MSDS Provider is a system that allows accessing the latest manufacturer’s MSDSs including indexed safety and
regulatory information.  The system is searchable by product and/or manufacturer name.  The system supports the

mulitdocument feature application.

Search for a Provider MSDS:
To search for and add a new MSDS from Provider,  click the Provider Button in the Product Output form.  The Add from
Provider Window appears.  The Search For Entry area is used to specify keywords used in the Product Name and
Manufacturer search.
Method Choice allows a search that will find words in the Product Name that begin with the specified word or words that
are contained within a larger word string.
NOTE:  Choosing the Word Begins With is a much faster search than Word Contains.
The field choice allows a search for a Product Name that matches the Specified word(s) typed, or a search for Manufac-
ture Name that matches the specified word.

After Clicking Search, a resulting list of matches will appear.  Using SEARCH SELECTION will narrow the search
within the currently found records.
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Provider - Cont’d

Add MSDSs from Provider
n Select any products you wish to add by highlighting them and clicking select.
n You can perform several searches and continue selecting products.
n After searches are done and MSDSs are selected, use the ADD button to add the selected

MSDS(s) to your Database.

Synchronization with Provider:
n To synchronize your data with Provider select the Synchronize with Provider option from the

Updates tab of the Admin Control Panel.
n The Synchronize with Provider form will be loaded.  It contains a list of all MSDSs from you

database with their statuses in relation to the Provider MSDSs.
n Match MSDSs with Provider MSDSs.  Only documents with the status “Possible Match” can be

linked to Provider.  Select the MSDS and use the MATCH button to see the list of potential matches on
Provider.

Document Status definition

n Current - The MSDS in your database is current.
n Possible Match(es) - There are possible Matches in Provider to the MSDS.

n No Matches - There are no matches to the MSDS in Provider.

n Error linking Provider - An error occurred during linking to Provider.

n Provider Newer - Provider has a more current version of this document.

n Local Newer - The local document is more current than Provider.
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Provider - Cont’d

When matching local MSDS to Provider MSDS, use VIEW CURRENT MSDS and VIEW PROVIDER MSDS to view  the
respective documents.  Select a provider MSDS to link the current MSDS to, and click LINK TO THIS MSDS.  Click
LEAVED UNLINKED if you don’t want to link your document to Provider.  Linked documents stay linked to Provider next
time you synchronize.  Unlinked documents can be linked the next time you synchronize.  After an MSDS is linked to
Provider its status will change to Current, Provider Newer or Local Newer.

n Synchronize with Provider by clicking SYNCHRONIZE WITH PROVIDER.
n Documents with Current, Local Newer, No Match or Error Linking Provider status will be ignored.
n Provider Newer Documents will be updated.
n Old Documents will be archived.
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WIM - Web Inventory Management

To access the WIM capabilities, you must first enable the Web based inventory through the Web Server Control Panel.
See Section 9-9 for instructions.

In the Web Browser open up a location that you wish to review, and select the Edit Inventory Link.
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WIM - Wed Inventory Management (cont’d)

n Remove Items:   Items that have been selected will be removed from your inventory.
Database setting determines if inventory is deleted or is the end date is set .
See section 9-9.

n Add New Products:  Go to screen for adding new products.

n Save Changes:  Saves the changes that you have made to Inventory Information.

n Cancel Changes:  Ignores any changes made to this page.

n Mark Location Reviewed:  Records that all inventory has been updated and confirmed.

The MSDSpro Database Administrator has the capability to add or remove fields.  See section 9-9 for instructions
on configuring employees for web interface.
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MSDS Request Form

Enter in as much information as possible for the MSDS you wish to have added to your location.  The only
fields that are required are noted with an astrix (*).

n Product:   The name of the product to be added.

n Mfg:   The Manufacturer of the product being requested,

n Mfg Phone:   The contact number for the manufacture.

n Mfg Catalog:   The catalog number for the product.

n Supplier:   The supplier of the product being requested.

n Time Needed:   The date the product is needed.

n Comments/Description of Use:   Notes for the use of the product.
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MSDS Request Form (cont’d)

Enter in as much information as possible for the MSDS you wish to have added to your location.  The only
fields that are required are noted with an astrix (*).

n Contact Information:

n Name:   The name of the person requesting the MSDS.

n Department:   The department of the employee requesting the MSDS.

n Location:   The location of the product being requested.

n Phone/Address/City State or Providence:   The employee’s contact information.

n Postal Code:   Zip Code.

n E-mail:   Employee’s e-mail address.

n Notes:   Additional information regarding the use and need for the MSDS requested.
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MSDSpro Enterprise Integrated Backup

Overview

To keep your data safe, you should guard against hardware-related breakdowns and human error.
MSDSpro Enterprise includes a integrated module designed for creating a backup of an MSDSpro
database. This module is capable of backing up the MSDSpro database even while the database is
open. The integrated backup module that comes with MSDSpro Enterprise is called 4D Backup. 4D
Backup does not integrate with other versions of MSDSpro; PlusWeb, Classic, Web CD and CD
Viewer.

Section ten of the MSDSpro Administrator’s Guide explains how to install 4D Backup, backup an
MSDSpro database and restore an MSDSpro database from a backup.

Installation of 4D Backup in MSDSpro Enterprise

4D Backup must be installed on the same computer as MSDSpro 4D Server. Beginning with MSDSpro
version 4.0, 4D Backup will automatically be installed with MSDSpro 4D Server. To install MSDSpro 4D
Server, please refer to the section Installation of MSDSpro 4D Server.

To install 4D Backup in MSDSpro Enterprise, follow these steps:

1. Shut down MSDSpro 4D Server.

2. Insert the MSDSpro CD into your CD-ROM drive.

3. As shown on the next page, use Windows Explorer to browse to the \Extras\4D
Backup folder on the MSDSpro CD.
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5. Verify the location to which 4D backup will extract.

To set the location to which 4D Backup will extract, type it in the Unzip To Folder field.

6. Click the UNZIP button.

7. After file extraction is complete, click the OK button.

8. Click the CLOSE button to close the WinZip Self Extractor.

Installation of 4D Backup in MSDSpro Enterprise (Cont’d)

4. Double-click the 4DBackup.exe self-extracting file.
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10. Move the Backup.4dx and Backup.rsr into the installed MSDSpro 4D Server Win4DX
folder.

The default location of this folder is C:\Program Files\MSDSpro Server\Program\Win4DX.

Installation of 4D Backup in MSDSpro Enterprise (Cont’d)

9. Locate the four files within the new C:\4D_Backup_605\Win4DX folder.

Changing the location to which 4DBackup.exe extracted in step six will change the location
of the Win4DX folder.
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11. Launch MSDSpro 4D Server.

Perform a Full Backup

1. Select Full Backup... from the Backup menu.

2. Select the destination volume by clicking on the hard disk icon.

Installation of 4D Backup in MSDSpro Enterprise (Cont’d)

Configuring 4D Backup

After installing 4D Backup and launching MSDSpro 4D Server, 4D Backup must be configured properly.

For the purposes of this guide, we will configure 4D Backup onto a fixed Hard Disk with 3 Backup Sets
and a transaction Log File to store transactions.
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3. Verify that the destination volume will have enough free space to perform the backup.

4. Verify the number of sets.

The number of sets indicates how many backups will be created before 4D Backup overwrites
the earliest backup file.

5. Select whether 4D Backup should verify the backup when finished.

Verifying will take additional time to ensure that the backup file was created successfully.

6. Click the BACKUP button.

7. Save the backup file to the appropriate location.

The first backup is named MSDSPRO001.4BK. Subsequent backups will be renamed
incrementally.

8. The backup progress thermometer will appear.

Configuring 4D Backup in MSDSpro Enterprise (Cont’d)
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9. After the backup is complete, save the backup parameters.

10. Click the SAVE button.

11. Browse to the location to which the parameters will be saved and click the SAVE
button.

Configuring 4D Backup in MSDSpro Enterprise (Cont’d)

Note: The Project file MUST be saved in the same folder as the datafile (*.4DD) for scheduled
backup to function properly.
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3. Specify the next date and time 4D Backup should automatically execute.

4. Click the OK button.

5. Select the interval which regular backups should occur.

Configure the Backup Scheduler

The Backup Scheduler is used to specify when automatic backups should occur.  These settings
may be modified at any time.

1. Select the Backup Every checkbox.

2. Click the watch icon to configure settings.
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2. Click the NEW button to create a new log file.

Configuring 4D Backup in MSDSpro Enterprise (Cont’d)

Select a log file

The log file is used to capture incremental changes to the database between backups. The log file can
be used to recover records that have been added, modified, or deleted since the last full backup.

1. Select the Select Log File... menu item from the File menu.
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3. Save the new log file.

4. The 4D Server main window now shows the location of the log file.

5. 4D Backup is now configured to automatically backup the MSDSpro datafile.

Configuring 4D Backup in MSDSpro Enterprise (Cont’d)
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3. Browse to and open the backed up MSDSpro database file.

4. Click on the RESTORE button.

Restoring an MSDSpro datafile using 4D Backup

1. Launch 4D Backup.

2. Click on the RESTORE button.
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6. A new folder named MSDSpro.RST will be created and the restored MSDSpro datafile
placed inside.

7. Once the database has been successfully restored, 4D Backup will again display its
main control panel.

Restoring an MSDSpro datafile using 4D Backup (Cont’d)

5. Browse to the location to which the MSDSpro datafile will be restored.

8. The MSDSpro database has been successfully restored.
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In summary, this section has shown how:

n To install 4D Backup into the MSDSpro 4D Server

n To perform a full backup

n To schedule regular backups

n To create a log file to store incremental information between backups

However, this guide contains excerpts from the full 4D Backup guide, which is provided as an all
inclusive reference for 4D Backup installation, usage, and restoration techniques. MSDSpro will provide
the full 4D Backup guide to you upon request.

Please contact MSDSpro as discussed in the section Contacting MSDSpro to request the full 4D
Backup guide.

Additional Information
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Compacting and Restoring the Database

Overview

Periodically it may become necessary to run a data compression or data recovery utility on the
MSDSpro data files.

The utility provided for these tasks is called 4D Tools, and is provided on the MSDSpro installation CD-
ROM or web site.

4D Tools can be used to compact the MSDSpro database files, which will remove deleted records and
remove unused space which will normally tend to accumulate as the database is used.  Compacting
the MSDSpro database files is similar to defragmenting a hard disk - MSDSpro will take less space
and will operate faster.

4D Tools can also be used to recover data in the unlikely event of a system crash.  This will provide the
best means of recovery if a reliable backup is not available.
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Installing 4D Tools

To Install 4D Tools, follow these steps:

1. Insert the MSDSpro Installer CD into your CD-ROM drive.

2. Locate the \Extras\4D Tools folder as shown below in Explorer.

3. Double-click the 4D Tools.exe application.

4. Click on the O.K. button.

5. Type the letter of the drive to which 4D Tools will extract, followed by the colon
symbol. (ex. C:)

6. 4D Tools will now install.
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Compacting MSDSpro Using 4D Tools

To compact the MSDSpro data files using 4D Tools, follow these steps:

1. Launch the 4DTools.exe application.

The default installation location is C:\4D Tools\4DTools.exe

2. Change the Files of Type field to Compiled Database (*.4dc).

NOTE: You must shut down the MSDSpro application currently in use.  It’s recommended that all file
extensions are VISIBLE and NOT HIDDEN.  This is accomplished from the Folder Options menu
within Windows® Explorer.  Select View -> Options/Folder Options -> select Show all files and
deselect Hide file extensions for known file types.

3. Select the MSDSpro.4DC file and click on the OPEN button.
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4. Click on the Maintain tab.

5. Click on the COMPACT button.

6. Name the new datafile with “new” at the end of the file name.

6. Click on the SAVE button.

7. 4D Tools will show the following progress thermometers during processing.

8. After 4D Tools has finished processing, select Quit from the File menu.

Compacting MSDSpro Using 4D Tools (Cont’d)
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9. Locate the old (original) data files.

10. Create a new folder called “Old Files” from the File menu -> New -> Folder.

11. Move the old files into the new “Old Files” folder.

12. Launch MSDSpro and immediately hold down the ALT key.

13. Select the new compacted datafile when the Open Datafile window appears.

14. Click the OPEN button.

Compacting MSDSpro Using 4D Tools (Cont’d)
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Recovering MSDSpro Using 4D Tools

To recover the MSDSpro data files using 4D Tools, follow these steps:

1. Launch the 4DTools.exe application.

The default installation location is C:\4D Tools\4DTools.exe

2. Select MSDSpro.4DC from the Open File window.

NOTE: You must shut down the MSDSpro application currently in use.  It’s recommended that all file
extensions are VISIBLE and NOT HIDDEN.  This is accomplished from the Folder Options menu
within Windows® Explorer.  Select View -> Options/Folder Options -> select Show all files and
deselect Hide file extensions for known file types.

3. Click the OPEN button.



Section 11: Compacting and Restoring the Database

Administrator Guide 11 - 7

4. Click on the Repair tab.

5. Click on the RECOVER button.

6. Name the new datafile with “recovered” at the end of the file name.

8. Click the SAVE button.

Recovering MSDSpro Using 4D Tools (Cont’d)
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9. 4D Tools will show the following progress thermometers during processing.

10. After 4D Tools has finished processing, select Quit from the File menu.

11. Locate the old (original) data files.

12. Create a new folder called “Bad Files” from the File menu -> New -> Folder.

Recovering MSDSpro Using 4D Tools (Cont’d)
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14. Launch MSDSpro and hold down the ALT key at the same time.

15. Select the recovered datafile when the Open Datafile window appears.

16. Click the OPEN button.

13. Move the old files into the new “Bad Files” folder.

Recovering MSDSpro Using 4D Tools (Cont’d)
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